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General Precautions 
Warnings and Cautions alert users to dangerous conditions that can occur if instructions in 
the manual are not obeyed. Warnings are conditions that can cause injury to the operator, 
while Cautions can cause damage to the equipment. 

 

 
CAUTION: Federal law in the U.S.A., and Canadian law, restricts the sale distribution, 
or use of this product to, by, or on the order of a licensed medical practitioner. This 
product should be used under the guidance of a medical physicist. 

 
CAUTION: The “Save” and “Save As” functions of the PIPSpro System are intended 
solely to save solutions of interest or potential reuse.  Specific patient information or 
identifiers should not be saved using these functions. 

 
CAUTION: To minimize the potential for computer issues, do not run PIPSpro 
concurrently with other software programs. 

 
CAUTION: Proper use of this product depends on careful reading of all instructions 
and labels. 

 
CAUTION: For accurate results in the MLC QA Module the MLC QA Phantom must be 
positioned carefully to ensure that the corner spherical marker is aligned to isocenter 
and that the supporting arm is perpendicular to the gantry rotation.  

 
CAUTION: The MLC QA module expects all tests to be performed with the collimator 
at either 0, 90, 180 or 270 degrees.  Collimator angle accuracy should be verified 
before acquiring images for analysis in the MLC QA module.  Variance in the 
expected angle could result in incorrect positions being reported for individual MLC 
leaves. 

 
CAUTION: For professional use only.  As desired by IAEA, English is the default 
language for labeling and manuals.  If translated versions are available, resolve any 
difference in favor of the English versions. 

 
CAUTION:  Cybersecurity is a shared responsibility between Standard Imaging and 
the customer.  Secure use of this product is dependent upon the proper utilization of 
passwords, firewalls, networks, computer platforms, operating systems and data 
storage.  

 
WARNING: Issues identified through the use of this product must be investigated 
and appropriately resolved and/or noted. 

 
WARNING: Proper application of the QC-3 Phantom, QCkV-1 Phantom and/or FC-2 
Phantom requires the use of the PIPSpro Software. 

 
WARNING: Where applicable, Standard Imaging products are designed to be used 
with the versions of common radiation delivery devices, treatment planning systems 
and other common computer software products or systems used in the delivery of 
ionizing radiation, available at the time the Standard Imaging product is released. 
Standard Imaging does not assume responsibility, liability and/or warrant against, 
problems with the use, reliability, safety or effectiveness that arise due to the 
evolution, updates or changes to these products or systems in the future. It is the 
responsibility of the customer or user to determine if the Standard Imaging product 
can be properly used with these products or systems. 
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The information in this manual is subject to change without notice.  Please see 
www.standardimaging.com for the latest information.  No part of this manual may be copied 
or reproduced in any form or by any means without prior written consent of Standard 
Imaging, Inc. 

 

Catphan® is a registered trademark of The Phantom Laboratory.  

BEAMVIEW® is a registered trademark of Siemens AG.  

PortalVision™ is a trademark of Varian Medical Systems, Inc.  

iView™ and iViewGT™ are trademarks of Elekta AB.  

TheraView® is a registered trademark of Cablon Medical B.V.  

Varian® is a registered trademark of Varian Medical Systems, Inc.  

Elekta® is a registered trademark of Elekta AB.  

Citrix® is a registered trademark of Citrix Systems, Inc. 

XenApp and XenDesktop are registered trademarks of Citrix Systems, Inc. 

TomoTherapy® is a registered trademark of Accuray Incorporated. 

Windows is a registered trademark of Microsoft Corporation. 

SQL Server is a registered trademark of Microsoft Incorporated. 

MillenniumTM is a registered trademark of Varian Medical Systems, Inc. 

120HDTM is a registered trademark of Varian Medical Systems, Inc. 

 

1 Quick Start Guide 
This Quick Start guide is an aid that allows you to start using PIPSpro immediately.  In addition 
to this introduction, there is an “Overview of PIPSpro Applications” and a section on “Common 
Application Functionality.” 

The Quick Start guide is not intended to be a substitute for the User Manual or the Phantom 
Setup Guide (which follows), both of which contain more detailed information on the use of 
PIPSpro. 

1.1 Installation 
NOTE: prior to installing the PIPSpro client it is required that SQL Server Express or Standard 
2017 or better be installed with SQL Server authentication enabled, as seen here: 
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Additionally, Installation must be installed with Administrator rights and assure all users have 
permissions to access the SQL/PIPSpro database.  

The PIPSpro installer can be obtained by download.  If you have already installed a previous 
version of PIPSpro and want to upgrade OR you want to create a new install, select “PIPSpro 
Client and Database.”  Follow prompts. 

From the Initial Installer Screen 

Example images, logfiles, MLC patterns and RT Plans can be found under: 

• C:\Program Files (x86)\Standard Imaging PIPSpro  
or 

• C:\Program Files\Standard Imaging\PIPSpro 

The first time you log in, you may log in as Username: Superuser, Password: Superuser. 

1.2 System Manager 
The System Manager allows a user at the administrator level or above to configure PIPSpro for 
a specific department or departments.  Divisions that “own” departments, users, machines, 
and phantoms are specified.  Although PIPSpro can be run by the Superuser, PIPSpro 
functionally works best if each user has an individual login and password.  For instance, results 
cannot be approved by the Superuser. 
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1.3 Alert and Error Thresholds 
Alert and error thresholds are set in the System Manager for all tests except for Imager QA.  
Default error thresholds are the TG-142 recommended values.  Default alerts are usually one 
half of the error thresholds. 

For Imager QA, a “Baseline Editor” allows you to specify results that are typical as your 
baselines.  Alert and error levels are specified with respect to these baselines. 
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1.4 General Tips and Tricks 
• Create separate logins and passwords for each user. 
• When imaging, always use the same technique.  Different techniques will yield 

different results. 
• To ensure good image resolution, always use as small a field of view as possible.  

Smaller fields of view will have more pixels per structure of interest. 
• Be sure to set up your phantoms correctly and accurately.  Poor or inconsistent setup 

will lead to an inability to get results or results that do not trend well. 
• PIPSpro accepts TIFF (16-bit), BMP (8-bit), DICOM, and native format images from 

CyberKnife and ExacTrac. 

1.5 Applications 
PIPSpro is composed of eight different applications for that allow testing a large number of 
imaging and linac machine parameters: 

Imager QA 

Single Planar (MV, kV)  

• Spatial Resolution 
• Noise 
• Contrast to Noise 
• Uniformity  

Dual Planar (MV, kV) 

• Spatial Resolution 
• Noise 
• Contrast to Noise 

Computed Tomography (CT) 

• Spatial Resolution 
• Uniformity and Noise 
• Hounsfield Constancy 
• Geometric Distortion 
• Low Contrast Detectability 
• Low Contrast Visibility 
• Slice Thickness 
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Radiation Light Field 

• Light Field vs. Radiation Field Displacement 
• Radiation Field vs. Crosshair Displacement 
• Light Field vs. Crosshair Displacement 
• Jaw Placement Errors with respect to Central Axis 

StarShot 

• Maximum Diameter 

Stereotactic 

• Optimal Shift (dX, dY, dZ) 
• Worst case 2D isocenter displacements (dU, dV) 

IGRT 

3D Couch 

• Position Error (X, Y, Z)  

6D Couch 

• Position Error (X, Y, Z) 
• Angle Error (Pitch, Roll, Yaw) 

Image-Based MLC QA 

• Leaf Position - Expected and actual leaf positions 
• Multi-Port - Expected and actual leaf positions 
• Leaf Transmission - Leaf leakage and Inter-Bank leakage 

Logfile-Based MLC QA Tables and Charts 

• Loss of Leaf Speed 
• Accuracy (exact position, RMS error, 95% mm) 
• Repeatability 

Daily CT/SIM Check Phantom Analysis  

• Image Orientation Confirmation  
• Uniformity 
• HU Constancy 
• Slice Position 
• Slice Thickness 
• Geometric Distortion  
• Phantom Alignment  

1.6 PIPSpro Applications: Imager QA 
Analyze flat panel and CT images for standard quality assurance metrics. 

Data Acquisition 

Phantoms: QC-3 for planar MV, QCkV-1 for planar kV, Catphan 503, 504, 600, or 604 for CT. 

Images: DICOM only. 
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Planar:  Align QC-3, QCkV-1 phantom at a 45 degree angle with the number ‘1’ facing the 
gantry.  Align the crosshair on the phantom to the beam central axis. 

MV images:  3 - 5 MU.  

kV images:  70 - 100 kV and the lowest mAs. 

Flood field images must irradiate the entire imager without hitting any “electronics.”  
Phantom images need at least a    15x15 cm field 

CBCT:  Set up Catphan to lasers as “squarely” as possible with the third marker from the gantry 
aligned to the cross plane lasers.  Acquire images with as close to a      24 cm FOV as possible 
using 2.5 mm slices. 

Always use the same imaging protocol for each Imager QA test. 

Image Analysis 

1. Open Imager QA by selecting Application>Imager QA from the main menu. 
2. If you have created a  Quick Select for the test you wish to run, load it.  Otherwise use 

Manual Select to specify your test.  Then, select [Load] under Actions in the left-hand 
panel: 
Single Planar - Load a phantom image and a flood field image. 
Dual Planar (not recommended because it does not have a uniformity test) - Load two 
phantom images. 
CT - Load a CT series. 

3. ROI analysis markups are placed automatically. 
If required, adjust markups using the provided controls. 
For planar analysis a result tab will appear. 

 

CBCT results use the dropdown menu in the upper right to navigate between multiple 
pages of results. 
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For CBCT, suboptimal results can often be traced back to setup.  The Key Slice is often 
not found when setup is not good or the FOV is too small.  Markers must be clearly 
visible on one CT slice as shown. If some are visible on one slice and not another that is 
an indication that the phantom was not set up squarely. 

 

CatPhan Key Slice for 503 and 504 Phantom 

 

 

1.7 PIPSpro Applications: Radiation Light Field 
Analyze radiation light field coincidence, crosshair centering, and jaw position accuracy. 

Data Acquisition 

Phantoms:  FC-2 and Center Marker Phantom. 

Images: EPID.  (Film is possible, but not recommended.) 

Place FC-2 phantom on couch.  Set SSD to FC-2 at 100 cm.  Set jaws or MLC to 10x10 or 15x15.  
Using the light field, align inner edges of FC-2 grooves to the field edges as carefully as 
possible.  Ignore the central crosshair on the FC-2. 

Place the center marker phantom on the FC-2.  Align it to the crosshairs. 

Portal Imager: 3 - 5 MU. 

Image Analysis 

1. Open Radiation Light Field by selecting Application>Radiation Light Field from the 
main menu. 

2. Select [Load] under Actions in the left-hand panel.  Select an image. 
3. Markups are automatically placed showing field edges, outer field markers and the 

central crosshair marker. 
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Results automatically appear in a new tab. 

 
 

 

1.8 PIPSpro Applications: StarShot 
Establish the diameter of the center of rotation for the gantry, couch, and collimator. 

Data Acquisition 

Phantoms:  None 

Images:  Film or EPID. 

Gantry and couch images must be taken with film.  Collimator images may be taken with 
either film or EPID. 

Close lower collimators to form a narrow slit about 5 mm wide.   MLC’s may also be used.  
Using build up, irradiate film or EPID using several angles (e.g., 0, 90, 315 degrees). 

Monitor Units: 

• Radiographic: 3 - 5 MU 
• Radiochromic: ~ 400 MU 
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• Portal Imager: 3 - 5 MU 

Scan film as a grayscale image with a resolution of 72 - 96 dpi.  Save as TIFF or BMP. 

Separate EPID images may be combined using PIPSpro image compositing tools. 

Image Analysis 

1. Open StarShot by selecting Application>StarShot from the main menu. 
2. Select [Load] under Actions in the left-hand panel.  Select an image.   

For film images, place a single fiducial marker near the center of the intersecting 
spokes.  DICOM images do not require the fiducial and are automatically identified as 
collimator images. 

 
Select the angle type (Collimator, Couch, or Gantry) and then [Calculate]. 

3. Markups are placed showing the region of analysis and identified spokes. 

 
Results automatically appear in a new tab. 

 
The only really important result is the Minimum Diameter, which is shown “passing” 
green, above. 

1.9 PIPSpro Applications: Stereotactic 
Use Winston-Lutz-type tests to establish the radiation and mechanical isocenter coincidence. 

Data Acquisition 

Phantoms:  Winston-Lutz. 
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Images: EPID only. 

Works with jaws, MLC’s or cones.  Minimum aperture is 1.5 cm. 

Align Winston-Lutz phantom at isocenter as defined by the light field crosshairs.  You may also 
use lasers if you use them clinically. 

 

 

 

Acquire up to 8 separate images.  Recommended IEC 61217 angles: 

Gantry Couch 
60 0 
130 0 
230 0 
300 0 
60 270 
130 270 
230 90 
300 90 

Portal Imager: 3 - 5 MU. 

Eight angles will allow the optimal isocenter shift to be calculated. 

Less than eight images will allow 2D offsets to be calculated only. 

Image Analysis 

1. Open Stereotactic by selecting Application>Stereotactic from the main menu. 
2. Select [Load] under Actions in the left-hand panel.  Select between two and eight 

images. Two images is the minimum for analysis and eight is the minimum to 
calculate “Optimal Shift.” 

3. Markups are automatically placed. 

 
Markups show radiological and mechanical centers along with the ball marker and 
aperture. 
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2D results are shown next to each image.  “U” increases top to bottom, “V” increases left 
to right. 

 
If there is any brown color around outside of the ball, that should be adjusted away 
using a smaller search offset. 

 
The “Optimal Isocenter Shift” is the best shifted position for the ball marker to get 
improved 2D results.  It is specified in standard patient coordinates as shown by the X, 
Y, Z right-handed coordinate system at the head of the couches above, however it 
must be noted that values X, Y, Z, are in fact the position of the Winston Lutz pointer in 
relation to the optimal location.  Thus, the user should shift the Winston Lutz pointer to 
the inverse of what is being displayed in the software as the indicated shift 
vector.  Always check that these shifts achieve better results.  These shifts should not be 
used clinically.  They are just for checking phantom setup. 

1.10 IGRT 
Track deviations in the daily coincidence of imaging and radiation isocenters. 

Data Acquisition 

Phantoms:  MIMI. 

Images:  Daily alignment. 

Images are not imported into PIPSpro.  Results of morning alignment input by user. 
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For positioning and repositioning test, place the phantom on the couch and align it to the 
isocenter.  Offset the phantom a known distance in the X, Y, and Z directions.  If the system has 
a 6D couch, apply angle offsets.  Acquire MV orthogonal images and register using a 2D/2D 
matching algorithm provided with your linear accelerator’s software. 

For treatment coordinate coincidence test, without moving the phantom, acquire either 2D 
kV projection images or a full 3D CBCT image series.  Register using matching algorithms 
provided with your linear accelerator’s software. 

Good results are near zero distance and angle shift for the second step. 

Image Analysis 

1. Open IGRT by selecting Application>IGRT from the main menu. 
2. No images are used in the IGRT module.  Instead, enter offsets determined by your 

treatment delivery image analysis system into the appropriate fields. 
3. As stated above, we recommend doing the “positioning and repositioning” test prior to 

the “treatment coordinate coincidence test”.  To do this, a 2D MV/MV registration 
should be done first followed by 2D or 3D kV/kV registration. 

1.11 PIPSpro Applications: Image-Based MLC QA 
Analyze the accuracy and leakage of MLC’s for leaf position, picket fence (Multi-Port), and 
interleaf and interbank transmission. 

Data Acquisition 

Phantoms:  MLC QA or graticule (film only). 

Images: Film or EPID. 

MLC test patterns are provided in the PIPSpro installation folder. 

For EPID images, no phantoms are required.  For film images, it is recommended to use your 
calibrated graticule when imaging.  The graticule will provide alignment and scaling 
information.   

You can use the MLC QA phantom with the In-Air Comparison Jig alternately.  Refer to User 
Manual for setup. 

Monitor Units: 

• Radiographic: 3 - 5 MU 
• Radiochromic: ~400 MU 
• Portal Imager: 3 - 5 MU 

Scan film as a grayscale image with a resolution of 72 - 96 dpi.  Save as TIFF or BMP. 

Separate EPID images may be combined using PIPSpro image compositing tools. 

Image Analysis 

1. Open Image-Based MLC QA by selecting Application>Image-Based MLC QA from the 
main menu. 



PIPSPRO™ SOFTWARE  15 

2. Select [Load] under Actions in the left-hand panel.  Select an image. 
When film is used, Image-Based MLC QA tests require fiducials to be identified.  For 
larger MLC’s, e.g., 40x40 cm, the center marker and a marker 8 cm off axis are selected.  
For smaller MLC’s, e.g., 10x10 cm, the center marker and a marker 3 cm off axis are 
selected. 
Image tests are automatically identified as Leaf Position, Multi-Port, or Leaf 
Transmission. 
DICOM EPID images do not require fiducials.  Leaf Position and Multi-Port test are 
automatically processed.  Leaf Transmission requires identification of the energy. 

3. Markups are automatically placed.   
Leaf Position and Multi-Port markups show identified edges (Full Width Half Max). 

 
Results automatically appear in a new tab. 

 
Results automatically appear in a new tab. 

 
For Leaf Transmission the outer pair of lines show where the MLC’s are backed by jaws.  
The middle pair shows the region where the leaf average transmission is calculated.  
The central line shows where inter-bank transmission is calculated.  The total range is 
determined as the intensity difference between the outer line region and the open 
apertures. 
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Results automatically appear in a new tab. 

 

 

1.12 PIPSpro Applications: Logfile-Based MLC QA 
Analyze Varian DynaLog files and Trajectory logfiles and Elekta “TRF” logfiles for loss of leaf 
speed, accuracy, and repeatability. 

Data Acquisition 

Phantoms:  None. 

Images: None. 

Non-clinical MLC patterns and RT Plans for leaf speed and repeatability are provided in the 
PIPSpro installation folder. 

To learn how to acquire logfiles, see Appendix C: Acquiring Varian Logfiles or Appendix D: 
Acquiring Elekta Logfiles in the PIPSpro 5.9 User Manual. 

For a basic introduction to logfiles and how they are interpreted by PIPSpro, see Appendices E 
- H. 

Image Analysis 

1. Open Logfile-Based MLC QA by selecting Application>Logfile-Based MLC QA from the 
main menu. 

2. Select [Load] under Actions in the left-hand panel.  A browser appears that allows you 
to select logfiles based on your machine type.  Select a logfile then select [Open]. 
The system presents Logfile Information and tries to find a Quick Select that matches 
it. If there is no matching Quick Select, the user can edit Manual Select values to match 
intended nominal values (e.g., 180, not 181 degrees) before saving and making a new 
Quick Select. Confirm the Test Type in the configuration section and change to desired 
test if necessary. 

3. A movie feature allows the entirety of a logfile to be viewed showing when leaves are in 
alert or error state or non-moving. 
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Elekta logfile movies do not show leaf status for leaf speed or other moving leaf tests. 
Leaves that are non-moving or in the wrong position when the beam is off do not 
contribute to statistics.  Mouse over leaves to see their number and error status. 

 
Leaf Speed Results include graphs of worst case loss of leaf speed for each leaf and 
table of the ten worst performing leaves. 

 
Accuracy Results are shown for Step and Shoot, Sliding Window and Modulated Arc.  
They include leaf error RMS, 95% of error counts (in mm), and a tabular leaf error 
histogram (as well as a table of the ten worst performing leaves). 

 
Repeatability Results include graphs of worst case failure to return to a specified 
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position (as well as a table of  the ten worst performing leaves.) 

 
 

1.13 PIPSpro Applications: Daily CT Simulator QA 

Data Acquisition 

Phantoms: CT/SIM Check Phantom. 

REF Description 
75030 CT/SIM Check Phantom 
81000 CT/SIM Check Phantom User Manual 
 

 

Images: DICOM CT Set of CT/SIM Check phantom. 

Use one of your clinic's standard protocols to acquire a full set of the phantom. For consistency 
and to provide consistent HU analysis, the same protocol should be used on a daily basis. 
Please refer to the CT/Sim Check Phantom manual for more information on set-up and 
imaging. 

Image Analysis 

1. Open Imager QA by selecting Application>CT Sim QA from the main menu. 
2. Select the CT image set of the CT/Sim Check Phantom (from the directory in which you 

have it saved) to analyze. ROI analysis markups are placed automatically, and the 
analysis will automatically begin.  

Note: once you have navigated to the location of the image sets the software will recall 
this location and open it upon selecting Load.  

3. When Analysis is complete the user will be presented with a Results Overview (which 
will be color coded if a baseline is set (green=pass, yellow=alert, red= fail). Example: 
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4. Using the pull-down menu at the upper right of the screen from the results page you 
can select the specific images of the slices that are used for the various tests as well as 
additional detailed results information. 

 

Once Analysis is complete the user will have the option to print the day’s results with the print 
button in the upper left of the workspace which can be printed or saved as a PDF for 
electronic storage.   

 

 

 
 

1.14 Common Functionality for Applications 

Standard Action Buttons 

All applications, except IGRT, have the standard action buttons below. IGRT just has [Save]. 

 
Appearance before calculation 
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Appearance after calculation 

Note that the standard action button functionality can also be accessed under the “File” 
menu. And, as such, “hot keys” can be used for some functions (e.g., Load, Save, and Print). 

Saving Results 

Results can be saved in all applications.  Saved results become a permanent part of the 
PIPSpro database. 

To save results to the database, select [Save] in each application’s left-hand panel under Image 
Analysis or Log Analysis.  To discard results and try again, select [Reset].  The workflow is 
slightly different in IGRT, where there is no reset functionality. 

Quick Selects 

The first time results are saved for a particular experimental setup in Imager QA or Logfile-
Based MLC QA, the system will create a Quick Select.  Experimental setups for Imager QA 
include the Imager, Test Type, Phantom, and Energy.  Experimental setups for Logfile-Based 
MLC QA include the Test Type, Gantry Start and Stop angles, Collimator Angle, and the Leaf 
Speed and Direction for Leaf Speed tests. 

Quick Selects help you remember experimental setups and index results in the Results 
History.  Quick Selects can be renamed, archived, and deleted in the System Manager.  Quick 
Select functionality will be added to other applications as needed.  The Quick Select naming 
dialog appears the first time a particular experimental setup is encountered. 

It is probably best to name your Quick Select when the dialog appears, but you can name it 
later in the System Manager. 

Results Approval 

Once results are saved to the PIPSpro database, they can be approved by users whose position 
is designated as Physicist or Physician.  The Superuser cannot approve results. 

To approve a result, the select [Print] after results have been saved.  A login dialog will present 
which will accept your user name and a password in order to approve the results just 
calculated. 

Results can be printed whether or not they are saved or approved.  A report will be displayed 
in a preview window (see report to right).  Approval status will appear at the bottom of the 
report.  If a report is not approved, it will show “Generated by” instead of “Approved by”.   
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Results History 

Results History is available in all applications.  When you select History from the blue bar at the 
top of PIPSpro, you will be presented with a page that allows you to select results from the 
current machine and application that are of interest to you.  There are two basic ways of 
selecting results: through Quick Selects for Imager QA and Logfile-Based MLC QA and 
through parameter selection for the other applications.  All applications allow you to select a 
data range for results. 

To view records from a specific query, select [Apply].  Once a query is made and records are 
found, individual records can be achieved or returned to active state.  You can also view only 
active or only archived records. 

To archive data that are not relevant, select them in the active Table View, and select [Archive] 
in the left panel.  To re-activate an archived record, select it in the archived Table View and 
select [Activate]. 

All applications except Logfile-Based MLC QA have a print option. 

The Show Detail checkbox allows the user to obtain more information about a particular data 
record appearing in the Table View.  You must select a record in order to view details.  Just 
click on a record to select it. 

Table View 

A table of data records appears when the [Apply] button is selected.  All Table Views are 
similarly organized and have similar functionality.  The Table View and Chart View are the 
primary active media used to track and  trend QA results. 

To exclude a record from being displayed in charts, select the associated “Don’t Chart” check 
box. 

To view details about a specific record, select a record and the Show Detail check box.  This 
functionality appears only in Imager QA, Radiation Light Field, and Stereotactic. 

Chart View 

The Chart View, when present, appears next to the Table View tab.  As with the Table View, all 
Chart Views are similarly organized and have similar functionality.   

To zoom in on an area of the chart, click and drag across the section of interest.  Use the  or   
buttons to zoom out again.  If icons appear at the bottom of the chart they can be 
selected/unselected to control what information is displayed on the chart.  This is a finer level 
of control than is possible using the “Don’t Chart” checkbox alone.  

Logfile-Based MLC QA does not have a separate Chart View as the charting functionality 
appears on the same tabs as the MLC B Bank and A Bank information; the Table View and 
Chart View are combined. 

Reports 

All applications except Logfile-Based MLC QA have the ability to export results history as a 
compiled report.  
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Select File>Reports... and one of the following dialog box styles presents. As with History, the 
Imager QA report history is indexed by Quick Select; for all other applications there is no Quick 
Select.  Future releases will have more extensive use of Quick Selects to index results.  
Optionally select a Quick Select then a select date range and OK to view a report.  

Export 

All applications except Logfile-Based MLC QA have the ability to export results history in 
comma separated variable (*.csv) files.  These files can be read into Excel and data extracted 
and visualized using Excel tools and graphics.  This capability may be especially useful when 
determining what individual tolerances should be for Imager QA tests in the Baseline Editor. 

Select File>Export... and one of the following dialog box styles presents.  Optionally select a 
Quick Select, then a date range, and [OK] to save data in *.csv format. 
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2 Section 1: Introduction / Intended Use 
Machine QA - PIPSpro™ is a standalone QA software tool for professionals responsible for 
maintaining modern linear accelerators and their imaging systems.  It is specifically targeted 
towards satisfying over 30 of the AAPM TG-142 report’s recommended tests.  

The software is designed as a two-tier client-server system:  a computing architecture that 
separates a client (PIPSpro) from a database server (SQL Server) that can be implemented 
over a computer network.  Each instance of the client software sends data storage and 
retrieval requests to the database server.  This design allows clinical teams to collaborate and 
store related QA tasks in a centralized library.  PIPSpro’s simple straightforward organization 
into divisions, departments, users, linacs, test thresholds, and phantoms - all maintained in the 
database - further facilitates user collaboration. 

Set up of PIPSpro is easy, as we shall see; but in some cases, especially where multiple clients 
are connected to a single database server, it is recommended  to have an Information 
Technology professional or personnel familiar with SQL (Express or Standard) involved with 
the setup of the PIPSpro SQL Server database and assure that all users have permissions to 
access the SQL Server and associated PIPSpro database.  Client software installs can be 
performed at each workstation with the included Client Software Install DVD-ROM or can be 
‘pushed’ to each computer using commercially available remote installation software 
programs. 
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2.1 Minimum System Requirements 
Operating System - Windows 11 Professional, 64 bit 
recommended.  English only. 
Processor - Dual Core, 1 GHz; Quad Core, 2 GHz 
Recommended 
Memory - 32-bit OS: 2 GB, 4 GB Recommended 64-bit 
OS: 4 GB, 8 GB Recommended 
Runtime Environment - .NET 4.5.2 
Hard Drive – 32 GB or greater, 3 GB free space for 
software installation. Sufficient space to store input 
image and/or MLC Log files.  
5 GB free space if installing a local copy of SQL Server 
Express or Standard; 25% free space recommended. 
Screen Resolution – 1600×900 (16:9) or higher, 16-bit 
HiColor or greater 
Virtual Machines – Must support WMI (Windows 
Management Instrumentation) 
Database Management – SQL Server Express or 
Standard 2017 or later.   
Connectivity – IPv4 LAN, 100 Mbit/s or greater 
 

 

  
Product Standards: Designed to meet IEC 60601-1-4  
 
 
  

 

NOTE: PIPSpro Usage Statement: 
PIPSpro Software does not produce any independent DICOM files, nor does PIPSpro Software 
make changes or edits to any existing DICOM files.  
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3 PIPSpro Modules 
PIPSpro Software features separate modules that enable the user to perform different QA 
tasks. PIPSpro version 5.9 features eight modules for performing QA: 

PIPSpro* is an invaluable tool for professionals who are responsible for maintaining modern 
linear accelerators and their imaging systems.  It is specifically targeted towards satisfying the 
needs of the AAPM TG-142 report.  PIPSpro’s ever growing number of applications and 
associated phantoms provides the ability to perform over 30 tests that meet or exceed TG-142 
recommendations. 

The software is designed as a two-tier client-server system:  a computing architecture that 
separates a client (PIPSpro) from a database server (SQL Server) that can be implemented 
over a computer network.  Each instance of the client software sends data storage and 
retrieval requests to the database server.  This design allows clinical teams to collaborate and 
store related QA tasks in a centralized library.  PIPSpro’s simple straightforward organization 
into divisions, departments, users, linacs, test thresholds, and phantoms - all maintained in the 
database - further facilitates user collaboration. 

Where multiple clients are connected to a single database server, it might be best to have an 
Information Technology professional involved with the setup of the PIPSpro SQL Server 
database.  Installation must be installed with Administrator rights and assure all users have 
permissions to access the SQL/PIPSpro database.  

 It is important to note that when setting up the SQL instance and subsequently the PIPSpro 
database permissions are granted to any user accessing PIPSpro and said components of the 
SQL database. Client software installs can be performed at each work station with the 
included Client Software Install or can be ‘pushed’ to each computer using commercially 
available remote installation software programs. 

Imager QA – uses Catphan® model 503, 504, 600, and 604 phantoms to analyze CT image 
series for uniformity, noise, HU constancy, spatial resolution, geometric distortion, slice 
thickness, low contrast visibility, and low contrast delectability. Uses the QC-3 phantom (MV), 
the QCkV and QCkV-R phantoms (kV), or the LEEDS TOR-18 Phantom (kV) to analyze flat panel 
planar images for uniformity, noise, spatial resolution, and contrast-to-noise ratio. 

Radiation Light Field – uses images of the FC-2 and Center Marker phantoms to provides 
quantitative information about radiation field and light field coincidence, the position of each 
of the jaws, and the positioning of the light field crosshairs. 

StarShot – analyzes spoke images to determine the isocentricity of each of the rotating 
components of a linear accelerator: the collimator, the gantry and the couch. This module 
works with either portal images or film and calculates the minimum diameter of a circle that 
will touch each of the spokes. 

Stereotactic – analyzes Winston-Lutz test images to determine the coincidence of the 
machine isocenter with the radiation isocenter. This module provides 2D offsets for each 
image.  It provides an optimal shift of the phantom to improve results when a full eight image 
set is provided. As few as two images may be used if only 2D results are desired. 
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IGRT  – tracks and trends recommended daily image registration and couch shift tests. Can be 
set up to track both MV and kV imaging tests for either 3D (X, Y, Z) or 6D (X, Y, Z, Pitch, Yaw, 
Roll) couches.  

Image-Based MLC QA – This module provides quantitative information for three different MLC 
tests; multi-port (picket fence), leaf position, and leaf transmission (inter-leaf and inter-bank).  

Logfile-Based MLC QA – analyzes leaf speed, leaf position accuracy, and leaf position 
repeatability.  Supports Varian DynaLog files and Trajectory files from MillenniumTM  MLCs and 
120HDTM  MLCs and Elekta “TRF” logfiles from AgilityTM 160-leaf MLCs. 

CT Simulator Daily QA – Analysis of performance of a CT Simulator using Standard Imaging’s 
CT/Sim Check Phantom 

Reports and history that allow tracking and trending of results are available for all modules.  All 
modules have user-specifiable alert and error thresholds and Image QA allows the user to set 
baselines with reference to each of their machines’ performance. 

 

4 Setting up PIPSpro Software 

4.1 Network Configurations 
PIPSpro can be configured to operate in several network topologies, including:  Local Install, 
LAN, Internet, and VPN.  Consult your IT department for guidance. 

Local Software Install 

The Local Software Install methodology has the Client software residing on the same PC as 
the SQL Server and database. 
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Local Area Network (LAN) 

The LAN model is the most basic and simplest to implement.  In a LAN network model, 
PIPSpro clients are connected to a PIPSpro database server through a local area network.  Use 
either SQL Server Authentication or Windows Authentications to manage user access.  Make 
sure that all users of the PIPSpro software have permissions in place to access the SQL 
instance and PIPSpro database. 
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Internet  

In an Internet network model, PIPSpro clients access the database via the internet.  Due to the 
fact that the PIPSpro database will reside outside of your company’s firewall, it is strongly 
suggested that you employ SSL encryption, SSL certificates, SQL Server authentication, and a 
firewall to secure and protect PIPSpro data. Make sure that all users of the PIPSpro software 
have permissions in place to access the SQL instance and PIPSpro database. 
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Virtual Private Network (VPN) 

In this method, remote PIPSpro clients connect to the PIPSpro database through a virtual 
private network (VPN).  This type of configuration will require assistance from your IT 
department. 

 

 

4.2 Setting up PIPSpro 
 

Prerequisite to PIPSpro installation: SQL Server Express or Standard 2017or later needs to be 
installed and set up for PIPSpro to set up the database for use.   Installation must be installed 
with Administrator rights and assure all users have permission to access the SQL/PIPSpro 
database.  SQL Server authentication must be enabled, as seen here: 
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IMPORTANT NOTE: The PIPSpro Client is intended to be set up on a workstation class 
system.  PIPSpro is a 32-bit application, but it can be set up and function on a 64-bit platform. 

To begin setting up PIPSpro, select the executable provided to you by Standard Imaging.   

The PIPSpro Installation dialog will be displayed.  Use the following steps to set up PIPSpro: 

Step 1: Select a Configuration 

In the first screen of the PIPSpro Installation dialog, you will need to select a configuration.  All 
configuration options are for new software installations and upgrades.   
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PIPSpro Client Only 

Select this option if you only wish to set up or upgrade the PIPSpro client software.   

PIPSpro Database Only 

Select this option if you are the PIPSpro database administrator and wish to set up or upgrade 
the database for PIPSpro.   

NOTE:  Language referring to database administrators is to make sure that informed and 
qualified personnel perform database-related operations.  Anyone can be a database 
administrator if so delegated. 

PIPSpro Client and Database 

Select this option if you wish to set up both the PIPSpro client software and database.  This is 
the recommended option for new/first time software installations of PIPSpro. 

Once you have selected your installation configuration, select [Next>]. 
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Step 2: Software License Agreement 

The PIPSpro Software Installation dialog  will display the Software License Agreement.  Review 
and select ‘I accept the terms in the license agreement’ to continue. 

 

 

Step 3: Select an Installation Option 

The PIPSpro Installation dialog will display the components available to set up based on your 
selected configuration. 
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When ready, select [Install].  The application will begin the setting up the prerequisites.  A 
progress bar will be displayed. 

 

When the progress bar has completed, select [Next>]. 

Step 4a: Select an Installation Folder 

Use this step if you are installing only the PIPSpro client software.  Otherwise, refer to Step 4b. 

The PIPSpro Software Installation dialog will display a screen allowing you to select a 
destination folder for the path for the Software installation of PIPSpro.  The default folder* is: 

C:\Program Files\Standard Imaging\PIPSpro 

 If a different destination folder is required, select [Browse].  Select the desired folder in the 
provided dialog. 
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When ready, select [Install].  The application will begin installing the selected components.  A 
progress bar will be displayed. 

 

When the progress bar has completed, select [Close].  The PIPSpro Installation dialog will 
close. 

The PIPSpro application is now ready for use.  An icon will be displayed on your desktop. 

Step 4b: Choose How to Install the Database 

Use this step if you are installing the PIPSpro database, or both the database and client 
software.  If you are only installing the PIPSpro client software, refer to Step 4a. 

Choose how the PIPSpro database should be installed; 
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• Upgrade your existing PIPSpro database to the latest version 

Select this option if you are the PIPSpro database administrator and want to update an 
existing database to work with 5.9.   

NOTE: You only need to update the specific database instance once per PIPSpro version. 

• Install a new PIPSpro database for an existing instance of SQL Server 

Select this option if you are the PIPSpro database administrator and want to create a new, 
independent database for your QA results to be used with an existing SQL Server.   

NOTE: The new database will contain no user data. 

Once you have selected your installation configuration, select [Next>]. 

Step 5: Selecting a Database or Installation Folder 

If you have chosen to upgrade an existing database, or create a new database on an existing 
SQL Server... 

The PIPSpro Installation dialog will display a screen allowing you to specify the database you 
wish to upgrade/install.   

 

Enter the name of the SQL Server in the space provided or click [Browse] to select the SQL 
Server from a list of those available on your network. 

If necessary, enter your user name and password for the SQL Server or select the check box to 
use Windows Authentication instead. 

Select [Test Connection] to ensure the PIPSpro Installation application has connected to the 
correct database. 
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When ready, select [Next>].  The application will install/upgrade the database.  If you are not 
installing the PIPSpro client software, you may close the PIPSpro installation dialog after this 
step. 

If you are also installing the PIPSpro client software, the PIPSpro Installation dialog will display 
a screen allowing you to select a destination folder for installing PIPSpro.  The default folder* is: 

C:\Program Files\Standard Imaging\PIPSpro 

 If a different destination folder is required, select [Browse].  Select the desired folder in the 
provided dialog. When ready, select [Install].  
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The application will begin installing the selected components.  A progress bar will be 
displayed. 

 

When the progress bar has completed, select [Close].  The PIPSpro Installation dialog will 
close. 

The PIPSpro application is now ready for use.  An icon will be displayed on your desktop. 

If you have chosen to install the database on a new SQL Server... 

The PIPSpro Installation dialog will display a screen allowing you to select a destination folder 
for installing PIPSpro.  The default folder* is: 

C:\Program Files\Standard Imaging\PIPSpro 

 If a different destination folder is required, select [Browse].  Select the desired folder in the 
provided dialog. When ready, select [Install].   
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The application will begin installing the selected components.  A progress bar will be 
displayed. 

When the progress bar has completed, select [Close].  The PIPSpro Installation dialog will 
close. 

The PIPSpro application is now ready for use.  An icon will be displayed on your desktop. 

5 Licensing 

5.1 New Installation/License 
Launch the application.  This will display the ‘Standard Imaging – Software Activation’ dialog. 

 

Select one of the licensing options. 

5.2 Evaluation Activation 
Evaluation mode allows full use of the software for a period of 30 days.  After 30 days, the 
evaluation period will expire and the software will no longer be usable until a regular license is 
purchased. 

  



PIPSPRO™ SOFTWARE  44 

Begin by selecting [Evaluation activation].  This will display the Evaluation Activation pane. 

 

 

Enter contact and address information, then select [Start Evaluation].  The Evaluation mode 
will be enabled.   

Each time the application is launched, a rolling dialog will be displayed above the task bar, 
indicating how much time is left until the evaluation expires. 
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5.3 Internet Activation 
Internet activation is the preferred method of license activation.  The application will register 
the license key via the Internet. 

Begin by selecting [Internet activation].  This will display the Internet Activation pane. 

 

The license key will either be received as an email, or printed on the disk case if a physical disk 
was received.  Enter the license key, contact, and address information.  When finished, select 
[Activate].  This will activate the license and allow the program to be used. 
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5.4 Manual Activation 
Manual activation is an option in instances where an Internet connection is not available. 

Begin by selecting [Manual activation].  This will display the Manual Activation pane. 

 

 

An unlock code is needed to complete a manual activation.  Following the directions in the 
dialog, you can visit the website, call, or email to obtain the unlock code.  Once received, the 
unlock code should be entered into the provided field and select [Activate].  This will activate 
the license and allow the program to be used.  
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5.5 Deactivate License 
It is occasionally necessary to deactivate a license. For example, when moving the software to 
a different machine, or if the machine itself is being decommissioned.  Deactivating a license 
will prohibit the program from being used.  The software cannot be used again until the 
license is activated. 

Begin by selecting Help>License>Deactivate License in the main menu.  This will display the 
Deactivate License dialog. 

 

The license can be deactivated through the internet, or manually. 

Deactivate using the Internet 

Start by selecting [Use the Internet].  This will display the ‘Deactivate License using Internet 
Connection’ pane. 
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Enter the license number and product name, and select [Deactivate License].  The license will 
be deactivated automatically.  A message dialog will be displayed indicating that the 
deactivation was successful.   

Deactivate without the Internet 

Start by selecting [Return without Internet].  This will display the ‘Deactivate License without 
Internet Connection’ pane. 

 

Select [Deactivate License].  This will generate a Proof of Removal code in the specified 
field.  The program will automatically be disabled, but the Proof of Removal code must be 
communicated to Standard Imaging by email or phone to complete the deactivation process.  
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5.6 Update License 
Updating the license is necessary when new features or modules have been purchased in the 
software.   

Begin by selecting Help>License>Update License This will display the ‘Standard Imaging – 
Software Update’ dialog. 

 

Enter the license key, contact, and address information, and then select [Update License].  If 
no updates are available, a message dialog will be displayed saying so.  If updates are available, 
the update will occur automatically, and a confirmation message will be displayed. 
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6 Section 2 : Using PIPSpro 

6.1 Opening PIPSpro Software version 5.9 
To open PIPSpro Software double click the shortcut icon that was placed on the desktop 
during installation. 

 

Or you can start the program by clicking on the Windows Start button>All 
Programs>Standard Imaging>PIPSpro 5.9. 

Running PIPSpro the first time 

The first time the program runs it will present the following screen. 

  



PIPSPRO™ SOFTWARE  51 

 

Choose the appropriate database from the list and click [Select].  If this is a first-time/new 
install, select the database pictured above, where “Example” might be the name of your 
computer or server. 

On systems connected to large networks, many servers may be shown in the list. If you have 
questions about which server to select, contact your Information Technology professional to 
determine which server should be chosen. In some cases, the server will not be shown in the 
list or part of the name, e.g. ‘\SQLEXPRESS’, is not shown. When this happens, click on the 
check box next to the word ‘Manual’ and type in the correct information and then click 
[Select]. 

 

Log in with your username and password.  

NOTE: If this is the first time logging in, use the following: 

User Name: Superuser 

Password: Superuser 
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You will be presented with the following screen: 

 

 

Note that even though it is possible to run all of PIPSpro as Superuser, it has been designed 
with the idea of individual users and individual accounts.  Certain features will not work (e.g., 
report approvals) and others will not work as well as the might (e.g., machine persistence) 
unless individual accounts are created and used.  (See ‘Adding Users’ instructions following). 

 

6.2 System Management 
The System Manager allows you to create and organize your Divisions, Departments, Users, 
Linacs, Thresholds, and Phantoms.  “Administrators” can access all aspects of the System 
Manager.  “Superusers” can access only Linacs, Thresholds, and Phantoms, in addition to their 
own password controls.  “Users” cannot access the System Manager.  For more on user 
permissions, see the ‘Adding Users’ section. 

Launch the System Manager by selecting File>System Manager from the main menu. 

Creating a Division 

PIPSpro Users and Departments are assigned to a Division; therefore the first step in 
configuration is creating at least one Division. If PIPSpro is to be used in a multi-center 
operation, it may be necessary to add more than one Division. Divisions can be used to 
prevent any Department(s) or User(s) from viewing information from Department(s) or User(s) 
of other Divisions, or can be used to create more manageable groups of Departments or 
Users.  
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Note: A Master Division is created at initial launch.  Please do not use the Master 
Division.  Instead, create a new Division for your organization with a name that reflects the 
overall ownership organization name.  

 

Select [New] at the bottom of the System Manager screen. 
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Enter a name for the Division. You will not be able to add Departments nor Users until 
Divisions have been created (see instructions following).  

Select [Save] to commit the new Division information to the database. If more than one 
Division is required for your organization, repeat the previous steps until all desired Divisions 
have been added. 

Adding Departments 

The next step in configuration is setting up at least one Department. If PIPSpro is to be used 
by a multi-center operation, the main Department (if there is one) should be added first.  

Note:  A ‘0001’ Department is created at initial launch.  Please do not use the ‘0001’ 
Department.  Instead, create (a) new Department(s) with (a) unique name(s) that reflect the 
site name(s). 

 

Select the Departments tab at the top of the System Manager window. Select [New] at the 
bottom of the window to add a new Department. 
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Enter information in the appropriate fields.  Be sure to enter the Department Name as it 
should appear for all reports and documentation generated by PIPSpro.  Continue filling out 
the screen with the appropriate information.  Click on [Modify List] to add one or more 
Divisions to the Division Membership selection list.  Then click on the Default Division drop-
down list to select the default division that this department will be a member of. 

Note: The Unique Department Identifier should be exclusive to that department and should 
not contain any spaces.  For example, “RadOnc” may be used for the Radiation Oncology 
Department. 

Division Membership and Default Division 

To add a new Department to an existing Division, select [Modify List], located next to the 
Division Membership field. A list of existing Divisions will be shown in the Eligible Divisions 
field. Choose the appropriate Divisions to add and select [Add Divisions]. This will move the 
chosen Division(s) to the Associated Divisions list. Selecting [OK] will complete the process of 
creating the Division Memberships. 

Once Division Memberships have been established a Default Division can be chosen from the 
dropdown list. Setting a Default Division means that all new Users who are assigned to this 
Department will also be automatically added as Users in the Default Division. 

Password Policy 

Choose how often you would like the Users in this Department to change their user passwords 
by entering the appropriate number of months. 

Editing a Department 

A PIPSpro administrator may change any of the department information entered when the 
department was created. Select the desired department from the list on the left. This will 
populate the right portion of the form with that department’s information. When ready, select 
[Save] to save the changes to the database. After the save is complete, select [Close] to exit the 
screen. 
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Adding Users 

Once Divisions and Departments are set up, the next step is to set up the users. In the System 
Manager window select the Users tab. A ‘Superuser’ account is automatically created during 
the initial database setup and will be shown.  

NOTE: For best results, the Superuser account should not be used for routine use of 
PIPSpro.  Features such as approvals will not work and machine persistence will not work as 
designed.  It is best to make one login per staff member using PIPSpro. 

 

Select [New] to create a new user. 
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Create a new user account by assigning a unique username for the user.  Enter the username 
as it should appear on reports, complete with professional credentials (in the ‘suffix’ 
field).  Adding a user’s e-mail address will enable future functionality.  

Choose a Primary Department from the dropdown list. For certain functions of the software a 
department needs to be chosen before proceeding. The Primary Department will 
automatically be chosen by default when the user logs in.  

Select the position that describes the User’s function.  Assign a security level from the 
dropdown lists. The user levels are as follows: 

Administrator – Full access to the software, including System Manager tools. 

Supervisor – Full access to the software, except that System Manager access does not include 
Divisions, Departments, or Users. 

User – Restricted access to the software and no access to the System Manager.  Users may 
perform calculations and save results, but cannot change the active/archived status of a 
record.  

Enter an initial password for the user. This password can be changed by the user after the 
initial log in. 

The Divisions that a user is part of can be assigned from the Add User screen. Select [Modify 
List] and choose the Divisions from the Eligible Divisions list to include.  Select [Add Division] to 
move the chosen Division(s) to the Associated Divisions list. Selecting [OK] will commit the 
changes. 

Editing a User 

To edit an existing user, select the System Manager Users tab. From the Department 
dropdown choose the Primary Department of the user to be edited. Choose the user from the 
Active Users list, and the user information will be populated. Edit the information as needed.   

After all desired edits have been completed, select [Save] to save any changes to the database. 
After the save operation has completed, exit the screen by selecting [Close]. 

Adding a Machine (Linac or CT Simulator) 

For full functionality of PIPSpro software it is necessary to enter information about the 
machines in each department. To add a linac or CT Simulator, select the Machines tab in the 
System Manager.  
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Select [New] at the bottom of the screen.  Select Machine type (either Linac or CT Simulator) 

 

 

Select Linac or CT Simulator as your machine type to enter.  Enter a Machine ID. The Machine 
ID should be unique for each linac in the specified department. From the Department 
dropdown list, choose the appropriate department that the machine will be associated 
with.  Fill in all other information appropriately.  If an MV imager and/or kV imager is not 
installed on the machine, select the associated ‘None’ option.   

Fill in all other information appropriately.  Please ensure the linac serial number is entered into 
the Serial text box. 

NOTE: The “TrueBeam” checkbox and “Coordinate System” dropdown are only available if the 
selected Manufacturer is ‘Varian’.  Check the “TrueBeam” check box if the linac being defined 
is a Varian TrueBeam.  
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Setting Thresholds 

Alert and error thresholds for modules other than Imager QA are specified in the Thresholds 
tab.  These modules include: Radiation Light Field, Stereotactic, StarShot, Image-Based MLC 
QA, and Logfile-Based MLC QA.  Imager QA alert and error thresholds are specified in the 
Baseline Editor. 

When a new linac is defined in the System Manager, default error thresholds are set to the 
tolerance levels suggested by TG-142.  Default alert threshold levels are meant to be more 
stringent than error threshold levels, and so are typically set to one-half the value of the default 
error threshold levels. 

 

During the original definition of the linac in the System Manager, the Image-Based MLC QA 
Inter-Leaf Leakage (%) ‘Baseline’ value will be blank (undefined).  You should obtain, for the 
given linac and energy, one (1) to five (5) Inter-Leaf Leakage images and then obtain results in 
the PIPSpro Image-Based MLC QA Module for these images.  Enter the average of the results 
that PIPSpro has produced, found in the Results Tab as ‘Inter-Leaf Leakage (%)’.  As shown 
above, the 6 MV Baseline Inter-Leaf Leakage average value for this linac was found to be 2.0%. 
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Adding a Phantom 

After the machine information is established, begin entering information for each phantom by 
selecting the Phantoms tab. 

 

Then select [New] at the bottom of the window. 

 

 

Fill out all fields appropriately, ensuring each phantom has a unique Phantom ID.  Edit the 
Planner Phantom ROI line-pair frequencies and/or the Catphan ROI line-pair frequencies and 
Catphan HU values, if the manufacturer-supplied calibration data for the phantom are 
different from the PIPSpro default values. Repeat until all phantoms have been recorded. 

Note: There is no phantom entry for the CT/Sim Check Phantom as phantom values for this 
phantom are coded into the software.  Tolerances for the CT/SIM Check analysis can be set or 
adjusted in the baseline editor. 
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Archiving Records in the System Manager 

Once a Division, Department, etc., is entered in the System Manager, it cannot be 
deleted.  However, it can be archived.   

Archiving separates obsolete items from active data without deleting them entirely.  To 
archive, select a category from the menu bar at the top of the System Manager window, 
ensure the Active item list is shown by clicking on the corresponding ‘Active’ button, then click 
on the desired item to select it.  When the desired item is highlighted, select [Archive].   

To view Archived items, select the corresponding ‘Archived’ button in the lower left of the 
System Manager.  To return to the ‘Active...’ item list, select the corresponding ‘Active’ button. 

If you need to re-activate an archived item, select the particular item, then select [Activate].  

6.3 Title Bar 

 

Shows the user’s Department, the Linac being tested, and the currently selected application. 

6.4 Menu Structure 

 

• The File menu allows access to the System Manager, duplicates functionality of the 
“Standard Action Buttons” and adds the ability to print History Reports and to Export 
cumulative results.  The latter two functions are also found on the Blue Bar. 

• The Machine menu allows you to select Linacs in your Division to use with the various 
PIPSpro applications.  Your Linac selection will persist and no Machine re-selection is 
needed before selecting to use a different PIPSpro application. 

• The Application menu allows you to select applications to launch. 
• The Window menu allows you to switch to applications that are currently running. 
• The Help menu provides a link to the current PIPSpro User Manual (this document), 

information about the current release in the About Box, and to access the PIPSpro 
license activation. 
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6.5 Results Dashboard 
The Results Dashboard shows an overview of the last analysis results for a selected 
linac.  PIPSpro calculation results that do not drop below the ‘Alert’ threshold will be denoted 
with a green circle, indicating ‘Pass’ status.  Results that satisfy the ‘Alert’ Threshold but do 
drop below the ‘Error’ threshold will be denoted with an amber triangle, indicating ‘Alert’ 
status.  Results that satisfy the ‘Error’ threshold will be denoted with a red square, indicating 
‘Fail’ status. 

The Show/Hide Dashboard button located on the upper right of the application provides 
control of the Results Dashboard presentation.  Linacs may be selected via the Machine 
dropdown list on the Results Dashboard. 
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6.6 Launch Applications 
All applications are launched by selecting a menu item. 

 

 

 

6.7 Blue Bar 
 

 

The Blue Bar allows the user to easily switch from Image Analysis, or logfile Analysis, to the 
History View, to print History Reports, and to Export cumulative result in a comma-separated 
variable (*.csv) type format. 

 

 

6.8 General Application Layout 
Applicability:  All applications, except IGRT.  Some other applications do not have all 
functionality. 

Most applications have two window areas:  A left-hand panel that displays information 
pertinent to the tests that are being performed and a right-hand panel that displays images or 
logfiles in one tab, and result in another. 
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Whenever possible, after data are loaded, results will be calculated automatically, and the 
Results tab will be displayed immediately.  A Window/Level bar on the left of the image may 
be used to adjust the image display.  Changing the ‘Window’ and/or ‘Level’ controls does not 
alter the image information in the source DICOM image.  The only change occurs to the 
presentation of the image in the image display.  
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The Comments area allows the user to enter information related to the results that will be 
saved in the database and shown in reports. 

 

6.9 Standard Action Buttons 
All applications, except IGRT, have the standard action buttons below.  IGRT just has [Save]. 

 

 

 

Appearance after calculation 
 

Appearance before calculation 
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The [Load], [Calculate], and [Reset] functions are somewhat different in each application and 
will be separately described for each application.  [Save] and [Print] are similar enough that 
they can be described together. 

Note that the standard action button functionality can also be accessed under the “File” 
menu.  And, as such, “hot keys” can be used for some functions (e.g., Load, Save, and Print). 

 

6.10 Loading Data 
See description of individual application. 

 

6.11 Calculating or Resetting Calculations 
See description of individual application. 

 

6.12 Saving Results 
Availability:  All modules. 

Saving results permanently enters them into the PIPSpro database.  These results can later be 
reviewed through the use of the “History”, “History Reports” or “Export” functionality available 
in PIPSpro.  In the case of Imager QA, saved results can be used to create baselines for 
different test conditions using the “Baseline Editor”.   Results can be archived, so that they do 
not appear in “History”, “History Reports” or “Export”.   Archived results can be later restored. 

 

6.13 Quick Selects 
Quick Selects can be created in Imager QA and Logfile-Based MLC QA, when unique 
combinations of parameters are used in a test.  Quick Selects allow tracking and trending of 
results that are parameterized.  For instance, Imager QA Quick Selects are created for unique 
combinations of imager, phantom, energy, and test type (e.g., single planar, CBCT). 
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6.14 Printing Results 
Availability:  All modules, except IGRT. 

Selecting [Print] brings up a print preview window for a report.  If the results have been saved 
to the PIPSpro database, an approval dialog will present first.  You do not need to approve 
before printing. 

    

Paper printing  

Select the “Print” button in the preview window to open a standard Windows “Print” dialog.  

PDF Save  

Select the “Save” button in the preview to open a standard Windows “Save As dialog”.  
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6.15 Approving Results 
Availability:  All modules, except IGRT. 

Results that are saved to the database can be approved by a Physicist or Physician.  Approval is 
available when a saved result is printed.  Approval status can be viewed in the History.  This 
functionality is available only if you are not logged in as Superuser.   

 

 

6.16 Alert and Error Thresholds - Non Imager QA 
Availability:  All modules, except IGRT. 

Thresholds can be set in the System Manager by a user with Administrator or Supervisor 
permissions.  When a machine is created, it is assigned default error thresholds that are the 
limits specified in TG-142.  Alert threshold defaults are typically one-half of the TG-142 limits, 
but may be different, smaller or larger values for some quantities.  These different alert 
thresholds are based on experience that we have had while using PIPSpro. 

 

 

 

 

 
Appearance after calculation 

 
Appearance before calculation 

 

Alert and error thresholds for Imager QA are set in the Baseline editor. 
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6.17 Advanced Parameter Expanders 
Availability:  All modules, except IGRT. 

Advanced parameter expanders allow the user to change parameters that affect test 
execution.  These parameters are not and should not often be changed.  Default values from 
your installation are typically satisfactory. 

 

 

6.18 History View 
Availability:  All modules. 

To view QA result histories, select [History View] from the blue bar.  
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Common Settings 

• Date Range - Select all “Show All” or a subrange of acquired results. 
• Table View - Shows the active or archived data that match the chosen settings. 
• Many, but not all, table views color results.   
• The “Don’t Chart” check box can be used to prevent the data from appearing in the 

charts. 
• Chart View - Charts the active or archived data that match the chosen settings. 
• Clicking on the legend name of any of the charted values turns on/off that series on the 

charts. 

Several modules have additional settings to specify the type of data to be displayed (e.g., 
Image-Based MLC QA allows selection of “Leaf Position”, “Multi-Port” or “Leaf Transmission”). 

Chart Manipulation and Data Archiving 

Zooming in Chart View  

Clicking and dragging within a chart will expand the chart in the drag area.  

Selecting the “Zoom out one level” button [icon goes here] will zoom a chart to the previous 
level.  

Selecting the “Zoom out all levels” button [icon goes here] will completely unzoom a chart.  

 

Printing or Saving a History View Report  

Availability:  All modules, except Image-Based and Logfile-Based MLC QA. 

Selecting [Print] in the left hand panel will launch a Print Preview window showing Table 
Views and Chart Views.   Results can be printed or saved as PDF. 

 

Record Status  

Availability:  Supervisor or Administrator 

If data saved to the database are not relevant, the data can be archived so that they do not 
appear in Table and Chart Views.  

To archive data, in the Table View, highlight the row of data that is to be archived by clicking 
on it.  The row will turn blue.  Selecting “Don’t Chart” is different functionality and cannot be 
used to select data for archiving (or un-archiving). 
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Multiple rows can be selected by using the Shift (continuous) or Ctrl (multiple choice) keys 
when clicking. When the data to be archived are highlighted, click on [Archive Selected] in the 
left hand panel. 

 

To un-archive data switch the Record Status View to “Archived”. In the Table View, highlight 
the row of data that is to be un-archived by clicking on it. When the data to be un-archived are 
highlighted, click on [Restore Selected] in the left hand panel. 

 

 

6.19 Export 
Availability:  All modules, except Logfile-Based MLC QA. 

Data that have been saved to the database can be exported in comma separated variable 
(.csv) format allowing for analysis in the user’s choice of software programs.  

To export data, select the Export Tab or File->Export.  
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A dialog will appear allowing you to select date ranges and types of results to export. 

 

 

 

 
Export Dialog from Image-

Based MLC QA 
Export Dialog  

from Imager QA 

 

Notice, above, that the export for Imager QA is Quick Select-based, because the Quick Select 
captures information about the restricted type of data that the user may be interested in. 

 

6.20 Acceptable Image Formats 
 

Module DICOM 16-bit TIFF BMP HIS RAW CyberKnife 

Imager QA, MV Planar Y N N N N N/A 

Imager QA, kV Planar Y N N Y Y Y 

Imager QA, CBCT Y N N N N N/A 

Radiation Light Field Y Y Y N N N/A 

StarShot Y Y Y N N N/A 

Stereotactic Y N N N N N/A 

IGRT N/A N/A N/A N/A N/A N/A 

Image-Based MLC QA Y Y Y N N N/A 

Logfile-Based MLC QA N/A N/A N/A N/A N/A N/A 
 

HIS and Raw images are typically associated with ExacTrac.  Imager QA only accepts DICOM 
and native kV image formats, because conversion to BMP or TIFF formats may affect image 
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fidelity (e.g., spatial resolution).  IGRT does not do any image processing.  Logfile-Based MLC 
QA relies on logfiles of MLC and other machine data.  

 

6.21 General Image Acquisition 
For consistency, it is recommended that you create a ‘QA Patient’ in your record and verify 
system. Having standard fields that you use over and over allows easier setup and ensures that 
images are acquired in the same manner each time.  

Many of the images that PIPSpro analyzes can be DICOM images from portal imagers 
(EPID).  Image acquisition typically requires a minimal amount of radiation (3-5 MU).   For 
instructions on how to obtain images on your treatment machine, please contact your 
treatment machine manufacturer. 

Film image are also analyzed in some PIPSpro applications.  Either standard radiographic or 
radiochromic films can be utilized. The film needs to be digitized using a film digitizer or a 
high quality flatbed scanner. The film should be scanned as a grayscale image with a 
resolution of between 72 and 96 dpi and then saved in a TIFF or BMP format.   When using 
film, make sure that you use “buildup” or your images will appear faded and potentially be 
unusable. 
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6.22 Image Composition 
Availability:  StarShot, Imager-Based MLC QA 

Images acquired for StarShot and Imager-Based MLC QA are often acquired as separately 
irradiated image segments.  To create a composited image from separate image segments, 
navigate to a directory where segments can be found and select all segments that you would 
like to composite. 

 

All images must be of the same type and have the same dimensions in order to be 
composited.  

When ready, select [Open].  
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If the selected files can be composited, a Save As dialog will appear. You must save the 
composited file in order to use it in further image analysis. You may select any name for the 
composited file.  

 

The composited image file will retain the file type of the original files (i.e., if DICOM (.dcm) 
images were used, the composited files will also be a DICOM image). The composited image 
will also retain the same dimensions as the original images.  

Once the file has been saved, the system will display the composited image in the Image tab.  

 

6.23 Acceptable Logfile Formats 
Varian TrueBeam – Trajectory logfiles 

Varian Clinac Series – DynaLog files 

Elekta with Agility MLC – “TRF” files 
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6.24 Imager QA Module 
Imager QA is designed to analyze flat panel planar and CT (both Cone-beam and Diagnostic-
quality) images for quality assurance and to track possible changes in performance over time. 

Planar Images may be taken with either the QC-3 phantom (for MV images), the QCkV-1 and 
QCkV-R phantoms (for kV images), or the Leeds TOR-18 Phantom (for kV images).   

Two types of planar image analysis exist: Single image analysis uses a phantom image and a 
full field open image (without phantom in place).  Dual image analysis uses two identical 
phantom images. 

Single image analysis provides quantitative information for noise, spatial resolution, the 
contrast-to-noise ratio (CNR), and uniformity.  Dual image analysis is not recommended, 
because it does not perform uniformity calculations. 

CT images may be acquired using the Catphan® model 503, 504, 600, and 604 
phantoms.  The analysis for CT images provides a variety of quantitative information including: 
uniformity and noise, HU constancy, spatial resolution, geometric distortion, slice thickness, 
low contrast visibility, and low contrast detectability. 

Demo images are available in:  C:\Program Files\Standard Imaging\PIPSpro\Demo Images. 

 

6.25 Planar Image Analysis 

Acquiring Planar Images 

Planar MV images may be taken with the QC-3 phantom; Planar kV images may be taken with 
the QCkV-1, QCkV-R phantoms, or Leeds TOR-18 phantom. 

For MV images, place the QC-3 in direct contact with the imager cover with the gantry in the 
neutral position.  Alternatively, the phantom can be set up on the stand on the treatment 
couch with the gantry rotated 90 degrees.  In either case, it is important to use the same 
setup, including source to image distances and energies for all images as different setups will 
produce different results. 

For kV images, the phantom should be set up on the stand on the treatment couch.  Again, it 
is important to use the same setup, including source to image distances and energies for all 
images as different setups will produce different results. 

The QC-3, QCkV-1 and QCkV-R phantoms are aligned at a 45 degree angle and should be 
positioned so the number ‘1’ on the phantom faces the gantry.  Lines and marks on the surface 
of the phantom assist in aligning it to the central axis of the beam.  The TOR-18 phantom 
should be set up according to manufacturer recommendations. 

Users of the TOR-18 test tool should be aware that this phantom was not designed for 
automated analysis of the bar patterns.  Only the nine lower frequency bar patterns are 
included in the automated analysis, so the user-selectable RMTF trend points should be set at 
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F90 and F80 for this phantom in order to avoid having trend points placed solely on the 
extrapolated portion of the curve. 

There are two different methods for planar QA: 

Single Image Planar Analysis 

Single Image planar analysis requires one phantom image and one flood field image.  MV 
images should be taken with approximately 3 - 5 MU.   

Dual Image Planar Analysis 

Two “identical” images should be taken in succession with approximately 3 - 5 MU each (MV) 
(for instructions on how to obtain images on your treatment machine, please contact your 
treatment machine manufacturer).   

Concerning Image Quality and Format 

Images created on Varian machines in IMRT or integrated mode tend to introduce some 
image noise which can be unpredictable and may cause the noise or contrast-to-noise 
calculations to report failures more often.  kV images should be acquired using between 70 
and 100 kV and the lowest exposure (mAs) settings available (for instructions on how to obtain 
images on your treatment machine, please contact your treatment machine manufacturer).  It 
is necessary to leave a small margin around the phantom images for automatic analysis to 
occur. 

NOTE: You may need to experiment with different settings in order to achieve acceptable 
images for analysis. 

The flood field image should be acquired with as much of the imaging panel exposed as 
possible without causing damage to the imager electronics.  It is very important that once 
baselines are created that the identical setup and acquisition parameters are used in 
obtaining images for continuing QA tests. 

Images must be exported in DICOM format, with the exception of CyberKnife images (see 
Concerning CyberKnife Images, page 77) and ExacTrac Images (see Concerning ExacTrac 
Images, page 77).  All images must be exported to a location accessible by the PIPSpro 
software.  Acceptable DICOM Modality attribute tag (0008, 0060) values: ‘CR’ (Computed 
Radiographs), ‘CT’ (Computed Tomography), and ‘RT IMAGE’ (Radiotherapy Image). 
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Launch 

Open the Imager QA module by choosing Application>Imager QA from the menu. 

 

This will display the Imager QA module... 
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Image Analysis 

Select Configuration 

To use the Imager QA module, the imager, test type, 
phantom, and energy used to produce the images 
must be identified.  If this is a new configuration, use 
the drop-down menus in the Manual Select section 
of the information panel.  For planar imaging tests, 
either “Single Planar” or “Dual Planar” should be 
selected as the test type.  Single planar is the 
preferred method, because it reports image 
uniformity as one of its results. For configurations 
whose analysis results have been previously saved, a 
Quick Select will exist. 

Quick Selects are created automatically when the 
analysis results for a new configuration are 
saved.  These Quick Selects have two functions: to 
provide a quick and easy method of referring to a 
known configuration, and to provide access to 
historical data for tracking and trending. 

Note that options provided in each of the Manual 
Select drop-down menus come from information 
entered in the PIPSpro System Manager (e.g., imager, 
phantom, energy). 
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Load Images 

When doing Planar Analysis, both images are loaded at the same time.  Select [Load], browse 
to the folder with your images, and select two images from the same imaging session (click, 
control-click).  Select [Open] and processing will occur. 

If desired, the markups can be adjusted after the results are calculated by navigating to the 
Image tab (lower left), and selecting [Tools] in the upper right corner. 

NOTE:  If auto-detection fails, the application will display the Tools menu in order to place 
markups manually. 

If the current images correspond to a Quick Select configuration with existing data, the 
application will also provide the option to use previously confirmed markup positions, and will 
use these positions automatically if auto-detection fails. 

NOTE: Manual placement of markups may be required the first time the software is used. 

In most cases, markups will be displayed in blue. However, if you are using new Quick Select 
criteria and auto-detection fails, the initial markups will be displayed in red. 

If the markups are displayed in red, they must be manually adjusted before the system will 
allow you to calculate results.  
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Concerning CyberKnife Images 

For acquisition of the CyberKnife images the QC-kV1 Phantom should be placed in the 
CyberKnife stand and set up to be parallel to the Imager A and Imager B as seen here with the 
phantom label facing the stand and region one of the phantom at the top, towards the ceiling: 

 

When loading a CyberKnife image, it is important that the imager type specified in the System 
Manager matches the type of CyberKnife images that you are trying to analyze (G3 and G4 
and iRayimages are different).  CyberKnife files that may be analyzed are named as follows: 

A_##_##########_PA_UP  or  B_##_##########_PA_UP 

Or 

A _*_UNPROCESSED_* or  B_*_UNPROCESSED_*. 

Where the leading letter “A” or “B” indicates which of the two CyberKnife imagers produced 
the image file, and the following “UP” or “UNPROCESSED” designates the file as containing an 
unprocessed image.  CyberKnife image files do not have a file extension.  Only files that follow 
these conventions can be analyzed. 

NOTE:  CyberKnife image files are not in DICOM format.  They are in a CyberKnife proprietary 
format, which can be analyzed by Imager QA.   

Concerning ExacTrac Images 

ExacTrac kV imagers produce three different types of images:  *.his, *.raw, and *.dcm.  PIPSpro 
supports all three formats.  *.his and *.raw images are both 16-bit “raw” format images.  We 
recommend using the raw format images, because we have seen DICOM images that are 
coded as 8-bits per pixel. 
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Tools 

To adjust markups, select [Tools] in the upper right corner of the Image Analysis view.  This will 
display the Tool options. 

Edge Tool 

The Edge Tool allows you to manually select the edge of the phantom. When using this tool, 
the cursor will appear as a square. Position the square cursor so that the edge of the phantom 
sits in the middle of the square and click. The application will retry auto-detection using the 
repositioned square and attempt to redraw the edges accordingly. 

The Edge Tool has an associated Invert Image checkbox. This inverts the pixel grayscale values 
and allows the user to re-attempt auto-detection. Note that when using this option, the 
appearance of the image will not change, the pixel inversion is performed behind the scenes. 
Also, the application will continue to invert the image for all subsequent edits, until the Invert 
Image checkbox is deselected. 

Markup Tool 

The Markup Tool allows you to manually move the entire set of markups. Simply click in the 
middle of the markup bounding box and drag it to a new location. 

To expand or contract the markup area, position the cursor over the edge of the markup 
bounding box until the cursor is displayed as perpendicular arrows. Click and drag to adjust 
the size of all the markups within the bounding box. 

To rotate the markups, position the cursor over the corner of the markup bounding box until 
the cursor is displayed as rotating arrows. Click and drag to rotate the markups to the desired 
degree of rotation. 

Adjustments Completed 

When finished making adjustments, select [Done], then [Calculate] to perform the 
calculations. 

 

Calculations 

Once calculations have been performed, the Results View will be displayed on a new tab page. 

If there is a baseline associated with the Quick Select option in use, measurement values and a 
pass/fail indication will be given for each test.  If there is no associated baseline, the 
measurement values will be displayed, but no pass/fail indication will be made.  Refer to the 
Baseline Editor section for more information. 

 

Results View 

The Results view will be displaying both the calculated results, and the images analyzed. 
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The table displays results for the following tests: noise, and the contrast-to-noise ratio 
(CNR).  Single image analysis also includes: relative modulation transfer function (RMTF) and 
uniformity calculations. 

The graph shows the RMTF for the phantom images along with vertical lines representing the 
F50 and two configurable f-values (defaults: F40 and F30). 

For a complete description of each test, refer to Appendix A: Imager QA Algorithms. 

Planar Resolution Results 

Choose between plotting individual or all resolution results.  The alert and error thresholds are 
only displayed on the graph when a single resolution is being displayed. 

 

6.26 CT Image Analysis 

Acquiring CT Images 

CT images may be acquired using the Catphan® model 503, 504, 600, and 604  phantoms. 

It is very important to set up the Catphan phantom carefully, according to the manufacturer’s 
instructions.  The phantom should be set up at isocenter and precisely aligned using the exact 
method described in the Catphan manual.  Scan the phantom with a high-quality imaging 
technique.  The CBCT Module requires image reconstruction using 2.5 mm slices and the 
smallest field of view (24x24 cm is optimal, however 27x27cm is acceptable) because it 
provides the highest resolution (i.e., more pixels per unit of measure).  Techniques that use a 
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full rotation give the most reliable result in the module.  Reconstruct the image at the highest 
pixel resolution possible, 512 x 512 or 1024 x1024 is recommended. 

After acquisition, export the DICOM CT data set to a directory that PIPSpro has access to.  To 
facilitate a faster load time, it is recommended to keep each CT series in its own directory 
folder. PIPSpro recommends our included tool: “(SI) DICOM Router 3.6.0 

Please note that Imager QA may only import DICOM (.dcm) images that are the direct output 
of MV or kV imagers.  Imported images must be raw, not processed. 

Launch 

Open the Imager QA module by choosing Application>Imager QA from the menu. 

 

 

This will display the Imager QA module... 
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Image Analysis 

Select Configuration 

 

To use the Imager QA module, the test type, imager, phantom, 
and energy used to produce the images must be identified.  If this 
is a new configuration, use the drop-down menus in the Manual 
Select section of the information panel.  For CT analysis, either 
cone beam or diagnostic, enter “CT” as the test type.  For 
configurations whose analysis results have been previously saved, 
a Quick Select will exist. 

Quick Selects are created automatically when the analysis results 
for a new configuration are saved.  These Quick Selects have two 
functions: to provide a quick and easy method of referring to a 
known configuration, and to provide access to historical data for 
tracking and trending. 

Note that options provided in each of the Manual Select drop-
down menus come from information entered in the PIPSpro 
System Manager (e.g., imager, phantom, energy). 

NOTE: If you are using a Quick Select in which markup adjustments have been made, those 
adjustments will automatically be applied to the image.  However, previous adjustments 
made to the key slice location will not be applied.  This is because the key slice position is 
dependent on how the scan was performed, not the configuration of the phantom. 

Load Images 

To analyze a CT series, select [Load] to browse for the folder containing the DICOM files you 
would like to analyze.  Select the folder name and the image series (there may be only one), 
then select [Open] to load the files.  If the browser does not see images that are in a folder, 
changing the file extension to “*.*” may help as DICOM files are not required to have a file 
extension.  
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Using the CT Image Browser 

If the CT series does not reside on a windows drive “mounted” on your computer, but is 
accessible via a “Windows Network Share,” then you may type or paste the directory path into 
the ‘Directory’ field using Microsoft UNC format for that shared resource.  Press <ENTER> to 
activate the typed path and the CT Image browser will scan the UNC path for CT series 
files.  The UNC path will then be added to the navigation tree in the right hand side of the CT 
Image browser. 

See Appendix I: UNC Paths for information on determining the appropriate text for a particular 
Microsoft UNC path. 

 

After Loading Images 

Once the images are loaded, the application will try to automatically find the key slice.  No 
analysis or adjustments of markups can be done until the location of the key slice is set.  The 
key slice is used by the software to determine the relative position of analysis slices within the 
phantom.  An analysis slice is used to perform one or more tests, such as ‘Uniformity and 
Noise’ or ‘HU Constancy’.   

 

Catphan 503, 504 and 604 Key Slice 

 

 

Therefore, a CT series will only have one key slice, but multiple analysis slices.  In the Catphan ® 
503, 504, 600, and 604 phantoms, the key slice is also an analysis slice. 
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If the key slice is automatically found, the application will place markups on the key and 
analysis slices and display the results view.  To view the image again, select the Image tab.  Use 
the ‘Go To’ buttons located along the side of the image area to navigate through the CT series.  

If the key slice is not found automatically, the user must manually locate the key slice.  Please 
note that the key slice must be set before any other slices are located or adjustments 
made.  Use the scroll bar or mouse wheel to move to the correct slice position.  Select [Set Key 
Slice] in the right panel to designate the currently displayed image as the key slice. 

NOTE:  If poor image quality may have contributed to the system not locating the key slice 
automatically, it may be prudent to investigate the causes of the poor image quality before 
analyzing and trending the CT image data. 

When the key slice is set, either automatically or manually, the user may inspect the markups 
on each analysis slice by using the ‘Go To’ buttons in the right panel.  Refer to the Tools section 
for instructions on setting analysis slices and adjusting markups. 

NOTE:  If you are using a Quick Select in which markup adjustments have been made, those 
adjustments will be automatically be applied to the image. 

When ready, select [Calculate] in the left panel. 

 

 

On Finding the Key Slice 

If analysis has been set up manually (i.e., without the use of a Quick Select), the system will first 
try to find the key slice in the original image z-order.  If the system cannot find the key slice in 
the original image order, it will automatically reverse the images and try to find the key slice. 
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Tools 

There are two ways to adjust the markups: click and drag with the mouse, or use the arrow 
keys on the keyboard.  In general, the click and drag method will be better for large changes, 
while using the arrow keys will be better for small adjustments. 

NOTE:  Prompts are provided in the Help panel for additional guidance on adjusting markups. 

Please note that adjustments made to key slice markups will be applied to markups on all 
other analysis slices.  Adjusting markups on an analysis slice (non-key slice) will only affect the 
markups on that slice. 

To adjust markups, begin by navigating to an analysis or key slice.  For mouse-based 
adjustments, you can click and drag the markups at any time.  For arrow-based adjustments, 
first select one of the Adjust Markups radio buttons, and then use the arrow keys as needed: 

 

• Translate:  Use the (keyboard) arrow keys to move the markups up, down, left and 
right.  Each press of the arrow key will move the markups 1 pixel in the selected 
direction.  To move the markups 10 pixels at a time, hold the Shift key while pressing 
the arrow key. 

• Rotate:  Use the (keyboard) arrow keys to rotate the markups.  The right arrow key will 
rotate the markups clockwise; the left arrow key, counter clockwise.  Each press of the 
arrow key will rotate the markups 1 degree in the selected direction.  To rotate the 
markups 10 degrees at a time, hold the Shift key while pressing the arrow key. 
NOTE:  The center of the bounding box is used as the axis of rotation. 

• Scale:  Use the (keyboard) arrow keys to scale the markups.  Use the up arrow key to 
expand the markups, and the down arrow key to contract.  Each press of the arrow key 
will scale the markups by 1 pixel in the selected direction.  To scale the markups 10 
pixels at a time, hold the Shift key while pressing the arrow key. 
NOTE:  The bottom tip of the bounding box is always the fixed location when scaling 
with the arrow keys.  Ensure the bottom tip  of the bounding box is in the correct 
position before scaling. 

 



PIPSPRO™ SOFTWARE  89 

Slice Order Reversal 

The Imager QA module will typically find the key slice 
automatically.  If the key slice is not found automatically, you may 
want to reverse the z-order of the image slices in order to locate and 
set the key slice manually. 

To reverse the order of image slices, select the Slice Order check box 
(labeled “z-order reversed”) on the right panel.  After the image 
order has been reversed, you will need to manually set the key slice. 

Manually Setting Slice Locations 

If needed, image slice positions can be reset manually.  To begin, 
use the ‘Go To’ buttons to navigate to the automatically located 
slice.  From there, use the scroll bar or mouse wheel to move to the 
desired slice position.  Notice that the corresponding ‘Go To’ button 
is now a ‘Set’ button. 

 

Select the ‘Set’ button to use the displayed slice as the analysis slice.  The application will apply 
markups accordingly.  Repeat as needed. 

NOTE:  Always make sure the key slice is in the correct position before resetting any other 
slices. 

 

Toggle Markup Display 

If you would like to see the image without markups, 
select [Hide Markups]. 

To display the markups again, select the same button, 
now labeled [Show Markups]. 

 

When adjustments have been completed, select 
[Calculate], located on the left panel. 
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Results 

The initial results view will display the CT Results Overview (Summary).  Select a category from 
the Summary table to view the detailed results page for that particular category by clicking on 
the category name.  Alternatively, use the dropdown menu in the upper right to move 
between the summary and results pages. 

 

Tests include: 

Uniformity and Noise:  Describes the distribution of pixel values observed in similar 
homogeneous regions of the phantom. 

HU Constancy:  Measures the average pixel values for regions in the phantom with 
known electron densities to determine differences between measured values and 
baseline (or expected) values.  This allows tracking of imaging pixel value drift over 
time. 

Spatial Resolution:  Measures the precision with which the imager can distinguish 
small items and fine line pairs. 

Geometric Distortion:  Provides an assessment of image symmetry and calibration of 
the image display system. 

Slice Thickness:  Provides an assessment of the scan’s slice thickness accuracy. 

Low Contrast Visibility:  Provides an assessment of the image quality based on the 
ability of a user/image analysis algorithm to identify low-contrast objects. 

Low Contrast Detectability: Evaluates a CT scanner’s low contrast performance against 
a series of targets of different contrast levels, each level supporting several diameters. 
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For a complete description of each test, refer to Appendix A. 

 

Calculations 

Once calculations have been performed, the Results View will be displayed in a new tab page. 

A pass/fail indication will be given for each test only if a baseline is associated with the Quick 
Select option in use.  If there is no associated baseline, the measurement values will be 
displayed without a pass/fail indication. 

Baseline Editor 

Baselines are created by averaging several measurements together and making adjustments 
to the tolerance settings as needed.  Baselines can also be created by entering an expected 
value based on past experience or published results. 

Launch Baseline Editor 

Begin by selecting Imager QA>Baseline Editor from the main menu.  This will display the 
Baseline Editor dialog. 

 

Select the desired configuration from the Quick Select menu.  This operates in the same way 
as the Quick Select menus elsewhere in Imager QA. 

If the selected configuration already has a baseline, a green dot will appear to the left of the 
baseline’s name. If not, the application will provide the opportunity to create a new baseline. 

Creating a Baseline 
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To create a baseline, select a Quick Select from the dropdown and select [Create new 
baseline].  The application will then display a table containing all records associated with the 
selected configuration.  Select which record(s) should be used to create the baseline.  If 
multiple records are selected, they will be averaged together.  When finished, select [OK].   

The application will display the Baseline Parameters view.  Fill in tolerance levels for the alert 
and error ranges.  These tolerances can be manually filled in as values and/or percentages.   

If you would like to set the same percentage difference for all tolerances, select the checkbox 
next to the ‘link’ symbol.  Enter the value in the first field and the system will copy that value to 
all subsequent fields.    After the desired values have been copied to all subsequent fields, the 
checkbox can be deselected to allow editing of copied values. 

 

Editing a Baseline 

To edit an existing baseline, choose a Quick Select from the dropdown and select [Edit].  This 
will allow changes to be made to the baseline parameters.  The records averaged to create the 
baseline, however, cannot be changed. 

 

Recreating a Baseline 

To recreate an existing baseline, select [Recreate].  This will allow for changing the averaged 
records used to create the baseline.  For further details, see Creating a Baseline, above. 

 

Using Tolerances from a Different Baseline 
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It is possible to create a new baseline using the tolerances from an existing baseline.  This 
option is only given if baseline of the same/comparable type exists.  To use this option select 
the ‘Copy alert and error thresholds from existing baseline’ checkbox.  This will display a menu 
to choose which existing baseline to use.  Once a selection has been made, continue creating 
the baseline as normal.   

 

Setting the Effective Date 

The effective date of a baseline is the date at which its thresholds take effect. There can be 
more than one baseline; one baseline stops where another takes effect.  The effective baseline 
can be set to any date between the acquisition of the first image (series) and the current date. 

 

Saving a Baseline 

After the baseline parameters have been created and/or edited, select [Save].  The baseline will 
be used for trending in the History View. 

 

Close Baseline Editor 

To close the baseline editor, select [Close].  To close without saving, select [Cancel]. 

 

6.27 Radiation Light Field Module 
The Radiation Light Field Module uses specialized phantoms to perform two different 
tests:  light field and advanced light field.  A light field test uses the FC-2 phantom to 
determine the coincidence between the light field projected from the head of the linear 
accelerator and the radiation being delivered.  The advanced light field test uses both the FC-2 
and the Center Marker phantom to determine offsets of the light field crosshairs with respect 
to the light field and radiation centers. 

Demo images are available in:  C:\Program Files\Standard Imaging\PIPSpro\Demo Images. 

 

6.28 Acquiring Data 
Select either a 10 cm x 10 cm or a 15 cm x 15 cm field with the gantry pointing straight 
down.  Place the FC-2 phantom on the couch top at isocenter.  Using the light field, align the 
FC-2 to the appropriate square on the phantom.  Do not align to the engraved crosshairs on 
the FC-2 phantom; rather, align the nominal light field to the edges of the engraved 
squares.  The crosshair on the FC-2 is just meant to be used for gross alignment. 
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After the FC-2 phantom is aligned, the Center Marker phantom can be placed on top.  Being 
careful not to shift the FC-2 phantom, align the Center Marker phantom so that the crosshair 
and the spherical marker are aligned to the center mark of the light field. 

Your acquired image should appear as below (see General Image Acquisition).  EPID and film 
images are supported. 

 

15cm x 15cm radiation/light field image 

 

Launch 

Open the Radiation Light Field Module by choosing Application>Radiation Light Field from 
the menu. 

 

Loading Data 

Select [Load] and browse to the directory where your images are kept.  Select an image and 
open it.  Results will automatically be calculated and displayed. 
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Results 

 

 

FC-2 Results 

The light field center is the centroid of the four outermost fiducials (identified as shown in the 
image markups, below).  The radiation field center is the centroid of the irradiated region. 

• Radiation/Light field displacement - the displacement in the X and Y directions 
between the center of the radiation field and the center of the light field. 

• The Jaw/MLC Displacements – this is based on the Center Marker Phantom fiducial 
location, and  calculates the deviation from the expected jaw position relative to the 
cross-hair position to each field edge, bisecting the expected field size (5cm for 
10x10cm and 7.5cm for 15x15cm Fields). 

• Field Rotation - the measured field rotation based on the detected radiation field 
edges compared to the known light field position. 

• Phantom Dimension - the nominal field size based on the spherical markers detected 
in the phantom (either 15.00 x 15.00 or 10.00 x 10.00). 
 

Center Marker Results 

Radiation field/Crosshair displacement - the displacement in the X and Y directions between 
the center of the radiation field and the spherical marker of the Center Marker Phantom. 
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Light field/Crosshair displacement - the displacement in the X and Y directions between the 
center of the light field and the spherical marker of the Center Marker Phantom. 

Image and Markup Review 

Select the Image tab to view the analyzed image with its markups.  Markups should appear as 
below.  Note that the dot (radio-opaque marker) that appears in the center of the image only 
appears when the Center Marker phantom is used. 

 

 

Advanced Expander 

If results are not satisfactory, default algorithm settings can be changed in the expander at the 
bottom of the page.  However, these settings should rarely, if ever, be changed as default 
settings should work for most images.  Select [Reset] to change these settings. 

 

Offset - the offset in millimeters from the corner of the identified edge that the search region 
for the spherical markers will start from (yellow box corner). 
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Search Area - the size in millimeters of the search region for the spherical markers (yellow box). 

Marker Threshold - Based on the background non-irradiated area pixel intensity, the 
percentage of the value that the software will consider as a spherical marker.  For example, if 
the background pixel intensity is 240 and the Marker Threshold is set to 5%, then a spherical 
marker of at least 12 (i.e., 240*0.05) will be identified as the marker.  If noise in the image is 
being detected as a marker, reducing the Marker Threshold can prevent this and improve 
results. 

6.29 StarShot Module 
StarShot images are used to establish the diameter of the center of rotation of the linac 
gantry, couch, or collimator. 

To create a StarShot image, in most cases, the lower collimators are closed to form a narrow 
slit and radiation is delivered through the slit to film (gantry, couch) or EPID or film (collimator) 
at multiple angles.  Multiple exposures are used to create a composite film or EPID image.  In 
some cases, the EPID image must be composited in PIPSpro (see “Creating Composite 
Images”).  The composite image is then analyzed and the smallest diameter of a circle 
containing and/or tangent to all lines (slits) is determined. 

Demo images are available in: C:\Program Files\Standard Imaging\PIPSpro\Demo Images. 

 

Acquiring Data 

Two types of StarShot images can be analyzed: 

Regular - A typical StarShot image with multiple projections. 

Hybrid - Can only be a collimator StarShot in which a standard spherical marker phantom is 
aligned to the lasers and imaged.  The spherical marker images is then ‘added’ to the 
collimator projections as described in Image Composition on page 20.  Analysis includes 
additional information about the distance from the center of the ball to the center of the 
intersections of the projections. 

Your acquired images should appear as below (see General Image Acquisition).  DICOM and 
film images are supported. 

 

 

 

 
Regular Hybrid 
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Launch 

Open the StarShot Module by choosing Application>StarShot from the menu.  The system will 
display a standard Open dialog.   

 

 

Loading Data 

Select [Load] and browse to the directory where your images are kept.  Select an image and 
open it.   You may also select a number of images, if they need to be composited. Results from 
DICOM images from EPID collimator images will automatically be calculated and 
displayed.  For film images, make sure that you select the angle type (Collimator, Table, 
Gantry) or the [Calculate] button will not activate. 

 

Fiducial Placement 

Projection Intersection 

Film image analysis requires a fiducial to be manually placed that identifies the center of the 
intersection of the projections. To do so, simply click on the image (shown as “1” below). The 
mark only needs to be approximately placed as the software uses an algorithm to determine 
the actual center.  

DICOM images, which are almost exclusively collimator stars, do not need manual fiducial 
placement as the software automatically selects the center of the images as the center of the 
intersection of the projections. 

 

Image Scaling 

If the DPI is not read from the image header, or the DPI is read incorrectly, the image pixel size 
can be determined by using pinholes marked a known distance apart on the film.    

First, clear out the “DPI Value” under the “Advanced Expander”.   Then, type the known 
distance between the pinholes into the “Cal. Distance” text box.  Then, select the intersection 
(shown as “1” below) and then select the two pinholes (shown as “2” and “3” below).  Identify the 
angle type and select [Calculate]. 
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If a fiducial mark is placed in the wrong position, right-click on the image to bring up a menu: 

 

The menu will give you the choice of clearing the last fiducial placed or all fiducials placed on 
the image. 

When the fiducials are positioned correctly click [Calculate] in the left hand panel to begin the 
analysis. 

 

Line Drawing 

It is possible that correct identification of projections cannot be determined even with 
adjustment of the threshold value used to search for projections. In this case the StarShot 
module allows the user to manually define the projections.  

After placing a center fiducial and choosing the image type and the angle type, right-click 
anywhere over the image and the menu above will be shown. 
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Choose ‘Enable Line Drawing’ from the menu. The cursor will turn into the fiducial marking 
tool. Place fiducial marks on opposite ends of the projections you would like included in the 
analysis and the points will be connected by lines. 

 

When all projections have been identified, select [Calculate] to complete the analysis based on 
the manually drawn lines. 

 

Results 

Make sure that you select the angle type (Collimator, Table, Gantry) or the [Calculate] button 
will not activate. 
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Regular Star Shot 

Minimum Diameter - the minimum diameter of a circle that touches each projection at the 
point of intersection shown in both millimeters and pixels. 

Number of Spokes - the number of lines identified. 

 

Hybrid StarShot 

Marker CoG - The millimeter and pixel position of the “center of gravity” of the spherical 
marker. 

Center Displacement - The radial distance between the center of the spherical marker and the 
center of the circle that touches each of the projections. 
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Image and Markup Review 

Select the Image tab to view the analyzed image with its markups.  Markups should appear as 
below.  The green circle is the search radius. The software finds the center of each projection as 
the search is completed around the circle. The centers are then connected by the orange 
spokes. 

 

 

Advanced Expander 

The expander at the bottom of the page does two things: It sets image scaling and allows 
default algorithm settings to be changed.  Select [Reset] to change these settings. 

The default image analysis settings can be changed if results are not satisfactory. However, 
these settings should rarely, if ever, be changed as default settings should work for most 
images.   
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Image Scaling 

Cal. Distance – In the situation where a DPI value is not available from the image header or the 
DPI is not correct and is not known two additional ‘calibration marks’ can be placed on the 
image and the software will use this distance to calculate the DPI of the image based on the 
number of pixels measured between the ‘calibration marks’ and the distance indicated. If a 
DPI is read from the image and an attempt is made to place calibration marks on the image a 
warning will be shown confirming that the user wants to use the calibration distance instead 
of the DPI value.  

DPI value – The resolution of the image in dots per inch (DPI) read from the image header OR 
the calculated value based on fiducials and the Cal. Distance OR a known value entered that 
can be entered by the user.  The DPI value for DICOM images should always be correct. 

 

Image Analysis 

Radius – The radius in pixels of the circle that the software will use to search for the projections 
from the center of the intersections. The software will automatically set this as 25% of the 
shortest side of the image. It may be necessary to adjust this value if the software is having a 
problem finding the projections at the default distance. For instance if an image is overly 
exposed the projections might not be well defined at the default distance and thus the 
distance may need to be increased to a point where the projections are better defined.  

Threshold – The percentage of difference between a background non-irradiated area pixel 
intensity and an irradiated area of a projection that the software will use to determine whether 
a projection has been discovered. For example if the background intensity is 240 and the 
Threshold has been set to 33% (default) then a projection would have to have a pixel intensity 
of approximately 79.2 to be considered a valid projection during the search.  

 

6.30 Stereotactic Module 
The Stereotactic Module allows the user to perform two different Winston-Lutz tests: a 2D test 
that applies to all images that calculates planar radiation-mechanical isocenter offsets and a 
3D test that calculates an “Optimal Isocenter Shift” (Low et al, Minimization of target 
positioning error in accelerator based radiosurgery, Med Phys 22 (4)).  

Demo images are available in:  C:\Program Files\Standard Imaging\PIPSpro\Demo Images. 

Acquiring Data 

Between two and eight DICOM images are required for stereotactic analysis.  Film images are 
not supported, because they cannot be used to accurately calculate the Optimal Isocenter 
Shift due to possible uncertainties in determining the scaling and centers of images. 
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Two images are required for 2D analysis and eight images are required for the Optimal 
Isocenter Shift calculation.  A spherical ball, a Winston-Lutz phantom, is positioned at isocenter 
using the light field crosshairs.  Lasers can be used if they are properly adjusted.  Images of ball 
in apertures defined by jaws, MLC’s, or cones are obtained at differing gantry and couch 
angles.  The ideal aperture for analysis is about 2cm. 

 

Standard Imaging Winston-Lutz phantom (REF 72286) 

 

The recommended IEC angles from the Low paper are: 

Gantry Couch 

60 0 

130 0 

230 0 

300 0 

60 270 

130 270 

230 90 

300 90 
 

These angles are best if you want to calculate the Optimal Isocenter Shift, but any collection of 
eight images with sufficiently varied and distinct angles can be used. 
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Your acquired images, when using the Standard Imaging Winston-Lutz phantom, should 
appear as below (See General Image Acquisition).   

 

  

 

 
Aperture defined by jaws or MLC Aperture defined by a cone 

 

 

Launch 

To open Stereotactic, select Application>Stereotactic, from the PIPSpro main menu. The 
Stereotactic application will be displayed in the PIPSpro frame.  

 

Loading Data 

Select [Load] and browse to the directory where your images are kept.  Select up to eight 
images and open them.  Results will automatically be calculated and displayed (if angular 
information is complete).  

 

Specifying Angles 

DICOM image headers often contain the gantry, table and collimator angles used during 
image acquisition (acquisition may need to be through a plan in the R&V system for this to 
happen).  Sometimes only the gantry and table are included and sometimes there is no 
angular information at all (when images are acquired in service mode). 

 

Decoded excerpt from DICOM header 
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Because of the variety of available information, PIPSpro allows angular information to be 
specified in file names or typed into text boxes for each image. 

There are two file-naming conventions, one old and one new: 

G###C###_AnyOtherText.dcm, where G = gantry and C = couch.  This is the old, pre-5.5 way of 
naming files.   Since the collimator is not specified it is set to the neutral position (0 degrees for 
IEC, 180 degrees for Varian coordinates). 

G###T###C###_AnyOtherText.dcm, where G = gantry, T = table (couch), and C = 
collimator.  This is a new way of naming files that allows the collimator to be specified. 

If there is angle information in a DICOM file header it supersedes any filename-based angle 
specification and differences are flagged to the user.  User-named files are loaded just like 
other DICOM files. 

If you are using images that do not have angles encoded in the filenames or in the DICOM 
headers, you will need to enter angles for each of the images. This is done by entering the 
values into the fields next to each image.  

Coordinate Systems 

 

Different coordinate systems for Varian machines may be specified in the System Manager, 
including Varian Scale, IEC 601-2-1, and IEC 61217.   All other machine types (e.g., Elekta, 
Siemens) are assumed to be in the IEC 61217 coordinate system. Users should verify that the 
angles that are being presented in the Stereotactic module are accurate and the X, Y, Z 
coordinate offsets that are reported are applied correctly based on your particular machine 
setup. 

  



PIPSPRO™ SOFTWARE  107 

Results 
 

 

 

The 2D planar radiation-mechanical isocenter offset error for an individual image is calculated 
as the offset of the ball from the center of the image.  Note that the offsets, dU and dV, are in 
the “U-V” coordinate system as shown.  

 

The “Optimal Isocenter Shift” represents a vector that, if applied to the ball, would result in 
better results on average.  It is specified in standard patient coordinates as shown by the X, Y, Z 
right-handed coordinate system at the head of the couches above, however it must be noted 
that values X, Y, Z, are in fact the position of the Winston Lutz pointer in relation to the optimal 
location.  Thus, the user should shift the Winston Lutz pointer to the inverse of what is being 
displayed in the software as the indicated shift vector.   

This vector can indicate a number of things including errors in ball setup, misalignment of 
lasers or the light field, or actual radiation-mechanical isocenter offsets.  Care must be taken 
when interpreting these results. 

The vector above indicates that better results would be obtained if the ball were moved (for a 
patient in standard head-first supine position) -0.7mm to patient left (X direction), +0.4 mm to 
patient inferior (Y direction), and +0.1 mm to patient anterior (Z Direction) and re-imaged. 
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Image and Markup Review 

Markups should appear as below.  The green region identifies the borders of the irradiated 
region.   The blue box identifies the search area for the ball.  The ball itself is identified by the 
brown pixels.  The center of the ball is identified by the yellow cross and the center of the 
aperture is identified by the green cross.  The dU and dV offsets are calculated by subtracting 
the coordinates of the ball from the coordinates of the center of the aperture. 

 

  

 

 
Proper markups for jaw  

or MLC apertures 
Proper markups  

for a cone aperture 

 

 

Markups can appear as below, if the search offset in the Advanced Expander is not set properly.  (These are the same images above, but with search offsets 
that are too small.) Notice that there are brown pixels identifying the ball, where it is not.  Also, notice the poor placement of the yellow cross identifying the 
center of the ball.   To fix situations as these, increase the search offset (which is calculated from the green border at its top, bottom, left, and right).  

 

 

Advanced Expander 

 

The Search Offset controls the size of the blue search region for the ball inside the green 
irradiated border.  It is measured from the green border at its top, bottom, left, and right.  A 
larger number makes the box smaller; a smaller number makes the box bigger. 
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6.31 IGRT Module 
TG-142 recommends performing tests of positioning/repositioning and imaging and 
treatment coordinate coincidence on a daily basis. 

The IGRT module allows the user to track and trend results of these tests in 3D or 6D 
according to the couch specification in the System manager for the machine being tested. 

The positioning/repositioning test is used to check the ability of your treatment system to 
reliably register daily images of a phantom with known offsets to images of the same 
phantom at isocenter. 

The treatment coordinate coincidence test is used to check that your imaging and treatment 
isocenters match. 

We recommend that you perform the positioning/repositioning test prior to the treatment 
coordinate coincidence test. 

Standard Imaging’s MIMI (Multiple Imaging Modality Isocentricity) Phantom is designed for 
these tests and will provide superior results. 

 

For 6D QA, using the MIMI with the HexaCheck (below) is ideal. 
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Test Procedure 

To open the IGRT module, select Application>IGRT from the main menu. 

 

Prior to doing the IGRT tests it is necessary to create a CT image series of the phantom that 
will be used in the tests.  The CT series should be acquired as a patient would be scanned, 
brought into your treatment planning system, and a plan created that uses that image series. 

To execute the positioning/repositioning test, place the phantom on the couch and align it to 
isocenter using the light field crosshairs or the lasers.  Then offset the phantom a known 
distance in the X, Y, and Z directions.  If the system has a 6D couch, angle offsets may be 
applied as well.  Acquire MV orthogonal images and register the offset phantom using a 2D/2D 
matching algorithm provided with your linear accelerator’s software.  The analysis will provide 
the X, Y, and Z offsets of the phantom compared to the reference images.  If the system has 
the capability, the pitch, yaw, and roll will be provided also.  Save these results comparing with 
the intended offsets in the MV, 2D/2D section of the IGRT software. 

 

Apply shifts suggested by your system software. 

To execute the treatment coordinate coincidence test, without moving the phantom acquire 
either 2D projection images or a full 3D CBCT image series with the kV imaging system.  Use 
either the 2D/2D or 3D/3D matching algorithms on the imaging system to register the newly 
acquired images to the CT series phantom.  The results, if all is in order, should be nearly zero 
in all dimensions (shifts and angles) indicating that the imaging system is in coincidence with 
the treatment beam.  Save these results comparing with the intended offsets in the kV, 2D/2D 
or 3D/3D section of the IGRT software. 

 

 



PIPSPRO™ SOFTWARE  111 

6.32 Image-Based MLC QA Module 
On most treatment machines, a multi-leaf collimator (MLC) is used to shape fields for 
conformal delivery. Most MLCs feature anywhere from 50 to 160 individual leaves.  Over time, 
the motors that drive these leaves can become worn, or the leaves themselves may become 
loose in their carriage. Periodic QA is required to determine if any such issues exist. 

For all Image-Based MLC QA tests, it is recommended that a ‘QA Patient’ be set up in the 
record and verify system. By doing so, you can create the fields that need to be delivered in 
order to acquire images. This allows for easier setup and ensures that the images are acquired 
in the same manner each time. 

Demo images are available in: C:\Program Files\Standard Imaging\PIPSpro\Demo Images. 

Leaf Patterns are available in: C:\Program Files\Standard Imaging\PIPSpro\ 
VarianMLCTestPatterns. 

Image processing for EPID DICOM images is for the most part automatic; however, the Leaf 
Transmission test requires the user to select an energy for which a baseline and has been set 
in the System Manager.  Film image processing requires the use of the MLC QA phantom or 
graticule and manually-placed fiducials (see Film Analysis, below). 

6.33 Test Descriptions 
The Image-Based MLC QA module supports three tests: Leaf Position, Multi-Port, and Leaf 
Transmission. 

Leaf Position Test 

TG-142 recommends doing a monthly quantitative MLC leaf position test using two leaf 
patterns.  The Leaf Position test allows the user to create tests and analyze aligned banks of 
leaves for symmetric fields, where the leaf positions are set to a millimeter value that is a 
multiple of 5.  For instance, a 20 x 40 cm field, a 5 x 40 cm field, etc. 

When a Leaf Position image is analyzed, the system estimates the 
position of the central leaves of the left and right leaf banks.  It then 
rounds the estimated positions to the nearest millimeter that is a 
multiple of 5.  These leaf positions are assumed to be the nominal 
leaf positions specified by the user for each leaf in a leaf bank.  The 
differences between the actual positions of the leaves and these 
nominal positions, in conjunction with the alert and error 
thresholds, are used to determine the results of the test. 
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Multi-Port Test 

TG-142 recommends doing a weekly qualitative MLC leaf position test.  The Multi-Port test is 
the PIPSpro version of the “Picket Fence” test, which is regarded as a standard test for the 
qualitative analysis of leaf positions.  Multi-Port goes beyond the qualitative giving quantitative 
results calculated in a similar manner to the way calculations are done in the Leaf Position 
test. 

The test consists of imaging irradiated strips created by a series of leaf openings that sweep 
across the field. 

Use one of the following five strip configurations:   

• For 40x40 collimators, each irradiated ‘strip’ in the image should be 2 cm wide, 
separated by a 1 cm unirradiated gap.  The middle strip should be centered on the 
central axis of the beam. 

• For 10x10 collimators, each irradiated ‘strip’ in the image should be 1 cm wide, 
separated by a 1 cm unirradiated gap.  The middle strip should be centered on the 
central axis of the beam. 

Note that following the configuration guidelines and setting up the collimator so that there is 
no rotational component to the images is important for obtaining good results. 

It is best to obtain a single image as an integrated image.  If creating an integrated image is 
not an option with your imager, acquire a single image of each strip.  You can combine them 
using the [Load] function, which has automatic image compositing built in (see “Creating 
Composite Images”). 
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Leaf Transmission Test 

TG-142 recommends testing the leaf transmission values on a 
yearly basis. 

Set up the MLC so that the leaves are closed at the isocenter 
plane.  Because the ball markers in the MLC phantom must be 
imaged, two apertures must be opened in the closed leaves:  one 
aperture on the central axis and another aperture either 8 cm off 
axis for 40x40 collimators or 3 cm off axis for smaller collimators, 
such as the BrainLab M3. 

Set the collimators to the largest possible opening in the direction 
perpendicular to the leaf travel.  In the other direction, set the 
collimators to create a symmetric 8 cm shadow as shown in the 
figure below.   

 

6.34 Acquiring EPID Images 
For all Image-Based MLC QA tests, it is recommended that a ‘QA 
Patient’ be set up in the record and verify system.  By doing so, you can create the fields that 
need to be delivered in order to acquire images.  This allows for easier setup and ensures that 
the images are acquired in the same manner each time. 

Raise EPID to the highest position possible without a collision with the couch or 
phantom.  This will ensure that as many of the MLC leaves as possible can be acquired on the 
imager.   

For machines (Varian) in which the maximum imaging size is across the imager, it is advisable 
to turn the collimator 90 degrees so that the MLC’s travel is perpendicular to the maximum 
image dimension.  This will ensure that as many MLC leaves as possible will be imaged. 

For some machines, the imager is at a fixed distance from the source.  This makes it 
impossible to get all or of the MLC leaves in a single image.  In these situations it is advisable to 
take more than one image:  imaging one half of the MLC, then moving the imager to capture 
the other half. 

Acquire images using a minimal amount of radiation (3 - 5 MU). 
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6.35 Launching 
Select Application>Image-Based MLC QA from the main menu.  The Image-Based MLC QA 
application will then open inside of the PIPSpro frame. 

 

Select [Load] and browse to the directory where your images are kept.  Select an image and 
open it.   You may also select a number of images, if they need to be composited.  Images will 
be automatically identified in terms of the tests that they correspond to.  You may override the 
default identification with the “Test Type” dropdown. 

Results from DICOM images for the Leaf Position and Multi-Port tests are calculated 
automatically.  DICOM and film images for Leaf Transmission require an energy selection.   All 
film images need fiducials as described below.  After fiducials are placed, [Calculate] can be 
selected. 

 

Leaf Transmission tests are unique among MLC mechanicals tests in that they need a baseline 
value to calculate pass, fail, alert status.   Without a baseline and thresholds set in the System 
Manager, inter-leaf leakage will calculate, but not show (colored) status.  To show status, you 
must select an MV energy that has these values set. 
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6.36 Acquiring Film Images 
For film, there are two ways to determine the center of an image and its scaling for use in the 
Image-Based MLC QA module.  The preferred way is to use your accelerator’s graticule.  You 
should make sure that the graticule is calibrated so that the center radio-opaque marker 
consistently projects to the center of the field (rotating the collimator should show this).  The 
MLC Phantom should only be used in cases where the graticule will not work ---results are 
comparable with both methods, but the setup of the MLC QA phantom can be tricky. 

 

MLC QA Phantom (REF 72284) 

 

Placing Fiducial Markers 

Once an image has been loaded, two fiducial markers from radio-opaque BB’s in either the 
graticule or the MLC QA phantom need to be identified before analysis can occur. 

Fiducial #1 

The first fiducial is identified as the spherical marker at isocenter.  To do so, click near the 
marker on the image.  The software will perform a search for the maker and automatically 
place the fiducial optimally over the center of the sphere. 

Fiducial #2 

The second fiducial is identified as the spherical marker that is 8 cm off axis for larger 
apertures and at 3 cm off axis for small apertures. 
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6.37 Results 

Leaf Position 

The Leaf Position test is customizable.  Any symmetric leaf pattern that has leaf banks at 5 
millimeter increments can be used, for instance, a 20 x 40 cm field, a 5 x 40 cm field, etc. 

The software calculates the average position of each leaf bank and rounds that value to the 
nearest multiple of 5 mm.  The rounded value is considered the ‘correct’ value for each leaf in 
the bank.  

The chart shows results in the table below. 

 

Multi-Port Test 

The software calculates deviations from nominal MLC leaf positions for 40x40 or 10x10 fields 
(e.g., BrainLab M3). 
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The chart shows results in the table below. 

 

Leaf Transmission Test 

The software calculates percent inter-leaf leakage and inter-bank leakage.  The range, 0-100%, 
is determined from the readings behind the jaws (0%) and the readings in the fully-irradiated 
apertures (100%). 

Inter-leaf leakage receives pass, alert, fail status if there is a baseline and thresholds set in the 
System Manager for the particular MV energy being tested.  Inter-bank leakage does not 
receive status as it is a function of mainly how close leaves on opposite banks can approach 
each other…a function of machine design that has no standards. 

The chart shows results in the boxes below. 

 

 

6.38 Shift and Skew Adjustments 
The difficulty of setting up collimators perfectly square combined with the fact that imagers 
may not set up perfectly either, complicates the calculation of MLC leaf positions.  A 0.25 
degree collimator or imager rotation can result in a leaf position shift of nearly 1mm at 20cm 
from center.  Imagers may also not go exactly to the lateral and longitudinal position that is 
requested and also may be skewed. 

PIPSpro calculates both shift and skew for the Leaf Position and Multi-Port tests. Between 2 
(Leaf Position) and 10 (Multi-Port) lines are fit to leaf ends. The average center position of the 
lines is the shift and the average slope of the lines is the skew.  PIPSpro automatically removes 
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shift and skew from results.  If you would like to see the results without either quantity being 
removed, you may “Undo” the corrections.   If either shift or skew is especially large, it would be 
good to investigate its origins. 

 

 

A positive shift value indicates that the MLC is shifted towards the (patient HFS) left or towards 
the gantry.  A negative shift value indicates that the MLC is shifted towards the (patient HFS) 
right or away from the gantry.  Collimator skew is positive if the skew is clockwise and negative 
if the skew is counter-clockwise.   From the viewpoint of the imager, it is the opposite of above. 

 

6.39 Image Markup and Review 
Select the Image tab to view the analyzed image with its markups.  Markups should appear as 
below.  

Leaf Position 

PIPSpro places search profiles over each MLC leaf and determines the field edge of the right 
and left bank of the MLC. The left bank is denoted with red dots while the right bank is 
denoted with blue dots. 
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Multi-Port Test 

PIPSpro places search profiles over each MLC leaf and determines the field edge at each of the 
right and left bank MLC leaf position for each strip. The left banks are denoted with red dots 
while the right banks are denoted with blue dots. 

 

 

Leaf Transmission Test 

PIPSpro places profiles at 5 cm from isocenter in either direction to measure a background 
value for the image (behind the jaws). Two profiles will then be placed 2 cm from isocenter to 
measure the amount of inter-leaf leakage. A single profile will be placed at isocenter to 
measure the inter-bank leakage (ignoring the open areas). 

 

 

Sometimes the search algorithm has difficulties finding the edge of the openings around the 
fiducials, and will fail to correctly identify the area to be ignored.   If this happens, Select [Reset] 
and then adjust the Leaf Transmission Edge Threshold in the Advanced Expander on the left 
hand panel.  You may need to increase or decrease the value.  
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6.40 Advanced Expander 
 

 

 

The Leaf Transmission Edge Threshold is used to determine the area of the open irradiated 
regions around the fiducials for the Leaf Transmission test.  It does not apply to the Leaf 
Position or Multi-Port tests.   

The open areas are identified as the regions of greatest irradiation and are ignored in the 
analysis of inter-bank leaf transmission. The greatest irradiation is essentially the 100% value for 
the results, while the 0% value is taken from the readings behind the jaws.  Use this parameter 
to adjust the borders of the open irradiated regions. 

 

6.41 Rounded Leaf End Edge Threshold 
The Rounded Leaf End Edge Threshold is used to account for the fact that there is a finite 
amount of leakage through rounded leaf ends.  This is more of an issue for Varian machines 
than Elekta machines.  

 

Profile of an irradiated field 

Typically, we think of the 50% region of the penumbra, either radiation field or light field, as the 
definition of the beam edge.  The figure above shows how the radiation field edge at 50%, due 
to leaf end leakage, is further out than the light field edge, which represents the “true” leaf end 
position. 

For Varian machines, leaving the edge threshold at 50% results in irradiated profile 
measurements that are always too wide (e.g., 21 vs. 20 mm).  A suitable value for PIPSpro is 
30%.  Note that in the figure above that it seems that 70% would be more 
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appropriate.  However, irradiated regions in EPID images are darker than unirradiated areas, 
which has the effect of inverting the value (i.e., 50 + 20 becomes 50 – 20).   For Elekta machines, 
a value of 50% works well.  

 

6.42 Logfile-Based MLC QA Module  
The Logfile-Based MLC QA module analyzes Varian DynaLog files and Trajectory files from 
MillenniumTM  MLCs and 120HDTM  MLCs and Elekta “TRF” logfiles from AgilityTM 160-leaf MLCs. 

Leaf speed, leaf position accuracy, and leaf position repeatability tests may be done. 

Demo logfiles are available in: C:\Program Files\Standard Imaging\PIPSpro\Demo LogFiles  

Leaf Patterns are available in: C:\Program Files\Standard Imaging\PIPSpro\ 
VarianMLCTestPatterns and ElektaMLCTestPatterns 

There are only test patterns for Leaf Speed and Repeatability tests.  You should use clinical 
data for other types of tests, because that is representative of your clinical practice. 

Test Types 

There are three categories of logfile test types:  Leaf Speed, Accuracy and Repeatability.   

Leaf Speed Tests 

The PIPSpro leaf speed testing requires leaf patterns in which all leaves move in the same 
direction.  Results are reported in terms of “loss of leaf speed.” 

Leaf speed test files are provided in the installation to test loss of leaf speed. 

Accuracy Tests 

PIPSpro categorizes step and shoot, sliding window, and modulated arc treatments as 
“accuracy” tests.  Results are reported in terms of differences between “expected” and “actual” 
leaf positions, leaf error RMS, and the maximum error in millimeters of 95% of error counts. 

There are no test files provided for accuracy tests.  The user should pick representative clinical 
treatments for testing. 

Repeatability Tests 

Repeatability testing requires step and shoot leaf patterns that alternate.  Results are reported 
in terms of differences between “actual” leaf positions seen in the first two patterns that repeat 
and “actual” leaf positions seen in the repeating patterns. 

Leaf speed test files are provided in the installation to test repeatability.  

A Note on Elekta Machines 

Elekta linacs are different from Varian linacs.  Among other items, they use magnetrons 
instead of klystrons, have heavier MLC leaves , and have a different leaf positioning 
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method.  With this in mind, some Elekta logfile tests have been modified in PIPSpro to 
accommodate these differences.  These accommodations appear in leaf speed tests and 
sliding window and modulated arc leaf accuracy tests only.  Step and shoot leaf accuracy tests 
and repeatability tests are the same. 

The contents of the Elekta TRF logfiles are very similar to those of the Varian logfiles.  One 
notable difference is that for each record, there is a dynamic allowable MLC leaf error 
limit.  Dynamic error limits will be displayed in leaf accuracy tests.  There is also no concept of 
beam holds. 

 

6.43 Leaf Speed Tests  

Varian Leaf Speed Tests 

According to TG-142, loss of leaf speed greater than 5mm/s is considered a failure of the leaf 
speed test.  This module calculates instantaneous leaf speed and compares the results for 
every leaf at every time point to the TG-142 criterion.  A single leaf failure is considered a failure 
of this test, because TG-142 gives no further guidance.  The module also calculates average leaf 
speed.  If the user identifies that the calculated average leaf speed is more than 5% different 
from the intended (or nominal) leaf speed, this is also considered a failure.  Differences larger 
than 5% will typically be due to beam holds. 

Note that it is common for beam holds to occur in Trajectory files at the start of a leaf speed 
test.  These beam holds do not indicate a problem delivering the MLC pattern.  Beam holds 
that occur during DynaLog file delivery do typically indicate a delivery problem.  You will be 
prompted to adjust the nominal leaf speed when beam holds occur (except at the start of a 
Trajectory file). 

Failures will occur if you specify a leaf speed that is faster than your system can deliver 
(resulting in beam holds) or if leaves “stick”, even momentarily.  To use this software effectively, 
you should determine nominal leaf speeds that your system can deliver.  If leaves stick, you 
may want to call your service engineer.   

To understand the impact of a momentarily sticky leaf, consider that logfile records contain 
sampled MLC positional data every 50 milliseconds.  Leaf speed is calculated by determining 
the change in leaf position over this interval and dividing by 0.05 milliseconds.  Therefore, a 5 
mm/s leaf speed can be caused by a positioning error as small as 0.25 mm.  This is a factor of 
four less than the TG-142 leaf position accuracy criterion.  

For best results:  Make Quick Selects with leaf speeds that your machine can deliver routinely 
without beam holds.  This may take some experimentation.  For DynaLog-producing 
machines, 12.5 mm/s seems to be a good choice.  For Trajectory logfile-producing machines, 
25.0 mm/s should work as TrueBeam MLC’s seem to be able to move faster and with fewer 
errors than earlier model MLC’s.  
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Elekta Leaf Speed Tests 

According to TG-142, loss of leaf speed greater than 5 mm/sec is considered a failure of the leaf 
speed test. 

For Elekta machines, this module calculates average leaf speed for each leaf and compares it 
to a baseline average composed of all individual leaf speeds. 

Unlike Varian machines, failures may not occur if you specify a leaf speed that is faster than 
your system can deliver, because individual leaf speeds are compared to the baseline. 

For best results:  Make Quick Selects with the leaf speeds that your machine can deliver 
routinely.  This may take some experimentation, but leaf speeds less than 30.0 mm/sec should 
work. 

 

6.44 Leaf Speed Test Files 

Varian Leaf Speed Test Files 

The Logfile-Based MLC QA module is designed to work with special Leaf Speed test 
files.  There are two different types of test files:  

• For “Simple” tests, a leaf gap spanning the entire field in the ”Y” direction moves as a 
“front” for 13.5 cm, either right-to-left or left-to-right. 

• For “Complex” tests, every other leaf moves across the field for a time and then the 
leaves that were previously stationary move, and so forth. This occurs in four 
phases.  Again, total leaf travel is 13.5 cm and leaves can move either right-to-left or left-
to-right. 

Different speeds are achieved by specifying different numbers of monitor units per beam. 

Desired Speed (cm/s) MU/Minute MU’s 

2.50 400 36 

1.25 400 72 

1.0 400 90 

0.5 400 180 
 

Speed table for simple tests. 

Desired Speed (cm/s) MU/Minute MU’s 

2.50 400 72 

1.25 400 144 

1.0 400 180 

0.5 400 360 
 

Speed table for complex tests. 
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Notice that for complex tests, that twice as many monitor units are required to create 
DynaLog files that move with the same speeds as the simple tests.  That is because the 
duration of leaf motion in complex tests is twice that of simple tests. 

 

Elekta Leaf Speed Test Files 

The Logfile-Based MLC QA module is designed to work with special Leaf Speed test files. 
Elekta machines are tested with  “Simple” tests, where a leaf gap spanning the entire field in 
the ”X” direction moves as a “front” for 14.0 cm, either out-to-in or in-to-out1.    

 

Simple Agility 160-Leaf 

Desired Speed (cm/s) MU/Minute MU’s 

3.0 500 39 

2.0 500 58 

1.0 500 117 

0.5 500 233 
 

Speed table for simple tests 

Different speeds are achieved by specifying different numbers of monitor units per beam.  You 
will likely not get the exact nominal speed as shown in the table. 

1Note that Elekta machines could do the complex test that Varian machines can use, but that 
development time did not allow us to accommodate it. 

 

6.45 Logfile Testing 

Trajectory File Testing 

MLC (or *.dva) files are somewhat difficult to turn into plans with the new TrueBeam software. 
Special licensed software is also required. For this reason, we have provided “RT Plans” that you 
can use. There are Leaf Speed plans and Repeatability plans.  By changing the monitor units 
delivered, as described later, you can change the leaf speeds. 

These RT Plan files can be found in the following directory*:  
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C:\Program Files\Standard Imaging\PIPSpro\VarianMLCTestPatterns\RTPlans 

There are also sample Trajectory files that you can use to exercise the Logfile-Based MLC QA 
module; they can be found in the following directory*:  

C:\Program Files\Standard Imaging\PIPSpro\Demo Logfiles\ VarianTrajectoryLogfiles 

 

DynaLog File Testing 

Four different types of Leaf Speed MLC files are provided in the installation: “LRXXXSimple.dva”, 
“LRXXXComplex.dva”, “RLXXXSimple.dva”, and “RLXXXComplex.dva”, where the “XXX” suffix is 
80M, 120M, or 120HD for one of each of the three types of multi-leaf collimators currently 
supported by PIPSpro logfile analysis.   

These MLC files can be found in the following directory*: 

C:\Program Files\Standard Imaging\PIPSpro\VarianMLCTestPatterns\VersionH 

There are also sample DynaLog files that you can use to exercise the Logfile-Based MLC QA 
module, they can be found in the following directory*:  

C:\Program Files\Standard Imaging\PIPSpro\Demo Logfiles\VarianDynaLog 

In order to create Leaf Speed DynaLog files, you must create plans that employ them. 

Elekta TRF Logfile Testing 

Elekta machines use “*.efs” files to specify leaf patterns and other aspects of beam 
delivery.  They are very similar in concept and content to Varian “*.mlc” files. 

We have provided “*.efs” files for Leaf Speed plans and Repeatability tests.  By changing the 
monitor units delivered, as described later, you can change the leaf speeds.  Note that PIPSpro 
only supports 160-leaf machines for logfile analysis as 80-leaf machines do not produce “TRF” 
files. 

These MLC files can be found in the following directory*:  

C:\Program Files\Standard Imaging\PIPSpro\ElektaMLCTestPatterns\ 160-Leaf 

 There are also sample TRF files that you can use to exercise the Logfile-Based MLC QA 
module, they can be found in the following directory*:  

C:\Program Files\Standard Imaging\PIPSpro\Demo Logfiles\ ElektaLogfiles 

The iCom interface can be used to run *.efs and create logfiles. 
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6.46 Choosing Leaf Speed Test Conditions 
You may create leaf speed logfiles with different speeds and directions as well as different 
gantry and collimator angles. The leaf speed module will track and trend your results using 
individual Quick Selects that are identified with combinations of these test conditions. 

  

6.47 Acquiring Logfiles 
Please refer to Appendix C: Acquiring Varian Logfiles. 

 

6.48 System Manager Setup – Magnification Factor (DynaLog) 
Leaf positions, and therefore leaf speeds, in a DynaLog file are specified in millimeters in the 
MLC plane.  Since we are interested in positions and speeds in the isocenter plane, a 
magnification factor must be applied in DynaLog file calculations.  This magnification factor is 
typically 1.9606. 

Varian trajectory file and Elekta TRF file leaf positions are projected to the isocenter, so there is 
no need for magnification (i.e., factor = 1). 

If your calculated leaf speed is in error by about a factor of two, make sure that the 
magnification factor is set for your machine.  The factor must be set in the System Manager for 
pre-existing machines; that is, those that existed before the PIPSpro 5.2 release. 

Launch 

From the main menu of PIPSpro, select Application>Logfile-Based MLC QA.  This will display 
the Logfile-Based MLC QA module. 
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6.49 Logfile Analysis 

Load Files 

Select [Load Files] under Actions or Logfile-Based MLC QA>Load Image from the main menu. 

 

In the resulting dialog, browse and select the desired DynaLog file  Trajectory Logfile.  Then 
select [Open]. 

 

 

Using the Logfile Browser 

You may browse to a directory that contains logfiles using the navigation tree in the left hand 
side of the logfile browser. 

When you access a directory, the logfile browser will determine if well-formed logfiles are 
located there. 

If logfiles are located in the selected directory, then the file information table on the right hand 
side will be populated with information discovered for each logfile (pair) and [Open] will be 
enabled. 

As you navigate a directory tree the logfile browser will update the ‘Directory’ path in the top 
of the browser. 

The last directory from which you loaded a logfile will always be shown when you reopen the 
logfile browser. 
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If the desired logfiles do not reside on a windows drive “mounted” on your computer but is 
accessible via a “Windows Network Share,” then you may type or paste the full or partial path 
into the ‘Directory’ field using Microsoft UNC format for that shared resource. 

See Appendix I: UNC Paths for more information on determining the appropriate text for a 
particular Microsoft UNC path. 

NOTE:  The UNC path you type in the ‘Directory’ field will not appear in the navigation tree; this 
is a known defect. 

 

The selected logfile will be loaded into Logfile-Based MLC QA module’s Image Analysis view.  

 

 

  



PIPSPRO™ SOFTWARE  129 

The logfile will be displayed along with the following components: 

 

Legend 
PIPSpro colors the leaves in the MLC movie viewer according to 
status.  This status is updated on a record-by-record, leaf-by-leaf basis 
every 50 milliseconds.  Pass, alert, and error status are determined by the 
thresholds set in the system manager.  Non-moving leaves are those 
that do not move during the entire “treatment.”  Leaf status is only 
determined when the beam is on, as shown by the trefoil symbol.  When 
the beam is off, all leaves pass or are shown to be non-moving. 
Alert and Error status is not shown for Elekta leaf speed. 
 

 

Radiation Trefoil 
The trefoil symbol is displayed to indicate when radiation was delivered 
during the “treatment.” 
 

 

Gantry and Collimator Dials 
The beam angles shown in the dials correspond to the angles in the 
current logfile record being displayed.  The hands of the dials will not 
move, unless a modulated arc treatment is being shown. In that case, 
the gantry angles will change. 
The display of the dial angles will be either in IEC or Varian coordinates 
according to the selection made for the machine in the System 
Manager. 
 

 

NOTE:  Varian 601-2-1 are not supported in logfiles. 

 

Logfile Viewer 

In the image display area, an image depicting the MLCs will be displayed.   

Select [Play] to view the images as a ‘movie’.  To move one image at a time, use [Prev] and 
[Next].  You may also use the scroll bar below the diagram to navigate between images.  
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Logfile Information 

When you select a logfile test in the Logfile Browser, PIPSpro knows the type of file that you 
have selected and displays the appropriate thresholds and information from the logfiles for 
that test.  Notice that average speed as well as speed thresholds are shown for leaf speed 
tests.  Other tests will not display average speed and will show thresholds specific for the 
selected tests. 

Thresholds can be set in the System Manager. 

 

 

Manual Select 

The Manual Select fields display (potential) nominal values that are copied from the Logfile 
Information from the loaded Dynalog files. 

If the displayed values match an available Quick Select, that Quick Select is invoked. 
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1. IMPORTANT:  If there is no matching Quick Select, you can edit copied values which 
may not be ideal.  For instance, a collimator angle could come in at 179 degrees for a 
test where 180 degrees was the desired nominal value.  Similarly, a leaf speed could 
come in at 12.6 mm/s when 12.5 was the desired nominal value. It is important to edit 
copied values to their desired nominal values, so that any generated Quick Selects will 
be specified as you intend.  Leaf directions cannot be edited. Once a quick select is 
generated the nominal speed can no longer be edited as this would affect prior test 
results.  Additionally you should confirm the Test Type in the configuration section and 
change to desired test if necessary. 

 

  

 

Quick Select 

Test results are saved according to their machine name, test type, gantry start and stop angle, 
collimator angle, leaf speed, and direction of leaf motion.  The combination of these variables is 
called a Quick Select. 

 

NOTE:  Be careful to make sure that nominal values are the ones you want for your Quick 
Select.  For instance, the logfile may contain a gantry angle of 179 degrees due to machine 
setup issues and you really want 180 degrees as your nominal angle. 

If this is a new Quick Select configuration,  edit the nominal values according to what the 
Quick Select will be.  A name must be assigned to the new Quick select when saving the 
results. 

 

Calculate 

When ready, select [Calculate] to perform the calculations.   
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Leaf Speed Test Results 

 

 

Once calculated, the Leaf Speed results will be displayed on the Results tab page.  The results 
will include: 

Varian Status 

Varian leaf speed test status is based on both instantaneous leaf speed calculations and 
average leaf speed calculations.  

 

The instantaneous leaf speed calculations “Pass” if no leaf loses more than the alert level for 
leaf speed, “Alert” if any leaf loses more than the alert level for leaf speed and no leaf loses 
more than the error level for leaf speed, “Fail” if any leaf loses more than the error level for leaf 
speed.   Alert and error thresholds are set in the System Manager.   

The average leaf speed calculation fails if it is not within 5% of the nominal leaf speed for a 
Quick Select.  IMPORTANT:  You must determine if the calculated average leaf speed is 
incorrect.  You specify this by typing the correct nominal leaf speed in the Manual Select 
section of the module.  If you do not specify this, the application will assume that you are 
creating a new Quick Select. 
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Elekta Status 

Elekta leaf speed test status is based on average leaf speed calculations.  When a leaf speed 
calculation is first saved and a Quick Select is created, the average/nominal leaf speed of all 
leaves is saved with the Quick Select (the single number shown in “Nominal Speed”).  On 
subsequent tests, individual leaf speeds are tested against the (baseline) nominal leaf speed. 

The leaf speed calculations “Pass” if no individual average leaf speed loses more than the alert 
level for leaf speed, “Alert” if any individual average leaf speed loses more than the alert level 
for leaf speed and no leaf loses more than the error level for leaf speed, “Fail” if any individual 
leaf speed loses more than the error level for leaf speed. Alert and error thresholds are set in 
the System Manager.  

 

Leaf Speed Differences Table 

Displays the top 10 leaf speed losses for each bank. 

 

Leaf Speed Maximum Differences Chart 

Displays the maximum difference per leaf for each bank.  Typically, the display will show losses 
of leaf speed; although, if a gain of leaf speed were detected (and no losses were detected), the 
gain would be displayed.   
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You may mouse over each leaf to display its number and loss of speed in mm/s. 

 

All results are color coded according to the Alert and Error Thresholds set in the System 
Manager.  The color code is as follows: 

Green - Results are within the acceptable range. 

Yellow - Results are within the ‘alert’ range. 

Red - Results are within the ‘error’ range. 

 

Accuracy Test Results 
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Once calculated, the Accuracy Varian test results will be displayed on the results tab page.  The 
results will include: 

Status 

Accuracy test status is based on the worst case results for leaf position accuracy, leaf error 
RMS, and 95% of error counts.  If all results are less than the alert thresholds set in the System 
Manager, the status is “Pass.”  If any results are greater than the alert thresholds and all are less 
than the error thresholds, the status is “Alert.”  If any result is greater than the error threshold, 
the status is “Fail.”  For more information on how these results are calculated, refer to 
Appendix G: Varian Logfile Analysis. 

 

 

Varian Maximum Accuracy Differences 

Displays the top 10 leaf position errors for each bank. 
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Elekta Maximum Accuracy Differences 

Displays the top 10 leaf position errors for each bank. 

 

Elekta TRF logfiles have a dynamic allowable MLC leaf error limit for each record.   This 
dynamic error limit can be as low as 1 mm or as large as       8 mm, or so.   We use the dynamic 
error limit to calculate the accuracy status for each MLC leaf in each logfile record.  The “Diff.” 
columns show the signed worst case differences between expected and actual positions.  The 
“Thresh.” columns show the dynamic error limits associated with the worst case differences. 

The leaf accuracy calculations: 

• “Pass” if the position difference, abs(actual - expected), is less than or equal to the 
dynamic error limit; 

• “Alert” if the position difference, abs(actual - expected), is greater than the dynamic 
threshold plus the accuracy alert threshold AND is less than the dynamic threshold 
plus the accuracy error threshold. 

• “Fail” if the position difference, abs(actual - expected), is greater than the dynamic 
threshold plus the accuracy error threshold. 

• As with other thresholds, these alert and error thresholds are set in the System 
Manager. 
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Leaf Statistics (Elekta & Varian) 

Displays the individual and combined leaf bank statistics for leaf error RMS and 95% of error 
counts. 

 

 

Leaf Errors (Elekta & Varian) 

Displays a tabular view of a leaf error histogram highlighting both individual and combined 
leaf bank statistics in raw counts and percentages.  On the far right of the table in the 
“Cumulative” column, the row in which 95% of error counts accrue is colored according to the 
alert and error thresholds set in the System Manager.  The combined 95% of error counts 
shown in the “Leaf Statistics” is the exact error in millimeters corresponding to the histogram-
binned colored cell. 
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Repeatability Test Results (Elekta & Varian) 

 

Once calculated, the Repeatability test results will be displayed on the results tab page.  The 
results will include: 

Status 

Repeatability test status is calculated by testing the ability of the leaves to return to positions 
in a known, cycling, step and shoot pattern.  As with other logfile-based MLC tests, alert and 
error thresholds are set in the System Manager.  For more information on how repeatability 
results are calculated, refer to Appendix G: Varian Logfile Analysis. 

 

 

Maximum Position Differences Table 

Displays the top 10 leaf position repeatability errors for each bank.   
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Maximum Position Differences Chart 

Displays the maximum leaf position repeatability error per leaf for each bank.  You may mouse 
over each leaf to display its number and repeatability error in millimeters. 

 

 

Reset (Elekta & Varian) 

To redo the calculations, select [Reset] in the left panel under Actions.  The application will 
provide an opportunity to save the current results before discarding them.  Select [No] to 
return to the Image tab and make adjustments as needed. 

 

6.50 Daily CT Simulator QA with Standard Imaging CT Sim/Check Phantom 
The CT/Sim Check Module in PIPSpro for use with Standard Imaging’s CT/Sim Check Phantom 
allows the user to perform daily QA and monitor imaging performance of their facility’s CT 
Simulator, including the following tests: 

• Image Orientation Confirmation  
• Uniformity 
• HU Constancy 
• Slice Position 
• Slice Thickness 
• Geometric Distortion  
• Phantom Alignment  
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Data Acquisition 

Use one of your clinic's standard protocols to acquire a full set of the phantom.   For 
consistency and to provide consistent HU analysis, the same protocol should be used on a 
daily basis. For reproducibility it is recommended a couch locking index bar be used to mount 
the CT/SIM Phantom to the CT Couch. Please refer to the CT/Sim Check Phantom manual for 
more information on phantom set-up and imaging.  

 

 

 Launch 

Open the Imager QA module by choosing Application>CT Sim QA from the menu.  This will 
open the workspace for the CT/Sim Check analysis. 

 

Select <Load> from the actions menu 

 

Load Images and Analysis 

This will open the directory tree to select your imager series of the CT/Sim Check Phantom. 
Upon first opening, the user may have to navigate to the specific folder that holds the image 
sets.  The software will retain this place and open to it automatically for future analyses for 
subsequent analysis. To analyze a CT series, select [Load] to browse the folder containing the 
image files you would like to analyze.  Select the folder name and the image series (there may 
be only one), then select [Open] to load the files.  If the browser does not see images that are in 
a folder, changing the file extension to “*.*” may help as DICOM files are not required to have a 
file extension.  
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Once the selected file set is “opened” analysis will automatically begin.  The software will find 
the “Key Slice” (this is a slice with the HU inserts and registration crosshairs) within the 
phantom image set, calculate positions, and analyze accordingly. 

 

Key SLice 

Results 

The initial results view will display the CT Results Overview (Summary).  Select a category from 
the Summary table to view the detailed results page for that particular test by clicking on the 
test name.  Alternatively, use the dropdown menu in the upper right to move between the 
summary and results pages.  If a baseline is established (See Baseline editor section below) the 
results will be color coded for Pass (green), Alert (yellow) or Fail (red). 

           

Tests include: 

Uniformity: Describes the distribution of pixel values observed in the homogeneous 
uniformity disk region of the phantom. 
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Uniformity  

 

HU Constancy: Measures the average pixel values for regions in the phantom with 
varied electron densities to determine differences between measured values and 
established baseline values.   

NOTE: The predicted values are approximations of density values for the materials 
listed (Lung, Liver, Water, Bone) for reference.  The density inserts are marked with one 
to four dots and these need to be inserted in the phantom in the specific order one 
through four with one being closest to the “R” marking on the phantom. 

HU Constancy Density 

Plugs (approximate 

densities) 

1) Lung: .320g/cc, -650HU  

2) Liver:.497g/cc, -500HU  

3) Water: - Virtual Water 1.04 

g/cm3 physical density/ 

1.01 relative electron 

density to water  

4) Bone: 1.6g/cc, 640HU  

  

 
HU Constanc 
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Geometric Distortion: Provides an assessment of image symmetry and calibration of 
the image display system. 

 
Geometric Distortion 

 
 

 

Slice Thickness/Slice Spacing: Provides an assessment of the scan’s slice thickness 
accuracy and expected slice spacing. 

 
Slice Thickness/Slice Spacing 
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Phantom Alignment: Verifies correct phantom position in vertical, longitudinal, 
latitudinal, pitch, roll, and yaw.  This test results from analysis using the phantoms 
towers as well as the key slice. 

 

Phantom Alignment 

 

 

 

 

 

 

 

Image Alignment: Verify the image orientation from the DICOM file.  

 
Image Alignment 
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Baseline Editor 

Baselines are created by averaging several measurements together and making adjustments 
to the tolerance settings as needed.  Baselines can also be created by entering an expected 
value based on past experience or published results. 

Once a baseline is set the results will be color coded according to the tolerance thresholds set 
for the baseline. Green (Pass), Yellow (pass but with and alert level), Red (Fail). 

Launch Baseline Editor 

Begin by selecting Imager QA>Baseline Editor from the main menu.  This will display the 
Baseline Editor dialog. 

 

Select the desired configuration from the Quick Select menu.  This operates in a similar way as 
the Quick Select menus elsewhere such as in Imager QA. 

If the selected configuration already has a baseline, a green dot will appear to the left of the 
baseline’s name. If not, the application will provide the opportunity to create a new baseline. 

Creating a Baseline 

To create a baseline, select a Quick Select from the dropdown and select [Create new 
baseline].  The application will then display a table containing all records associated with the 
selected configuration.  Select which record(s) should be used to create the baseline.  If 
multiple records are selected, they will be averaged together.  When finished, select [OK].   

The application will display the Baseline Parameters view.  Fill in tolerance levels for the alert 
and error ranges.  These tolerances can be manually filled in as values and/or percentages.   
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If you would like to set the same percentage difference for all tolerances, select the checkbox 
next to the ‘link’ symbol.  Enter the value in the first field and the system will copy that value to 
all subsequent fields.    After the desired values have been copied to all subsequent fields, the 
checkbox can be deselected to allow editing of copied values. 

 

Editing a Baseline 

To edit an existing baseline, choose a Quick Select from the dropdown and select [Edit].  This 
will allow changes to be made to the baseline parameters.  The records averaged to create the 
baseline, however, cannot be changed. 

 

Recreating a Baseline 

To recreate an existing baseline, select [Recreate].  This will allow for changing the averaged 
records used to create the baseline.  For further details, see Creating a Baseline, above. 

 

Using Tolerances from a Different Baseline 

It is possible to create a new baseline using the tolerances from an existing baseline.  This 
option is only given if baseline of the same/comparable type exists.  To use this option select 
the ‘Copy alert and error thresholds from existing baseline’ checkbox.  This will display a menu 
to choose which existing baseline to use.  Once a selection has been made, continue creating 
the baseline as normal.   
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Setting the Effective Date 

The effective date of a baseline is the date at which its thresholds take effect. There can be 
more than one baseline; one baseline stops where another takes effect.  The effective baseline 
can be set to any date between the acquisition of the first image (series) and the current date. 

 

Saving a Baseline 

After the baseline parameters have been created and/or edited, select [Save].  The baseline will 
be used for trending in the History View. 

 

Close Baseline Editor 

To close the baseline editor, select [Close].  To close without saving, select [Cancel]. 
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7 Section 3 : The QC-3 Phantom 
 

7.1 Analysis of Data from the QC-3 Phantom 

 

 

Analysis of Data from the QC-3 Phantom 

When setting up the QC-3 on a portal imager, use the positioning shown in the diagram 
below. 
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When setting up the QC-3 on the included acrylic stand, place it on the couch using the 
positioning shown in the diagram below. 

 

 

The QC-3 phantom 

• The QC-3 phantom is used to test the image quality from electronic portal imaging 
devices (EPIDs).  Megavoltage portal images are acquired with the phantom placed on 
the surface of an EPID, or at isocenter with the EPID at some known distance from 
isocenter (usually 40 or 60 cm). The images are then imported into PIPSpro and 
analyzed in the Imager QA module. The diagram at left shows the numbered regions 
of the QC-3 phantom. The angled numbers in the corners are used for subjective 
quality control, as they are visible on the image with increasing density (Number 1 is 
machined into a lead block to a depth of 1 mm, number 2 to a depth of 2 mm, 
etc.).  The small numbers in the diagram indicate the region numbers. Regions 1-5 are 
bars with different spatial separations, and are used for the analysis of the spatial 
resolution f50.  Regions 6-11 contain blocks of lead or plastic (PVC) with increasing 
thicknesses.  

 QC-3  

Region Bar resolution lp/mm Bar thickness mm 

1 0.76  * 15 mm lead 

2 0.45  * 15 mm lead 

3 0.25  * 15 mm lead 

4 0.20  * 15 mm lead 

5 0.10  * 15 mm lead 

6  15 mm PVC 

7  15 mm Aluminum 

8  5 mm lead 

9  7.5 mm lead 

10  7.5 mm lead 

11  15 mm lead 
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* These are nominal values. Actual values may be different for a specific phantom.  A 
calibration card is provided with every phantom. 

Acquiring QC images 

• The phantom is set up on the EPID or at isocenter on a bridge support, oriented at 45° 
to the sagittal plane, as shown in the diagram. The large number 1 points towards the 
gantry. Lines and marks on the surface of the phantom assist in lining it up to the 
central beam line.  For routine daily or weekly quality control, it is advisable to mark the 
surface of the EPID with tape so that placement of the phantom can be done quickly. 
A stand is available for lateral imaging (shown in the illustration to the left). For both 
single image and dual image analysis two images of the phantom are acquired.   

• For single image analysis the first image is an image of the QC-3 and the second image 
is a flood field image.  The flood field image, which should expose as much of the 
imager as possible, allows uniformity to be calculated for the imager. 

• For dual image analysis the both images are image of the QC-3.  For dual image 
analysis it is very important that the images be taken in fairly quick succession avoiding 
any movement of the phantom with respect to the imager, because slight 
misalignments of the images will lead to poor results.  

• The images are imported to PIPSpro so that they should appear on the screen in the 
orientation shown in the diagram (1 at the top, 4 on the left). 

• Saturation.  Be sure that the image is not under- or over-saturated within the 
boundaries of the phantom. If the image is saturated, use different acquisition 
parameters. 

• Image pair similarity.  The two images to be used in the analysis must be very similar, 
so that the calculation of random noise will be correct.  

 

7.2 Summary of Published Data from the QC-3 Phantom 
Prepared by Shlomo Shalev 

The QC-3 phantom is used for evaluating image quality from electronic portal imaging 
systems (EPIDs) during acceptance testing, commissioning, and routine quality control. It 
determines quantitative, objective parameters for spatial and contrast resolution, as well as 
the relative contributions to image degradation from the EPID and from the focal spot 
penumbra [16]. Full details of the methodology are available [23], as well as a comparison 
between the QC-3 phantom and the simpler “Las Vegas” test object used by some of the 
international EPID vendors [24]. Spatial resolution is measured in terms of the parameters f50 
or f30 which are the frequencies at 50% or 30% maximum of the relative modulation transfer 
function (RMTF). The method was originally proposed by Droege [1] and further developed by 
Rajapakse and colleagues for quality control of electronic portal imaging systems [2,3]. Portal 
images are acquired either with the phantom placed directly on the surface of the EPID (f50 
epi) to evaluate the detector characteristics, or with the phantom at isocenter (f50 iso) to 
include the blurring effect of the finite focal spot size. Contrast resolution is measured in terms 
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of the contrast-to-noise ratio (CNR). The results may be used for optimizing EPID image 
quality [7, 9, 13]. Time trend analysis of f50 and CNR may be incorporated into routine QA 
programs [19], and can indicate the deleterious effect of radiation damage [17]. The phantom is 
also useful for quality control of CR detection systems and comparison of their image quality 
with EPIDs [14,15]. 
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7.3 Parametric Analysis of Image Unsharpness 
 

Parametric Analysis of Image Unsharpness 

This section describes a technique for making experimental measurements with the QC-3 
phantom in order to evaluate the various components contributing to image unsharpness. 
One important result is the determination of the relative contributions to image unsharpness 
from the EPID on one hand, and from the linac focal spot size on the other. While focal spot 
size is well understood and carefully monitored in diagnostic radiology, its impact on image 
quality is generally ignored in megavoltage portal imaging. This, however, is a mistake, as an 
abnormally large focal spot will significantly reduce image quality, especially if the detector is 
quite far from the isocenter. Furthermore, when there is a reduction in image quality and 
maintenance is required, it is very useful to know whether the problem lies in the EPID or in 
the linac, as usually quite different support personnel are involved.  

This note does not describe how to acquire images with the QC-3 phantom, or how to 
determine the spatial resolution parameters from the data, as these subjects are covered 
elsewhere. It is only concerned with describing the analytical model and the determination of 
the variable parameters. 

A simple 3 parameter model of the portal imaging system is used for the purpose of 
differentiating between the most significant contributing factors to image unsharpness 
(blurring). The model assumes that the image pixels are square (equal width and height), and 
approximations are applied when this is not the case. It further assumes that the three 
parameters used in the calculations are independent, and are constant under the various 
situations in which test images are acquired. While this model does not claim to be 
scientifically precise, it is useful for the limited purposes of routine quality assurance of the 
EPID. 

 
 

1.   The detector (E) 

This component incorporates all the physical effects occurring in the detector that may 
impact the image quality and introduce blurring effects. In a fluoroscopic EPID this includes 
the electron path length in the conversion plate and phosphor, the optical system, camera, 
and data/image processing. In a liquid ion chamber and a solid state detector (am-Si) the 
effects include the electron path length in the conversion plate and the liquid/solid detector 
material, and the data read-out and processing techniques. The parameter E is generally 
unknown, and can be determined by experimental measurement with the QC-3 test 
phantom. Changes in the value of E may indicate problems with the optical system, electronic 
components, signal acquisition, or other contributing factors to the final image.  
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2.   The pixel matrix (P) 

All EPIDs accumulate image data in the form of a matrix of pixels. As the EPIDs have 
developed over the years, the matrix sizes have also changed from one model to another. The 
table shows some typical examples: 

EPID Detector 
size   (cm) 

Pixel matrix Pixel size 
(mm) 

P 
(mm) 

Siemens 
Beamview 

41 x 33 512  x   480 0.80 x 0.65 0.80 

Siemens FP 
(am-Si) 41 x 41 1024  x 1024 0.40 x 0.40 0.40 

Philips SRI-100 38 x 30 512  x   256 0.74 x 1.17 1.17 

Philips SRI-200 38 x 30 512  x   512 0.74 x 0.74 0.74 

Elekta iView 43 x 33 768  x   576 0.56 x 0.57 0.57 

Elekta iViewGT 
(am-Si) 41 x 41 1024  x 1024 0.40 x 0.40 0.40 

Varian PortalVision 32.5 x 32.5 256  x   256 1.27 x 1.27 1.27 

Varian aS500 
(am-Si) 

40 x 30 512  x   384 0.78 x 0.78 0.78 

TheraView 40 x 40 512  x   512 0.78 x 0.78 0.78 

IRIS (am-Si) 41 x 41 1024  x 1024 0.40 x 0.40 0.40 

Eliav PORTpro 43 x 32 568  x   753 0.57 x 0.56 0.57 

Eliav PORTpro v3  904  x   634   

 
 

The parameter P is equal to the pixel size (width) in mm. To determine this value one needs to 
know the pixel matrix and also the physical size of the image detector. Where the pixel is not 
square, the longest dimension is used as this will be the limiting factor in determining image 
quality.  Note that the dimensions given in this table are approximate and are provided only as 
a rough guide. Dimensions may be different for various EPID models and upgrades. You 
should independently determine the correct the values for your EPID.  

 

3.   The source size S. 

Image blurring will occur due to the finite size of the linac focal spot.  The focal spot size is 
usually unknown, but a parameter S can be determined by experimental measurement with 
the QC-3 test phantom. While the value of S determined in this test is an indication of the 
influence of focal spot size on image quality, it is not true measure of the actual focal spot size, 
since the focal spot will generally be asymmetrical and non-uniform.  
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This model assumes that the three effects described above are independent, and that their 
effects on image unsharpness can be expressed as Gaussian functions (σ1, σ2 and σ3). Their 
MTFs (modulation transfer functions) will be multiplicative: 

 
EPID . Pixel  .  Source  = Total 

 
(MTF1)2  .  (MTF2)2  .  (MTF3)2     =   (MTFt)2  [1] 

 
exp(-πσ1

2) . exp(-πσ2
2) . exp(-πσ3

2)   =   exp(-πσt
2)  [2] 

 
and so 

 
σ1

2  +  σ2
2  +  σ3

2     =   σt
2   [3] 

 

where MTFt and σt
2 are the total effective MTF and variance describing the blurring function. 

 

4.   The experimental technique. 

 

For this test the phantom is located at isocenter and the EPID is progressively moved farther 
away. Images are acquired at intervals of 10 cm (for example) and f50 is determined using 
Optional Module OM-Q in PIPSpro.  

Re-writing equation [3] in terms of M, E, P, S and f50 gives the unsharpness (blurring function): 

[4] 

where M is defined as the ratio of the source-detector distance (SDD) to the source-phantom 
distance (SPD). 
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5.   Values of M and f50 for optimal spatial resolution 

From equation [4] we determine the value of M(opt) which is the magnification required to 
minimize the blurring function (i.e., to ensure optimal image quality), and the corresponding 
value of f50: 

 

When treating a patient at isocenter, the source-phantom distance SPD is replaced by the 
source-isocenter distance (SID) and the optimal value of SDD is equal to M(opt)xSID. However 
only some types of EPID have adjustable SDD. Note that this simple model for calculating 
M(opt) only takes into account the spatial resolution (blurring). Other factors must also be 
considered when selecting the best position of the EPID for clinical use, such as image noise 
and effective field of view, both of which depend on the value of M. 

 

6.   Examples 

The following two examples demonstrate how experimental measurements and analysis are 
performed. The experimental data for f50 are converted to unsharpness (1/2f50)2 and  fitted to 
equation [4], with the value of P set as a fixed parameter. Values for E and S are found from the 
analysis. 

 

Figure 1:  P=1.27 mm    E=1.72    S=2.05 
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Figure 2: P=1.27 mm   E=1.77   S=4.65 

 

 

The values of E for these two EPIDs are almost identical, but there is a very significant 
difference in the focal spot size parameter S and the optimal distance for locating the EPID. 
Figure 1 is typical of a Varian PortalVision Mark 2, and indicates that the source-to-detector 
distance (SDD) should be >140 cm for optimal spatial resolution. Figure 2 shows another 
example of a PortalVision where the focal spot size was exceptionally large (S > 4) and was the 
dominant contributor to image unsharpness at SDD > 140 cm. For optimal image quality it 
would be best to keep the EPID close to the patient in this case. 

Flat panel detectors using amorphous silicon technology are gradually replacing the older 
systems using video or ion chamber detectors. The flat panel EPIDs are characterised by much 
higher spatial resolution and CNR. With pixel dimensions as small as P=0.4 mm, the influence 
of the focal spot size becomes the dominant factor in determining spatial resolution and the 
value of M(opt) is usually very close to 1. This means that spatial resolution will deteriorate as 
the detector distance increases. In EPIDs where the detector distance is fixed this is of only 
academic interest, although the focal spot size should be monitored on a regular basis. In 
EPIDs where the detector position is adjustable, it may be worthwhile to minimize the patient-
detector distance where possible. 
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7.  Application to EPIDs with fixed SDD 

Some EPIDs are at a fixed distance from the isocenter, and so this test must be simplified to 
just two locations: the phantom can be located either on the surface of the EPID or at 
isocenter, while the EPID remains fixed. The diagram illustrates this situation for an EPID with 
SDD = 140 cm. 

 

 

Two measurements of f50 are made (with the phantom on the surface of the EPID and at 
isocenter), and their ratio is examined. In the absence of blurring due to the focal spot size, the 
ratio would be expected to be equal to Miso or 1.4 for this example. However, with a finite focal 
spot the ratio will be less, and may even be as low as 0.8 for flat panel detectors where spatial 
resolution is dominated by the focal spot size. 

Since P is known, two measurements are sufficient to solve equation [4] for the unknown 
parameters E and S. Define: 

Viso  =  (1/2f50)2   for the measurement with the phantom at isocenter 

Vepi  =  (1/2f50)2   for the measurement with the phantom on the surface of the EPID 

Miso =  magnification with the phantom at isocenter 

Mepi =  magnification with the phantom on the surface of the EPID 
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Then 

S2   =  (Miso
2. Viso - Mepi

2. Vepi) / [(Miso-1)2- (Mepi -1)2] [7] 

E2   =  Miso
2. Viso  -  S2(Miso-1)2  - P2   [8] 

Care should be taken in measuring SDD in order to determine Miso and Mepi. Measure from the 
center of the phantom to the sensitive surface of the detector, and not simply to the outer 
surface of the EPID cover. A Microsoft® Excel file CalcES.xls is available from Standard 
Imaging, Inc. to assist in solving equations [7] and [8]. 

In the course of developing and testing the QC-3 phantom, measurements were made on 
numerous EPIDs around the world. A few typical results are shown in the following table (all at 
6 MV). Values of Miso  and Mepi  used in these calculations are estimated, and may not be very 
accurate. These data are random samples from various centers and should not be used as 
standards for acceptance testing. 

The focal spot size S dominates in two situations. First, it dominates when the focal spot size is 
very large, such as in a Cobalt-60 irradiation unit. Image quality deteriorates rapidly with 
distance, and the optimal distance for the EPID in the above example is only 92 cm. Second, 
the focal spot size dominates when P is particularly small, such as in the flat panel detectors 
Siemens FP and Elekta iViewGT. For these detectors optimal spatial resolution will be obtained 
with small values of M(opt), which implies that the EPID should be located close to the patient. 

One does not expect the values of E to be identical for EPIDs from the same vendor, especially 
for fluoroscopic detectors, as the values will depend on prior calibration of the EPID, optical 
focus, lens f-stop, camera adjustments, and many other factors. Similarly the value of S will 
depend on the type of linac, thickness of the beam flattening filter, beam energy, beam 
focusing, etc. However, after these parameters have been optimized during 
acceptance/commissioning tests, they may be subsequently monitored as part of the routine 
quality assurance program. Any changes may indicate that appropriate maintenance is 
required. 
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8 Section 4 : Appendices 
 
 
 
 

8.1 Appendix A: Imager QA Algorithms 
 

General Planar Imaging Metrics 

 

Noise Single Image (NSI) 

The Noise Single Image (NSI) metric quantifies the random variation of pixels values in a single 
image flood field image.   It is calculated as the standard deviation of the pixel values in a 
sampled region of the image.  Any difference in pixel values is assumed to be due to random 
differences in the detector response across the image. 

 

σflood Standard deviation of the pixel values in the flood field image  

N   Number of pixels in the flood field image 

Xi     Value of the pixel at location “i” in the flood field image 

μ Mean of the pixel values in the flood field image 
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Uniformity1 

The Percent Integral Uniformity metric quantifies the largest variation in pixel values in a 
region centered within and encompassing 75% of the area of a flood field image.  This inner 
75% of the image is meant to represent the “useful” field of view of the image.  In order to 
reduce the influence of image noise on the analysis of image uniformity, samples are taken 
from and averaged within small sub-regions of interest (SROI) that include approximately 
0.15% of the total number of image pixels (e.g., approximately 100 pixels for a 256x256 matrix 
image).   

 

SROImax   Mean pixel value of the subregion with the largest intensity   

values. 

SROImin  Mean pixel value of the subregion with the smallest intensity  

values. 

 

A PIU value of 100% theoretically means that there is no variability within the useful field of 
view.   

 

Noise Dual Image (NDI) 

The Noise Dual Image (NDI) metric quantifies the random variation of pixel values in a pair of 
images.  It is similar to the NSI metric, but can be used when no flood field image is 
available.  To calculate NDI, a pair of images is taken under the same conditions is 
required.  One image is subtracted from the other and a modified standard deviation is 
obtained from a sampling of pixels.   

 
 
 

 Standard deviation of the pixel values in the difference image  

N Number of pixels in the difference image 

Xi Value of the pixel at location “i” in the difference image 

μ Mean of the pixel values in the difference image 
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The ½ factor under the radical is due to the fact that we are processing a difference image, but 
reporting the standard deviation for each individual image. 

 

Contrast-to-Noise Ratio (CNR) 

The Contrast-to-Noise Ratio (CNR) metric quantifies image quality. 

 

μlight Mean of the pixel values in the “lightest” region of an image 

μdark Mean of the pixel values in the “darkest” region of an image 

 σdark Standard deviation of the pixel values in the “darkest” region of an  

 image 

 

NEMA Standards Publication MS 3-2008. Determination of Image Uniformity in Diagnostic 
Magnetic Resonance Images.  National Electrical Manufacturers Association.  Rosslyn, VA. 

 

Catphan CTP404 Metrics 

Geometric Distortion 

The Geometric Distortion metric is evaluated using the four holes (one with a Teflon pin) 
portion of the phantom.  These holes are positioned equally distant apart (i.e., 50mm) on 
center. By measuring from hole-center to hole-center distance, the spatial linearity of the CT 
scanner can be verified.  If an elliptical image is produced, the x-y balance of the image display 
system should be adjusted. 

 

Slice Thickness 

Slice Thickness metric estimates CT slice width using two pairs of 23° wire ramps in the 
phantom: one pair oriented parallel to the x axis; the other to the y axis. These wire ramps can 
also measure phantom or scanner misalignment errors. 

For a full description of the method, please refer to your Catphan manual. 
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Low Contrast Visibility (LCV) 

The Low Contrast Visibility (LCV) metric quantifies the difference in visibility of two phantom 
regions composed of materials of similar, but not identical HU values.  The manufacturer 
recommends assessing low contrast visibility with the Polystyrene (POLY) and Low Density 
Polyethylene (LDPE) samples as shown in Figure 1. 

 

σPOLY Standard deviation of the HU values in the Polystyrene region of an image 

σLDPE Standard deviation of the HU values in the Low Density  

 Polyethylene region of an image 

μPOLY Mean of the HU values in the Polystyrene region of an image 

μLDPE Mean of the HU values in the Low Density Polyethylene region of an image 

 

Figure 1: CTP 404 Module Image from the Catphan 503 Manual  
(The Phantom Laboratory, 2012) 

 

The procedure is described in Lehman et al. 2007 and Stock et al. 2009.   
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HU Constancy (HUC) 

The HU Constancy (HUC) metric trends Hounsfield unit (HU) values in CT phantom images for 
known materials over time.  In PIPSpro, HU values may be from -1000 for air to 990 for Teflon.   

The metric reported is the measured mean HU compared to the known (expected) HU of the 
material evaluated. 

Catphan CTP486 Metrics 

 

CT Number Uniformity  

CT Number Uniformity is estimated as the mean (μ) and standard deviation (σ) of five regions 
in a homogeneous region of slice of a phantom, as shown in Figure 2. 

 

N Number of pixels in region j 

Xi Value of the pixel at location “i” in region j 

 

Figure 2: CT Uniformity Slice 
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Integral Non-Uniformity 

Integral Non-Uniformity is a trending metric that presents 1-D horizontal and vertical profile 
data for (the two) profiles that go through the image center of a homogeneous slice of a CT 
phantom, as shown in Figure 3.   Each position on a horizontal profile is the average of the five 
pixels in the vertical direction centered at the horizontal profile pixel position.  Likewise, vertical 
profile points are averages of points in the horizontal direction.  This averaging has the effect of 
lessening the effect of the noise in the image.   Due to scanner boundary effects, typical 
profiles start from 2 cm from the edge of the test module’s image.  A representative profile is 
shown in Figure 3. 

 

Figure 3: CTP 486 Image uniformity module 
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Catphan CTP515 Metrics 

 

Low Contrast Detectability (LCD) 

The Low Contrast Detectability (LCD) metric is used to evaluate a CT scanner’s low contrast 
performance.  LCD is mathematically identical to the contrast-to-noise ratio, CNR, but includes 
a detectability limit, which allows a result to be True or False (Detectable or Not 
Detectable).  This detectability limit typically has a range of values from 3.29*SD to 5.5*SD 
(where SD is the standard deviation of the background).  The asymmetrical (3.29 – 5.5) spread 
of the range is because the noise distribution within target and background regions of interest 
is not perfectly normal.  PIPSpro uses a detection level of 4*SD.  

To calculate LCD, targets of different contrast levels and diameters are imaged, as shown 
schematically in Figure 4.  Typically, a phantom will contain three (3) or more contrast levels 
expressed as a percentage offset from water (e.g., 1% = 10 HU).   

 

μTarget Mean of the pixel values in the target region of an image 

μBackground Mean of the pixel values in the background region of an image 

σBackground Standard deviation of the pixel values in the background region of an image 

 

Figure 4: CTP515 low contrast module with supra-slice and subslice contrast targets 
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Low Contrast Detection Scores 

LCD is reported as by two scores within a contrast group (0.3%, 0.5%, and 1.0%): 

• Percent Detected is the percent of visible targets with respect to total targets that are 
detected within a contrast group.  

• C x D is the product of the contrast of the smallest detectable target and the diameter 
of that target. 

 

Catphan CTP528 Metrics 

 

Spatial Resolution 

Spatial Resolution, as defined by the Modulation Transfer Function (MTF), is a measure of the 
perceived sharpness or quality of an image.    From an imaging systems perspective, MTF tells 
us the spatial frequency response of an imaging system or component.  Invariably, imaging 
systems blur or lose sharpness for all items, so imaging systems act like low pass 
filters.  Because line pair regions with many narrow line pairs have more high frequency 
content than line pair regions with few and thicker line pairs, the former are affected more 
than the latter.  Hence, the typical decaying form of the MTF curve.   See Figure 5 for an 
example of a phantom slice used for this metric. 

 

 σ2
Region  Variance within selected line pair region frequency region f. 

 σ2
Background  Background variance. 
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Figure 5: CTP528 High resolution module with 21 line pair per cm gauge and point source. 

 

Displays in PIPSpro show a normalized or relative version of the MTF curve. 

 

flowest Lowest frequency region (i.e., the one with the biggest lines) 
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8.2 Appendix B: Stereotactic Algorithms 

Stereo Algorithms 
 

 

Eight digital images of a small radio-opaque ball marker within a circular radiation beam are 
used for the analysis.  Under ideal conditions the ball marker will always be at beam center, 
however in practice its position will be offset for different gantry and couch angles. Stereo 
computes the head frame offsets from the optimal target location in 3 dimensions.   

The purpose of this section is to describe the algorithms involved in generating the 3-
dimensional shift from the optimal target position. 

Edge detection 

A schematic diagram of the radio-opaque ball marker and radiation field edge is shown on the 
right.  The first task of Stereo is to determine the center of the radiation field and ball marker. 
This is performed by detecting the edge contours of both structures. An eight directional 
chain code is initiated and starts its search from the edge of the image working its way inward 
until it finds a point on the radiation field edge.  In this application it is not crucial that the 
detected radiation field contour be the 50% isodose due to the circular symmetry of the 
structure.  After the first point is found, the chain code traverses the entire radiation field edge 
until it closes on itself. In a similar manner, the edge contour of the ball marker is searched for 
inside the bounds of the radiation field.  A chain code traverses pixels on the edge of the ball 
marker until it closes on itself.  The U and V positions of every pixel along both contours are 
recorded and used to calculate the centers (u,v) of each structure according to the following: 

 

where n is the total number of pixels making up the contour and  (Ui,Vi) are the coordinates of 
pixels along the contour.  

 

Ball Marker

Radiation Field Edge

u
 

v
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The (dU,dV) offset of the center of the marker with respect to the center of the radiation field is 
then given by: 

 

where (ur,vr) and (um,vm) are the coordinates of the center of the radiation field and ball marker 
respectively.  

 

 

Coordinate transformation 

Consider an un-rotated gantry coordinate system as shown on the right.  (K,L,M) and (U,V,W) 
are points in the un-rotated and rotated gantry coordinate systems respectively.  If the gantry 
is rotated through an angle θ ,  the two points are related by the expression: 

 

The (K,L,M) coordinates also correspond with (-Y,X,Z) coordinates in the un-rotated IEC 61217 
coordinate system. 

mrmr vvdVuudU −=−=
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Therefore, let (K,L,M) and (-Y,X,Z) be points in the un-rotated and rotated couch coordinate 
system, respectively.  If the couch is rotated through angle φ , the two points are related by the 
relation: 

 

 Notice that the un-rotated gantry and couch coordinate systems coincide.  Combining these 
two equations gives: 

 

This equation can be simplified by identifying the fact that in images of the ball marker, only U 
and V displacements can be identified as the film is always exposed at right angles to the W 
axis. 

 

This equation is represented in differential form as, 

 

where (dU,dV) is the offset of the center of the marker with respect to the center of the 
radiation field and (-dY,dX,dZ) is the offset of the head frame from the optimal target location. 
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Least squares fit 

The equation, 

 

can be represented in vector form as, 

 

where  

 

If images of the ball marker are acquired with unique gantry and couch rotations, an over-
determined set of equations can be constructed giving, 

 

In order to determine the offset of the head frame from the optimal target location, this 
equation must be solved for (dX,dY,dZ). A powerful technique called Singular Value 
Decomposition (SVD) is used to solve this over-determined set of equations in a best fit least 
squares sense.  A detailed discussion of the SVD technique is beyond the scope of this manual, 
however the reader is referred to Press et al. Numerical Recipes in C, The art of scientific 
computing. Cambridge University Press, 1992.  
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8.3 Appendix C: Acquiring Varian Logfiles 
 

Acquiring DynaLog Files 

The following is an excerpt from Varian’s “DynaLog File Viewer Reference Guide.” 

Generating DynaLog Files for a Millennium MLC 

The Millennium MLC controller operates in a VxWorks® environment.  Serial communications 
using HyperTerminal needs to be set up to communicate with the MLC controller, and an 
Ethernet connection is required to transfer DynaLog files to the workstation. 

Use one of the following methods to generate DynaLog files for the Millennium MLC: 

• Enter a command to save the DynaLog files for only the dynamic treatment just 
completed. 

• Enter a command to make the MLC controller automatically save the DynaLog files: 
o Enter a command at HyperTerminal that turns on the auto-save only for the 

current session. 
o Modify the appropriate startup.* file to turn auto-save on permanently. 

Note: The Millennium MLC controller automatically names the file when generating new 
DynaLog files.  The name is based on the patient’s information and time of treatment. 

To enable the system to generate and save DynaLogs automatically, in the HyperTerminal at 
the VxWorks prompt, type the following command: 

diagAutoDynalogs 2, 1 (for 6.X) 

or 

diagAutoDynalogs 1 (for 7.X) 

To turn off this feature, type the command: 

diagAutoDynalogs 2, 0 (for 6.X) 

or 

diagAutoDynalogs 0 (for 7.X) 

When this feature is enabled, as soon as a dynamic MLC treatment finishes, the controller 
writes those treatment DynaLog files to the DynaLogs folder subdirectory within the default 
FTP root directory on the MLC workstation.  For example: 

...\Oncology\MLC\Controller\exec\DynaLogs\... 
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Acquiring Trajectory Logfiles 

Trajectory files are best created in clinical mode, since dynamic MLC files, like those for Leaf 
Speed, cannot be run in service mode.  You may import the provided RT Plans for Leaf Speed 
and Repeatability into your Record and Verify system, or import the provided MLC patterns 
into the Record and Verify system creating a field for each imported MLC file.  Both MLC 
patterns and RT Plans can be found in your PIPSpro 5.9 installation in the following directory. 

C:\Program Files\Standard Imaging\PIPSpro\VarianMLCTestPatterns 

After the plan is run and the patient is closed, the trajectory files are generated and saved 
automatically.  They can be retrieved on the Truebeam’s “I” Drive.  A typical path is as follows:  I 
drive\TDS\(your machine serial number)\TrajectoryLog\Treatment.  There are other folders 
such as PlanQA and DailyQA, where the files could be stored if you shot it in QA mode. 

Mode Folder Location 

Treatment Mode  
(R&V and File) 

<Output Folder>\TrajectoryLog\Treatment 

Plan QA <Output Folder>\TrajectoryLog\PlanQA 

Daily QA <Output Folder>\TrajectoryLog\DailyQA 
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8.4 Appendix D: Acquiring Elekta Logfiles 

How to Create Elekta Logfiles 

1. Put your Elekta machine in “Clinical Mode” to prevent any errors. 
2. Open your iCOMCat program and you will see a “Server Connections” screen asking for 

the server IP address and Linac ID like below. 

 

3. If you only want to review files (not transfer), you can ignore the “Server Connections” 
pop-up by pressing cancel. If you want to transfer files, we need to connect to the 
Elekta system using the “Server Connections”. The numbers shown in the image are 
specific to our system, so you will need to enter the information specific to your system 
to be able to establish a valid connection.  

4. Once the correct info is entered, press OK to connect. 
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5. Once connected, open up the folder location of the test files by clicking File>Open or 
the folder icon on the top left. Choose the file type to be “iCOM Field (*.efs)” and select 
your appropriate file and press “Open”. 

 

6. By opening the file, the Fx portion and the Vx portion of the iCom program will be filled 
in with live information about the system. Since these files were specific for our Elekta 
system, the Machine ID in the file needs to be changed to yours when uploaded; 
otherwise, the system will send back an error when trying to validate the file.  

 

7. Once the value has been changed, press the “Send Field” button at the top left to 
transfer the files to the Elekta System.  
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8. You will see the linac adjust itself to deliver this beam. We prefer to store this beam in 
service mode so that we can deliver it as needed instead of going through this process 
each time. To do this, select “Copy to Service” at the bottom right hand side of the 
console.  

 

9. You will be prompted for a file name for this new beam. We recommend keeping the 
same actual file name used for the .efs, since when the Elekta-Log files are pulled they 
will contain this name as the Log file name. Press “Save”. 
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10. Once saved you should logout of clinical mode and go into service mode. Once in 
service, click on the service functions tab. (Looks like a Wrench) 

 

11. Now click on the “deliver stored beams” tab. 

 

12. Select the Beams drop down list and find the name of the file you wish to deliver. The 
linac will then upload the parameters of the plan and wait for the confirmation from 
you. 
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13. Once the parameters are fully loaded in you can deliver the sequence. This setup 
should be repeated for all the files within the folder. The initial steps of placing these 
files into your service mode only have to be performed once unless you purge your 
stored beams.  

 

 

How to Get Elekta Logfiles 

 

1. Start at the Standby screen and click on the “Configuration” Tab.  The following screen 
will prompt you for a password.   
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The password is “eos”. 

 

 

2. Select the “Server Maintenance” tab at the top. 
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3. Click on the tab labeled with the Server Maintenance Icon. 

 

 

4. The following screen should appear.  Select the Linac Name by double clicking. 

 

5. Upon doing this, select “Elective Backup and Archive...” on a new window.  The 
following wizard will be started. 
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6. Click Next and mark the box next to “Service Diagnostic Data”. 

 

 

7. Select “Network folder” and input the location on a server or drive in which you would 
like the log files generated. 
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8. Double Check your settings and click Next. 

 

 

9. The process will take some time.  Sometimes it might look like it’s frozen, but be 
patient. 
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10. When finished click Next. 

 

 

You will be brought back to the following window. 
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11. Click ok at the bottom and you will be brought back to the Standby screen. 

 

 

Your Elekta Logfile Zip folder should now show up in the specified location. 
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8.5 Appendix E: Varian Logfile Contents 

Introduction 

Varian linear accelerators produce two different types of MLC logfiles.  TrueBeams produce 
“Trajectory Logfiles” which are binary files.  Older machines, that is, those preceding the 
TrueBeam, produce what are called “DynaLog” files which are in a comma separated variable 
format.  Both file types have headers with treatment and machine-specific information 
followed by series of records of machine parameters (including MLC positions) sampled at a 
fixed rate, which is 50 ms for DynaLog files and   20 ms for Trajectory Logfiles. 

Trajectory files contain much more data than DynaLog files, but there is essentially the same 
information available from both file types for MLC QA analysis.  There are two major 
differences between the MLC information contained in these files:   

1. DynaLog file leaf positions are with respect to the MLC leaf plane and, therefore, 
require a magnification factor greater than one to project the leaf positions to the 
isocenter plane.  This magnification factor is set nominally at 1.9606 in the System 
Manager.  Trajectory Logfile MLC positions are projected to the isocenter plane when 
they are recorded in the binary file.  Because there is no projection required by PIPSpro, 
the magnification factor is set in the System Manager to 1.0000.  These values are 
editable, but probably should not be in normal use of PIPSpro. 

2. In both DynaLog and Trajectory files, errors in MLC leaf positioning (and speed) are 
determined by subtracting expected positions from actual positions.  Equation 1 shows 
how errors for an individual leaf are calculated using DynaLog files.  It shows that the 
error for any leaf m at time n is calculated using the current actual position (at time n) 
and the expected position for the previous sample (at time n-1). 

(Equation 1) 

 

Equation 2 shows how errors for an individual leaf are calculated using Trajectory Logfiles.  It 
shows that the error for any leaf m at time n is calculated using the current actual position (at 
time n) and the expected position for the same sample (also at time n). 

(Equation 2) 
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Dynalog File Specification 

If the option of saving DynaLog files is selected, a pair of DynaLog files is created for each 
beam delivery, one for the “A” bank of MLC leaves and one for the “B” bank.   The structure of 
both files is identical; however, the individual movements of leaves as detailed in the files for 
the two MLC banks are, of course, different. 

 

Figure 1: “B” bank Dynalog file from a “simple” leaf speed test that has been read into Excel. 

Figure 1 shows a “B” bank simple leaf speed DynaLog file read into Excel1.  In the figure, Red 
denotes that a field or column is used for MLC QA.  Blue denotes a field or column that is used 
by PIPSpro for other information, including the number of leaves in the file, 60, and the gantry 
and collimator angles, which are used to identify different test scenarios and specify 
corresponding Quick Selects. 

Each row represents a 50 millisecond sample of machine activity, beam holds, beam on, and 
expected and actual leaf positions.  For DynaLog file analysis, we are interested in Beam Holds, 
Beam On and Expected and Actual leaf positions.  The colored columns show “expected” and 
“actual” positions2  for the 60 leaves (just two columns are show here).   The total treatment 
time is calculated as the number of records times 50 milliseconds per record 
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Leaf positions are described in the MLC plane to a precision of 1/100th of a millimeter.  So, a leaf 
position of -3296 corresponds to a position of 64.62 mm in the isocenter once a standard 
magnification factor of 1.9606 is taken into account. 

Notice that the “Leaf Actual” position is almost always identical to its previous “Leaf Expected” 
position.   This is because the expected position is where the controller will attempt to place 
the leaf on the next cycle; that is, 50 milliseconds later.  This is how instantaneous leaf speed 
and leaf placement errors are determined.  It is assumed that the controller “knows” where 
leaves need to go and that all such errors are with respect to the MLC controller not being able 
to get leaves to go where it “wants” them to go. 

 

 1 We know that it is a “B” bank file, because the leaf motion is from left to right and the first 
values of the expected and actual leaves are negative. 

 2 Varian terminology. 

 

Trajectory File Specification 

Figure 2 shows a Trajectory file from the same “simple” leaf speed test that was used as an 
example for DynaLog files.  The file has been converted from binary to comma-separated 
variable format and read into Excel. 

As before, in this figure, Red denotes that a field or column is used for MLC QA calculations. 
Blue denotes a field or column that is used by PIPSpro for other information, including the 
MLC model, and the gantry and collimator angles, which are used to identify different test 
scenarios and specify corresponding Quick Selects.  

In this Trajectory file, each row represents a 20 millisecond sample of machine activity and leaf 
positions according to the sampling interval.   Apparently, the sampling rate can be any 
multiple of the TrueBeam’s “heartbeat” of 20 ms; however we have only seen 20 millisecond 
sampling.  The total treatment time can be calculated as the number of records (snapshots) 
multiplied by 20 milliseconds per record. 

As with DynaLog file analysis, we are interested in beam holds, beam on and expected and 
actual leaf positions. The colored columns show “expected” and “actual” positions for the 120 
leaves of an NDS120 (just two columns are show here).  Notice that there is no column labeled 
“Beam Hold”, although there is one labeled “MU”, which shows cumulative monitor units for 
the treatment.  Beam on and beam off is determined using the difference between the 
current record and the previous record cumulative monitor units.  If the difference is greater 
than 0.075 MU, we consider the beam on.  Otherwise it is off.  This value was determined 
empirically. 

Unlike DynaLog files, where leaf positions are described in the MLC plane, in Trajectory Logfiles 
leaf positions, represented as floating point numbers with dimensions of mm, are already 
projected to the isocenter plane.  Thus, you will see that the default magnification factor for 
TrueBeam leaf positions is set at 1.0000 in the System Manager. 
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Figure 2: Trajectory file from a “simple” leaf speed test that has been converted from binary to 
comma-separated variable format and read into Excel. 
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8.6 Appendix F: Elekta Logfile Contents 
Figure 1 shows a “TRF” logfile for a “simple” leaf speed test similar to that used to test Varian 
linacs. The file has been converted from binary to comma-separated variable format and read 
into Excel.   

As before, in this figure, Red denotes that a field or column is used for MLC QA calculations. 
Blue denotes a field or column that is used by PIPSpro for other information, including the 
number of MLC leaves and the gantry and collimator angles, which are used to identify 
different test scenarios and specify corresponding Quick Selects.   

In this TRF logfile, each row represents a 40 millisecond sample of machine activity and leaf 
positions according to the sampling interval.  The total treatment time can be calculated as 
the number of records (snapshots) multiplied by 40 milliseconds per record.  For Elekta linacs, 
because the magnetron dose rate takes some time to ramp up and ramp down, the actual 
beam on time can be much less than the total treatment time. 

The colored columns show a sampling of “actual” (green) and “error” (orange) positions for the 
160 leaves of an Acuity MLC.  This representation is different from that of Varian logfiles, where 
“actual” and “expected” positions are given.  However, it is identical information as the 
expected position can be calculated from the sum of the actual and error positions. 

Beam on and beam off is determined by the “Linac State” column and the “Dose (1/64th Mu)” 
columns.  Beam on occurs when the linac state is “Radiation On” and the dose transitions from 
0 to a dose value greater than zero, as shown in Figure 2, record 87.  Beam off occurs when the 
linac state is “Radiation On” and the dose does not increment, as shown in Figure 3, record 
220.   The reason that the 1/64th column is used instead of the “Step Dose/Actual Value 
column is due to file encoding which limits the numerical resolution to 1 decimal place.  Notice 
for this example that the 39, the final Step Dose, times 64 is 2496, which is approximately 2497, 
the final 64ths column value. 

As with Varian Trajectory Logfiles, leaf positions are projected to the isocenter plane. Thus, you 
will see that the default magnification factor for Elekta leaf positions is set at 1.0000 in the 
System Manager. 
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Figure 1: Start 

 

Figure 2:  Beam Turns On 

 

Figure 3: Beam Turns Off  
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8.7 Appendix G: Varian Logfile Analysis 

Introduction to Tests 

The combination of Image-Based MLC QA and Logfile-Based QA in PIPSpro covers all of the 
MLC QA tests in TG-142, Table V.   

Below, we describe the logfile-based methods for calculating Loss of Leaf Speed, Leaf Position 
Accuracy, Leaf Position Repeatability, Leaf Error RMS, and 95% Error Count Distance.  These 
descriptions apply to both DynaLog files and Trajectory logfiles. 

TG-142 recommends testing Step and Shoot and Moving Window leaf sequences with Leaf 
Error RMS and the 95% Error Count Distance.  To these tests we add Leaf Position Accuracy 
testing and designate Step and Shoot, Moving Window, and Modulated Arc (not required by 
TG-142) tests as “Accuracy Tests”.   

Leaf Speed and Speed Errors 

Instantaneous Leaf Speed for a single leaf is defined to be the difference in successive “Leaf 
Actual” positions divided by the sample time: 

 

Instantaneous leaf speed errors are only calculated when the beam is on (i.e., when beam 
holds are not asserted). 

 

Average Leaf Speed for a single leaf is calculated as the average instantaneous leaf speed 
when the leaf is in motion and the beam is on.   There is an initial ramp section of a leaf speed 
profile, which is described later, that excluded in this calculation: 

 

where “m” is the first logfile record after the initial ramp and “n” ranges over records  when the 
leaf is in motion and the beam is on. 
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Average Leaf Speed for all leaves is calculated as the average of “n” individual leaf speeds. 

 

Instantaneous Leaf Speed Errors are calculated as the difference between the actual 
instantaneous leaf speed and the expected instantaneous leaf speeds. 

Instantaneous speed error status is determined by the Leaf Speed thresholds set in the 
System Manager. 

Average Leaf Speed Errors are calculated as the difference between Average Leaf Speed and 
the leaf speed intended to be delivered.  The user must calculate and know what the 
intended, nominal speed should be for a particular delivery. 

Unlike other tests, average speed error status is either pass or fail.  There is no intermediate 
“alert” status.  If the calculated average speed is more than 5% different from the user-
determined nominal speed, the leaf speed test fails.  The 5% threshold is not adjustable. 

IMPORTANT:  When there are beam holds, the user may need to set the nominal leaf speed in 
the Manual Select group box.  This is an important step as PIPSpro is not able to calculate 
intended leaf speed and the nominal speed is part of the Quick Select key that defines a series 
of tests.  Notice below that the Nominal Speed is 12.4 mm/s rather than 12.4 mm/s, the likely 
target speed. 

 

Overall status for a leaf speed test is determined as the worst case of the instantaneous and 
average status.  If a single leaf’s instantaneous speed loss at any point in time is greater than 
the error threshold, the test fails; if the average leaf speed is more than 5% different from the 
nominal leaf speed, the test fails. 
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Determining Leaf Speed 

Imagine a leaf pair with a 0.5 cm gap moving across the treatment field.  We know that with 
the Varian Millennium MLC, that the gap cannot move much more than 13.5 cm, because of 
carriage constraints. 

 

Figure 2: Detail from Varian Shaper® showing beginning and ending leaf positions. 

 

MLC leaf patterns to be delivered are expressed in fractions of total monitor units 
delivered.  So, as shown in Figure 2, if 100 monitor units are to be delivered, when the last of 
the 100 monitor units are delivered, the MLC leaf will be in its final position.  So, monitor units 
for a treatment can and do affect the speed at which leaves will move…if 200 monitor units 
were selected, the leaf speed would be one-half as much. 

Equation 4 shows how to determine the number of monitor units (MU) that will achieve a leaf 
speed of 2.5 cm/s  at a dose rate of 400 MU/minute.  

 

Leaf Speed Test Files 

The Leaf Speed module is designed to work with special Leaf Speed test files (RT Plans files for 
TrueBeam, *.dva files for earlier machines).  There are two different types of test files:  

“Simple Tests”, in which a leaf gap spanning the entire field in the ”Y” direction moves as a 
“front” for 13.5 cm, either right-to-left or left-to-right. 

 “Complex Tests”, in which every other leaf moves across the field for a time and then the 
leaves that were previously stationary move, and so forth. This occurs in four phases.  Again, 
total leaf travel is 13.5 cm and leaves can move either right-to-left or left-to-right. 
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Figure 3: Screen shots of simple and complex leaf speed tests at similar execution points. 

 

For DynaLog-producing accelerators, four different types of Leaf Speed MLC *.dva files are 
provided in the installation: “LRXXXSimple.dva”, “LRXXXComplex.dva”, “RLXXXSimple.dva”, and 
“RLXXXComplex.dva”, where the “XXX” suffix is 80M, 120M, or 120HD for one of each of the three 
types of multi-leaf collimators currently supported by PIPSpro logfile analysis.   

For TrueBeam accelerators, there are RT Plans provided for your convenience, but you can 
easily create plans of your own by importing the above leaf patterns into your Record and 
Verify system for individual fields in one or more plans. 

Both RT Plans and MLC files can be found in the following directory*: 

C:\Program Files\Standard Imaging\PIPSpro\VarianMLCTestPatterns 

 

In order to create Leaf Speed logfiles files, you must create plans that employ them.  Different 
speeds are achieved by specifying different numbers of monitor units per beam.  The fewer 
the monitor units the faster the leaf speed. 

Recommended field size: 14X40 cm 

Desired Speed (cm/s) MU/Minute MU’s 

2.50 400 36 

1.25 400 72 

1.0 400 90 

0.5 400 180 
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Speed table for simple tests. 

Desired Speed (cm/s) MU/Minute MU’s 

2.50 400 72 

1.25 400 144 

1.0 400 180 

0.5 400 360 

 

Speed table for complex tests. 

Notice that for complex tests, twice as many monitor units are required to create logfiles files 
that move with the same speeds as the simple tests.  That is because leaves are actually 
moving twice as long, due to the every-other-leaf format of the complex tests. 

 

How Leaves Move 

Implicit in the above calculations is that the leaf speed across the field for the test patterns is 
steady.   This assumption turns out to be true in the macro sense, but not in the micro sense as 
shown in Figure 4. 

 

Figure 4:  Typical leaf speed profile for 0.5 cm/s “nominal” leaf speed. 

 

As we can see, there is a ramp up region followed by a steady-state region that is composed of 
quasi-periodic discrete leaf speeds.  The ramp up may be predominantly attributed to beam-
line pulse startup latency.   A secondary source may be due to leaf inertia.  Figure 5 shows a 
detail of leaf speeds within the steady state region. 
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Figure 5:  Detail of steady-state leaf speeds 

 

Knowing that stepper motors are used for leaf positioning and that the DynaLog sampling 
frequency is 20 records per second , we can determine through linear regression that, for this 
leaf speed, between 11 and 14 stepper motor pulses per 50 ms period are required to maintain 
leaf speed to meet delivery goals. 

 

Summary and Observations 

When we calculate instantaneous leaf speed errors, we compare the actual leaf speed per 
record to the expected leaf speed as required by the MLC controller on a leaf-by-leaf and 
record-by-record basis.  This is in contrast to the alternative of comparing instantaneous leaf 
speed to nominal leaf speed.  Note that the MLC controller changing leaf speeds to meet 
clinical delivery goals with stepper motor and beam pulse constraints is by definition what the 
MLC controller is supposed to do.    

Average speed is calculated as the average speed of all leaves when the beam is on in the 
steady state region.  When there are beam holds, the average speed can be quite a bit 
different from the intended nominal speed as calculated in Tables 1 and 2.   We determine 
average speed errors according to the difference between the average and the nominal 
intended speed, which the user may need to specify when there are beam holds.  

 

Leaf Position Repeatability 

Leaf position repeatability is tested using alternating step and shoot MLC leaf patterns that 
iterate for a number of cycles.   In testing repeatability, PIPSpro identifies the first two patterns, 
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records the exact leaf positions during beam on for each leaf in the initial two patterns, and 
then compares the initial leaf positions to leaf positions for subsequent beam on periods. 

Leaf speed logfiles are provided in the installation to test repeatability.  They are in the same 
directory as the leaf speed tests.   

You may create your own repeatability patterns.  Any collection of alternating step and shoot 
MLC leaf patterns where leaf positions are multiples of 5 mm will be identified as a 
repeatability test.  You will need to be able to run Varian’s “Shaper” program to create MLC 
patterns. 

 

Figure 6:  Screenshots of initial repeatability patterns 

 

For any leaf, m, repeatability is calculated at time n (when the beam is on) as shown in 
Equation 5. Did leaf “m” go to where it was when a pattern was established? 

 

Notice that the repeatability calculation is signed.  A negative sign means that the measured 
leaf position was closer to the central axis than the position set by the initial pattern.  A positive 
sign means that the measured leaf position was further away from the central axis than the 
position set by the initial pattern.  This interpretation of signs is similar to that used in accuracy 
tests. 
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Accuracy Tests 

PIPSpro supports three different accuracy tests for different IMRT/VMAT deliver methods: Step 
and Shoot, Sliding Window, and Modulated Arc.  Three different quantities are reported for 
each test: signed accuracy, RMS leaf error and 95% of error counts.  We do not (yet) provide 
custom leaf patterns to test these delivery methods, so the user should use representative 
clinical delivery patterns for each test. 

Leaf Position Accuracy 

For each of the three supported tests, for any leaf, m, accuracy is calculated at time n (when 
the beam is on) as shown in Equation 6.  Did leaf “m” go to where the MLC controller wanted it 
to go at time n? 

 

As with the repeatability calculation, the accuracy calculation is signed.  A negative sign means 
that the measured leaf position was closer to the central axis than the expected (desired) 
position.  A positive sign means that the measured leaf position was further away from the 
central axis than the expected (desired) position. 

Leaf Error RMS 

Root Mean Squared (RMS) leaf error is calculated as shown in Equation 7.  RMS Error is similar 
to a standard deviation calculation, where deviation from a mean value is replaced by 
deviation from expected values.  Summations are over all moving leaves when the beam is on. 
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 95% of Error Counts Distance 

Figure 7 shows a typical distribution of the absolute values of leaf accuracy errors. 

Imagine that all errors are sorted in an array from smallest to biggest (left to right).  Starting at 
the beginning of the array, the index at which 95% of errors are represented is found. The error 
in millimeters corresponding to that index is the 95% error count value. 

 

Figure 7: Typical Distribution of Leaf Accuracy Errors (mm) 
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8.8 Appendix H: Elekta Logfile Analysis 

Introduction to Tests 

The combination of Image-Based MLC QA and Logfile-Based QA in PIPSpro covers all of the 
MLC QA tests in TG-142, Table V.   

Below, we describe the logfile-based methods for calculating Loss of Leaf Speed, Leaf Position 
Accuracy, Leaf Position Repeatability, Leaf Error RMS, and 95% Error Count Distance.  These 
descriptions apply to Elekta TRF logfiles only as they are different from Varian DynaLog files 
and Trajectory files. 

TG-142 recommends testing Step and Shoot and Moving Window leaf sequences with Leaf 
Error RMS and the 95% Error Count Distance.  To these tests we add Leaf Position Accuracy 
testing and designate Step and Shoot, Moving Window, and Modulated Arc (not required by 
TG-142) tests as “Accuracy Tests”.   

 

Leaf Speed and Speed Errors 

Calculation of instantaneous leaf speed, unlike with Varian linacs, is problematic because of 
leaf inertia and the leaf position resolution in the Elekta logfiles.   

Leaf inertia results in early leaf speeds that are significantly slower than later, steady state leaf 
speeds.  There is a significant leaf speed “ramp up”.   

The relatively coarse leaf position resolution, 0.1 mm, results in magnification of round off 
errors.   Given the 40 millisecond sampling rate, a 0.1 mm error in leaf position translates into a 
2.5 mm/s difference in leaf speed (i.e.,  0.1mm/0.04s = 2.5mm/s). 

So, instead of relying on a combination of instantaneous and average leaf speed, Elekta logfile 
analysis uses average leaf speeds only.   Because instantaneous leaf speed is not used, the 
movie display is not colored.  Results displays are structured identically to those used for 
Varian leaf speed results, but show maximum average leaf speed errors instead of maximum 
instantaneous leaf speed errors. 

Average Leaf Speed for a single leaf is calculated as the average instantaneous leaf speed 
when the leaf is in motion and the beam is on. 

 

(Equation 1) 

where “p” is the first logfile record when the leaf is in motion and the beam is on, and “q” is the 
last record when the leaf is in motion and the beam is on. 

Average Leaf Speed for all leaves is calculated as the average of “n” individual leaf speeds. 
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(Equation 2) 

Average Leaf Speed Errors are calculated as the difference between Average Leaf Speed for 
single leaves and an Average Leaf Speed “baseline” for all leaves.  This baseline is established 
when the first results for a unique leaf speed test are saved and associated with a Quick 
Select.   

Alert and error thresholds as specified in the System Manager are used to determine the pass, 
alert, fail status.  These thresholds are applied directly to the difference between each 
individual single leaf average speeds and the average leaf speed baseline.  Status for a leaf 
speed test is the worst case average leaf speed status.  

Determining Leaf Speed 

Imagine a leaf pair with a 1.0 cm gap moving 14.0 cm across the treatment field. 

 

Figure 1: Detail from movie display showing beginning and ending leaf positions. 

MLC leaf patterns to be delivered are expressed in fractions of total monitor units delivered. So, 
as shown in Figure 1, if 100 monitor units are to be delivered, when the last of the 100 monitor 
units are delivered, the MLC leaf will be in its final position. So, monitor units for a treatment 
can and do affect the speed at which leaves will move…if 200 monitor units were selected, the 
leaf speed would be one-half as much.  
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Equation 3 shows theoretically how to determine the number of monitor units (MU) that will 
achieve a leaf speed of 3.0 cm/s at a dose rate of 500 MU/minute. 

 

(Equation 3) 

 

Leaf Speed Test Files 

The Leaf Speed module is designed to work with “Simple” Leaf Speed *.efs test files.   In 
“Simple Tests”, a leaf gap spanning the entire field in the ”X” direction moves as a “front” for 
14.0 cm, either in-to-out or out-to-in. 

 

Figure 2: Simple leaf speed, 160 Agility 

 

Two different Leaf Speed MLC *.efs files are provided in the installation: “InOutSimple.efs” and 
“OutInSimple.efs”.  These *.efs files may be executed using the iCom system on 160-leaf MLC’s, 
the only MLC’s for which TRF files are produced. 

These *.efs files can be found in the following directory*:  

C:\Program Files\Standard Imaging\PIPSpro\ElektaMLCTestPatterns  
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Different leaf speeds are achieved by specifying different numbers of monitor units per beam. 
The fewer the monitor units, the faster the leaf speed.  

Recommended field size: 14X40 cm 

Target Speed (cm/2) MU/Minute MU’s Typical Speed 

3.0 500 39 2.75 

2.0 500 58 1.89 

1.0 500 117 0.95 

 

Speed table for simple tests 

Relatively significant leaf inertia means that leaves take a while to achieve a steady leaf speed, 
so “typical” average achieved speeds are somewhat less than the “target” speed.  The “typical” 
average leaf speed is what is used to create the baseline; it is differences from the typical leaf 
speed that are used to calculate leaf speed errors. 

 

Leaf Position Repeatability 

Leaf position repeatability is tested using alternating step and shoot MLC leaf patterns that 
iterate for a number of cycles. In testing repeatability, PIPSpro identifies the first two patterns, 
records the exact leaf positions during beam on for each leaf in the initial two patterns, and 
then compares the initial leaf positions to leaf positions for subsequent beam on periods.  

Leaf speed logfiles are provided in the installation to test repeatability. They are in the same 
directory as the leaf speed tests.  

 

 

Pattern #1: 160 Agility Pattern #2: 160 Agility 

 

Figure 3:  Screenshots of initial repeatability patterns 
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For any leaf, m, repeatability is calculated at time n (when the beam is on) as shown in 
Equation 5. Did leaf “m” go to where it was when a pattern was established? 

 

(Equation 4) 

Notice that the repeatability calculation is signed. A negative sign means that the measured 
leaf position was closer to the central axis than the position set by the initial pattern. A positive 
sign means that the measured leaf position was further away from the central axis than the 
position set by the initial pattern. This interpretation of signs is similar to that used in accuracy 
tests. 

 

Accuracy Tests 

PIPSpro supports three different accuracy tests for different IMRT/VMAT delivery methods: 
Step and Shoot, Sliding Window, and Modulated Arc. Three different quantities are reported 
for each test: signed accuracy, RMS leaf error and 95% of error counts. We do not (yet) provide 
custom leaf patterns to test these delivery methods, so the user should use representative 
clinical delivery patterns for each test. 

 

Leaf Position Accuracy 

For RMS leaf error and 95% of error counts, for any leaf, m, accuracy is calculated at time n 
(when the beam is on) as shown in Equation 5.  Did leaf “m” go to where the MLC controller 
wanted it to go at time n? 

 

(Equation 5) 

Signed accuracy for Elekta linacs uses Equation 5 somewhat differently, because of the 
dynamic allowable MLC leaf error limit for each record (See Appendix F: Elekta Logfile 
Contents).  Figures 4a and 4b show dynamic error limits and maximum absolute errors for a 
clinical VMAT case.  Maximum absolute errors are defined to be the largest absolute accuracy 
errors found for each leaf in each leaf bank for each record. 

Notice that the dynamic error normally envelops the maximum absolute errors for each 
record, as would be expected.  However, as an example, in Figure 4a, at approximately record 
800, as the dynamic error is decreasing, the maximum absolute error is increasing, as shown 
in the green dashed region.  This is potentially a region where the dynamic allowable MLC leaf 
error limit might be exceeded by one or more leaves. 
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Figure 4a: Dynamic and maximum absolute errors for a clinical VMAT case 

 

 

Figure 4b:  Dynamic and maximum absolute errors for a clinical VMAT case 

As with the repeatability calculation, the accuracy calculation, as shown in Equation 5, is 
signed.  A negative sign means that the measured leaf position was closer to the central axis 
than the expected (desired) position. A positive sign means that the measured leaf position 
was further away from the central axis than the expected (desired) position. 

Instead of using Equation 5 directly to calculate leaf status, the absolute dynamic accuracy for 
any leaf, m, is calculated at time n (when the beam is on), as shown in Equation 6.   Leaf 
accuracy thresholds as set in the System Manager are compared against the absolute 
dynamic accuracy to determine pass, alert, or fail status. 

 

(Equation 6) 
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Leaf Error RMS 

Root Mean Squared (RMS) leaf error is calculated as shown in Equation 7.  RMS Error is similar 
to a standard deviation calculation, where deviation from a mean value is replaced by 
deviation from expected values.  Summations are over all moving leaves when the beam is on. 

 

 95% of Error Counts Distance 

Figure 7 shows a typical distribution of the absolute values of leaf accuracy errors. 

Imagine that all errors are sorted in an array from smallest to biggest (left to right).  Starting at 
the beginning of the array, the index at which 95% of errors are represented is found. The error 
in millimeters corresponding to that index is the 95% error count value. 

 

Figure 5: Typical Distribution of Leaf Accuracy Errors (mm) 
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8.9 Appendix I: UNC Paths 

Microsoft UNC Path Format 

The Microsoft Windows UNC, short for “Uniform Naming Convention,” specifies a common 
syntax to describe the location of a network resource; such as an individual directory or printer. 

The UNC path syntax has the form: 

 \\HostName\ShareName[\Resource[\SubResource]] 

Microsoft often refers to this as a “network path” or a “network share.” 

The ‘HostName’ represents the name of the computer where the share is located or 
hosted.  The name must be either a NetBIOS name, a fully qualified domain name, or an IP 
address in IPv4 or IPv6 standard format. 

The ‘ShareName’ represents the resource to be accessed, and is defined by the user who set 
up the network share; which, in the directory default case, is the name of the directory that is 
shared.  A specific ShareName may not be visible if your user ID does not have suitable 
permissions assigned to access it. 

If your user ID has Administrative permissions on the target host named by the ‘HostName’ 
value, then you will be able to access the hidden “Administrative Shares,” for instance where 
the ‘ShareName’ is “C$” for the “C:\” drive root, etc. 

The ‘Resource’ is optional and how it is interpreted depends on the actual resource that is 
shared/accessed.  For UNC paths that represent a shared directory structure, the ‘Resource’ is 
the first directory or any file that is located in the root of the shared directory. 

Subsequent sub directories are appended as required to fill the path to the depth required to 
specify the resource directly, as represented by the optional ‘SubResource’ term above. 

Notes: 

• ‘HostName’ is not case sensitive because the four allowed formats are insensitive to 
case. 

• ‘ShareName’ may be case sensitive but is usually not.  This depends on the 
system/mechanism that is providing the network share. 

• ‘Resource’ and ‘SubResource’ are more likely to be case sensitive.  This depends on the 
system/mechanism that is providing the network share. 

 

Citrix Environments UNC Paths 

When using a Citrix system to access a remote desktop or a published application the disk 
drives of your local computer can be made available at the remote host, with permission, via 
UNC paths. 

These resources appear in the remote host with the ‘HostName’ set to “Client” and the 
‘ShareName’ matches the “Administrative Share” for that resource.  For example, the local 
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computer C drive will appear, when permitted, as   “\\client\C$”, the character case is ignored 
in this context. 

Early versions of Citrix services mapped the local computer to the ‘HostName’ of “User” so you 
may see differences depending on the release of Citrix that your organization is using. 

Please refer to your IT professional for assistance if needed. 
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8.10  Appendix J: Setting up QA Portal for PIPSpro Database test results export 

to QA Pilot 
 

• PIPSpro Software to QA Pilot Connection Setup 

QA Pilot is a cloud-based QA database management software tool offered by Standard 
Imaging.  Version 5.9 of PIPSpro provides a QA Portal to connect PIPSpro to QA Pilot for direct 
import of PIPSpro results into the QA Pilot Database.  If you are a QA Pilot User utilize the 
following instructions to connect PIPSpro to QA Pilot. 

  
1. Login to QA Pilot and select Manage→Sites & Machines and verify that the QA Pilot 

“Machine Name” matches the “Department Name” in the PIPSpro System Manager.  
2. In QA Pilot select Manage→Sites & Machines→choose Edit on the linac you will be 

using for the PIPSpro connection.   
• Confirm the Machine Label and Serial Number match the linac as defined in 

PIPSpro.  
3. Select Manage → Users → Modify for the User(s) who will perform QA on the linac(s) 

selected in step 2 and confirm they have permissions to perform the QA on the linacs.  
4. Select Manage → API 
5. Select [Add token] (button in the upper right), and complete the dialog by specifying a 

label and selecting Add token (an API Client and API Key will be generated) 
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6. Complete the dialog by specifying a token label and selecting Add Token 
 
 
 

 
 
 
 
 
 
 

 
 

7. (an API Client and API Key will be generated) 
 

 
  

8. Open the PIPSpro System Manager 
9. In the Systems Manager “Departments” tab: copy API Client ID and API Key values for 

each Department that you wish to allow access to have set up for QA Pilot 
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10. On Users tab: Check “QA Pilot: Allow Upload” box for each user you wish to allow to 
upload to QA Pilot 
  

 
  

11. Ensure that the Department Name, Linac Name and Linac Serial Numbers match in 
both systems. 

  

Note: After PIPSpro successfully connects to QA Pilot for the first time it will 
create 3 custom test groups:  

• PIPSpro Annual Tests 

• PIPSpro Monthly Tests 

• PIPSpro Weekly Tests 

A schedule must contain tests from these test groups for PIPSpro to be able to 
upload results with it as a target. 
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8.11 Appendix K: PIPSpro Publications 

PIPSpro Publications 

Implementation of electronic portal imaging in a busy radiation therapy treatment center.  
M. Davis, R. Sabey, R. Rajapakshe.  Proc. Workshop on Electronic Portal 
Imaging,  Amsterdam,  1996. pp 10-11.  
 
Picture archival and communication system (PACS) for electronic portal imaging.  
R. Rajapakshe, R. Sabey, R. Lewis, D. Henkelman. Proc. Workshop on Electronic Portal Imaging, 
Amsterdam, 1996. p. 10.  
 
Conformal treatment of the prostate utilizing intensity modulation and organ immobilization.  
W. Grant III, J. McGary, D. Bellezza, P. Nizin. Med. Phys. 24(6):1023 (1997).  
 
Setup reproducibility in radiation therapy for lung cancer: 
   A comparison between T-bar and expanded foam immobilization devices. 
R. Halperin, W. Roa, M. Field, J. Hanson, B. Murray.   Int.J.Rad.Oncol.Biol.Phys. 43(1): 211-216 (1998) 
 
A comparison of clinical experience and quality assurance with a gantry-mounted (Philips SRI 
100) and a mobile EPI-system (ELIAV PORTpro).  
B. Bannach, T. Doll, D. Lansing, G. Schmitt. Proc. Workshop on Electronic Portal Imaging, 
Phoenix, Oct 1998. pp 39-40.  
 
Image quality assurance for a Varian PortalVision EPID.  
H.J. Kim, R.S. Sloboda. Proc. Workshop on Electronic Portal Imaging, Phoenix, October 1998. pp 
95-96.  
 
Quality control in digital portal imagers (Abstract in English, text in Dutch).  
P.H. Vos, G.A.N. Coenen, S.A.J.M. Versmissen. Clinical Physics (Journal of the Dutch Society of 
Clinical Physics) 
98/1: 27-31 (1998)  
 
Erfahrungen mit dem Hochenergie-Bildsystem Siemens Beamview Plus im klinischen 
Routine-Einsatz.  
O. Schramm, B. Gagel, G. Sroka-Perez, M. Eble, M. Wannenmacher. Strahlenther. Onkol. 174: 92 
(1998)  
 
Vergleich des Hochenergie-Bildsystem Siemens Beamview Plus mit konventionellen 
Verifikationsfilmen.  
B. Gagel, O. Schramm, W. Harms, M. Eble, M. Wannenmacher. Strahlenther. Onkol. 174: 92 
(1998)  
 
Reproducibility in Radiation Treatment.  
I. Kristensen, T. Knoos. Winning best poster at ESTRO Conf. Edinburgh 1998  
 
Use of CT Simulation in Radiotherapy Treatment Planning for Carcinoma of the Prostate.  
M.A. Coe, D.J. Husband, C.H.M. Lee, J.A.H. Littler, H.M.O. Mayles, W.P.M. Mayles, V. Nock, I. 
Syndikus, J. Taylor.    Radiotherapy & Oncology 48: S149 (1998)  
 
Image quality parameters for the production standard Eliav PORTpro portal imaging device.  
A. J. Poynter. Brit. J. Radiol. 72: 802-804 (1999)  
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Verification of electron field positioning. 
H. Lemnitzer, U. Wolf, G. Hildebrandt, F. Kamprad. Radiotherapy & Oncology 52: 61-64 (1999) 
 
Preprocessing of control portal images for patient setup verification during the treatments in 
external radiotherapy.  
G. Hilt, D. Wolf, P. Aletti. Med. Phys. 26: 2539-2549 (1999)  
 
Clinical Implementation of a new Electronic Portal Imaging System.  
L. Aubin, A. Conrad, C. Thompson, R. Rajapakshe. Proc. WESCAN Conf., Kelowna, March 1999  
 
Quality Assurance in Stereotactic Radiosurgery.  
K. Luchka, J. Wolters. Proc. WESCAN Conf., Kelowna, March 1999  
 
Evaluation of the use of ORFIT based on head and neck immobilisation in radiotherapy.  
M.C. Kirby, N.C. Bulmer, A. Davis, R. Foster, L. Hall, J.L. Stief, C. Watson. Physica Medica XV No.3: 
204 (1999)  
 
A portal imaging test object for accurately assessing image registration algorithms.  
M.C. Kirby, A.R. Dowling, N.C. Bulmer. Physica Medica XV No.3: 204 (1999)  
 
Initial clinical experience with a video-based patient positioning system. 
L.S. Johnson, B.D. Milliken, S. Hadley, C. Pelizzari, D. Haraf, G.T.Y. Chen. Int.J.Rad.Oncol.Biol.Phys. 
45:205-213 (1999) 
 
Electronic portal imaging with an avalanche-multiplication-based video camera.  
G. Pang and J.A. Rowlands. Med. Phys. 27: 676-684 (2000)  
 
Radiation therapy for breast cancer at the millenium.  
H. Jane Dobbs. Radiotherapy & Oncology 54: 191-200 (2000)  
 
A clinical evaluation of setup errors for a prostate immobilization system. 
J.E. McGary, W. Grant. Jounal of Applied Clinical Medical Physics 1: 138-147 (2000) 
 
Characterization of a high-elbow, fluoroscopic electronic portal imaging device for portal 
dosimetry. 
J.C.J. de Boer, B.J.M. Heijmen, K.L. Pasma, A.G. Visser. Phys. Med. Biol. 45: 197-216 (2000) 
 
A multidisciplinary approach to implementing effective portal imaging and review protocols.  
J. Stief and M.C. Kirby. Proc. 6th. Int. Workshop on Electronic Portal Imaging, Brussels, June 
2000. Paper 5.  
 
Quality Assurance of EPI Systems.  
R. Rajapakshe, S. Shalev, K. Luchka.  Proc. 6th. Int. Workshop on Electronic Portal Imaging, 
Brussels, June 2000. 
Refresher Course Paper 24.  
 
Accepting and commisssioning an upgraded fluoroscopic electronic portal imaging device 
(EPID).  
M.C. Kirby, N.C. Bulmer. Proc. 6th. Int. Workshop on Electronic Portal Imaging, Brussels, June 
2000. Paper 28.  
 
Clinical integration of an iView electronic portal imaging device.  
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K. Luchka. Proc. 6th. Int. Workshop on Electronic Portal Imaging, Brussels, June 2000. Paper 
29.  
 
A quantitative assessment of a flat panel portal imaging device.  
K. Luchka. Proc. 6th. Int. Workshop on Electronic Portal Imaging, Brussels, June 2000. Paper 
31.  
 
The electronic portal imaging system Siemens Beamview Plus and the conventional 
verification films CEA-TVS 
and Du Pont CQL-7, a comparison of subjective image quality.  
B. Gagel et. al. Proc. 6th. Int. Workshop on Electronic Portal Imaging, Brussels, June 2000. 
Paper 38.  
 
Dependence of image quality on user-given parameters for the Philips SRI-100 EPID.  
D. Taylor, S. Hussein. Proc. 6th. Int. Workshop on Electronic Portal Imaging, Brussels, June 
2000. Paper 39.  
 
Prospective analysis of patient motion in prostate conformal radiotherapy. 
H. Lau, L. Aubin, A. Conrad, C. Thompson, K. Hutchison, R. Rajapakshe. Proc. 6th. Int. Workshop 
on Electronic Portal Imaging, Brussels, June 2000. Paper 71. 
 
Letter to the Editor.  
K. Luchka. Interactions - Canadian Medical Physics Newsletter. 46(3) July 2000. p. 118. 
 
Comparison of setup accuracy of three different thermoplastic masks for the treatment of 
brain and head and neck tumors  
L. Gilbeau, M. Octave-Prignot, T. Loncol, L. Renard, P. Scalliet, V. Gregoire. Rad. & Oncol. 58: 155-
162 (2001) 
 
Experiences in evaluating geometrical uncertainties in bladder radiotherapy. 
C. Hall, A. Gee, S. Hilton, H. Appleby, A. McKenzie, J. Graham. 
Abstract 3.5 in 1st UK Radiation Oncol. Conf. (UKRO), April 2001. Clinical Oncology 13(Sup. 2) p. 
S6 (2001). 
 
Double-blind randomized trial comparing virtual and conventional simulation in palliative 
radiotherapy for non-small-cell lung cancer. 
M. McJury, S.D. Pledge, P.M. Fisher, G. Brown, C. Anthony, M.Q. Hatton, J. Conway, M.H. 
Robinson. 
Abstract 5.4 in 1st UK Radiation Oncol. Conf. (UKRO), April 2001. Clinical Oncology 13(Sup. 2) p. 
S9 (2001).  
 
Radiotherapy technique: Accuracy and reproducibility for head and neck, bladder and 
prostate, thorax and abdomen. 
S. Stanley. Abstract 5.5 in 1st UK Radiation Oncol. Conf. (UKRO), April 2001. Clinical Oncology 
13(Sup. 2) p. S9 (2001). 
 
Quality control of treatment verification imaging software. 
N.C. Bulmer, M.C. Kirby. Presented at the BIR meeting on Treatment Verification. London 11 
June 2001. 
 
Image acquisition properties of an amorphous silicon electronic portal imaging device. 
P. Greer. Abstract in COMP Annual Meeting, Kelowna, July 2002. Medical Physics 28, 1974 
(2001). 
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Initial experience with the Lumisys ACR-2000 Computed Radiography system for digital 
simulation imaging, portal imaging, and verification of IMRT treatments. 
E. Henderson, H. Alasti. Abstract in AAPM Annual Meeting, Salt Lake City, 2001. Medical Physics 
28, 1216 (2001) 
 
The impact of virtual simulation in palliative radiotherapy for non-small-cell lung cancer. 
M. McJury, P.M. Fisher, S. Pledge, G. Brown, C. Anthony, M.Q. Hatton, J. Conway, M.H. Robinson. 
Radiotherapy and Oncology 59: 311-318 (2001). 
 
Treatment planning aids in prostate cancer: friend or foe? 
S. Malone, R. Donker, S. Dahrouge, L. Eapen, I. Aref, G. Perry, J. Szanto. Int.J.Rad.Oncol.Biol.Phys. 
51(1): 49-55 (2001). 
 
The application of computed radiography imaging system for portal imaging; a comparison of 
two commercial portal imaging systems. 
J. Vanhanen, M. Pitkänen, S. Peltola, S. Hyödynmaa. Radiotherapy and Oncology 61 Suppl. 1, S81 
(2001). 
 
Quality Asurance of EPI Systems.  
K. Luchka, R. Rajapakshe, S. Shalev.  Proc. 7th. Int. Workshop on Electronic Portal Imaging, 
Vancouver, June 2002: 8-11. 
 
Image quality performance of amorphous silicon electronic portal imaging devices.  
J. Figueredo, P. Greer. Proc. 7th. Int. Workshop on Electronic Portal Imaging, Vancouver, June 
2002: 106-107.  
 
Initial comparison of three am-Si EPIDs using the QC-3 phantom. 
R. Clements, K. Luchka, J. Pouliot, J. Sage, S. Shalev. Proc. 7th. Int. Workshop on Electronic 
Portal Imaging, Vancouver, June 2002: 108-109. 
 
Incorporating EPI into a comprehensive radiation therapy QA program.  
J. Wolters, R. Rajapakshe, G. Hovde, J. Moffat. Proc. 7th. Int. Workshop on Electronic Portal 
Imaging, Vancouver, June 2002: 168-169. 
 
Evaluation of iView and iViewGT using the QC-3 phantom: A multicentre study. 
N. Bulmer, G. Budgell, R. Clements, A. Glendinning, M. Kirby, J. Sage, S. Weston 
PIPSpro User’s Meeting, Manchester April 2003: 7-8. 
 
Clinical Case Studies: Head and Neck: A. Banbury. Lung: H. Dalton. Pelvis: A. Banbury 
PIPSpro User’s Meeting, Manchester April 2003: 9-10. 
 
The use of image registration methods in the optimisation of treatment accuracy. 
M. McJury, J. Conway, C. Anthony, G. Brown, K. Wilcock, M. Cooper, M. Robinson 
PIPSpro User’s Meeting, Manchester April 2003: 11-12 
 
Portal Image Verification of Siemens HD270 - a software option for improving MLC resolution 
D. Routsis, B. Gibson. PIPSpro User’s Meeting, Manchester April 2003: 15. 
 
Web-based integration of PIPSpro into a radiotherapy department 
R. Wyatt, K. Natarajan. PIPSpro User’s Meeting, Manchester April 2003: 17-18. 
 
Integrating PIPSpro and iView 
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J. Sage. PIPSpro User’s Meeting, Manchester April 2003: 19-20. 
 
Accuracy of prostate radiation therapy using fiducial point-pair registration technique based 
on the computer-assisted portal image quality assurance program PIPSpro. 
W. Mermerstain, Y. Cohen, Y. Krutman.  Australasian Radiology 47, 168-171 (2003). 
 
Quality assurance measurements of a-si epid performance 
Menon GV, Sloboda RS 
Medical Dosimetry - Spring 2004 (Vol. 29, Issue 1, Pages 11-17) 
A procedure to determine the radiation isocenter size in a linear accelerator. A. Gonzalez, I. 
Castro, and J. A. Martinez. Medical Physics 31, 1489-1493 (2004) 
Commissioning experience with con-beam computing tomography for image-guided 
radiation therapy. 
J. Lehmann, J. Perks, S. Semon, R. Harse, J.A. Purdy.  J Appl Clin Med Phys. 2007 Jul 17; 8(3):2354. 
 
Image quality and stability of image-guided radiotherapy (IGRT) deices: A comparative study. 
M. Stock, M. Pasler, W. Birkfellner, P. Homolka, R. Poetter, D. George.  Radiother Oncol. 2009 
Oct;93(1):1-7. 
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9 Section 5 : Troubleshooting and Frequently Asked Questions 

9.1 General 

Can you do TG-142 MV and kV imager scaling test in PIPSpro? 

The scaling test should really be done on the imager’s system.  The test is intended to assess 
whether or not the imaging system is scaling the image correctly based on different distances 
of the imager. 

To perform the scaling test, a phantom with fiducials separated by a known distance is 
needed.  The MLC phantom or FC-2 phantom could be used for this purpose as could any 
other phantom that has fiducials set at a known distance from one another. 

The phantom is placed at isocenter, and an image is acquired with the imager 150 cm from 
the source.  Use the imager system measuring tools to measure the distance between the 
fiducials.  These measurements should correspond to the known distance between fiducials. 

The test should be done at two imager distances in order to assess the imager’s scaling 
capabilities. 

 

How does PIPSpro calculate the DPI values from a DICOM image? 

PIPSpro uses the following method: 

DICOM tag - 3002:0011 

Located in RT Image>Image Plane Pixel Spacing 

X & Y Value = mm per Pixel 

Calculation is 25.4/[# in above DICOM tag]. 

 

9.2 Database 

SQL Database does not work. 

If needed, the database can be updated manually.  Contact Standard Imaging, Inc. for further 
assistance. 

 

9.3 Imager QA 

What should I use for Alert and Error deviations for baselines in the Imager QA module? 

We suggest the following parameters: 

Noise: 10% Alert, 20% Error 

All other fields: 5% Alert, 10% Error 
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Noise has different suggested parameters because it tends to fluctuate more than other 
factors that are measured in PIPSpro. 

 

What are the line pairs per millimeter for the QC-3 and QCkV-1 phantoms? 

The QCkV-1 phantom line pairs per millimeter are all the same.  They are: 

Region 1 = 2.46 

Region 2 = 2 

Region 3 = 1.5 

Region 4 = 0.98 

Region 5 = 0.66 

The QC-3 phantom varies and is based on your phantom.  The values should have been sent 
with the phantom and are also usually posted on the side of the phantom. 

If you have neither of these, contact Standard Imaging, Inc.  The measurements can be looked 
up according to the serial number.    

 

If you have an older phantom that lacks a serial number and/or calibration report, nominal 
values may be used: 

Region 1 = 0.76 Ip/mm 

Region 2 = 0.45 Ip/mm 

Region 3 = 0.25 Ip/mm 

Region 4 = 0.20 Ip/mm 

Region 5 = 0.10 Ip/mm 

 

To relate the calibration frequency supplied with the QC-3 and QA-KV Phantoms 

 

Open the System Manager from the File Menu, Select the  ‘Phantoms’ tab at the top of the 
system manager window: 
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This will allow you to input the frequency values of your phantoms which will then be used for 
analysis and reporting. 

 

The RMTF curve is calculated from the central strip of line pairs of the phantoms:  
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These line pairs correspond with the black dots of the RMTF Curve 

 

 

From there, the curve is interpolated (with the blue lines connecting the dots) 

And then the % modulation frequency (f50 = 50% of RMTF) is interpreted by drawing a straight 
line from the % modulation and finding the intersection point where that modulation meets 
the RMTF, which is a line pair frequency 

 

Example: In this image, the F50 value is equal to 0.412 line pairs per millimeter.  

 

 

Can I use the QCkV-1 phantom for CR/DR for fluoroscopy image quality analysis? 

It will depend on your system and if you are trying to do diagnostic image analysis.  PIPSpro 
may have problems opening some of these diagnostic images. 

In addition, the resolution lines per mm on the QCkV-1 phantom may not be high 
enough.  Standard Imaging, Inc. has created the QCkVR-1 phantom which is designed 
specifically for diagnostic imaging. 
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How do I acquire higher CBCT resolution images on an Elekta XVI System? 

Presets will need to be adjusted for volume acquisition and the reconstruction:  

For the volume acquisition, set the Projection Dimension to 1024. 

For the reconstruction preset, set the projection downsize factor to 2. 

This will result in a resolution of 512 x 512. 

If using the standard Elekta image quality preset for volume scan and reconstruction, the 
image slices will have a thickness of 0.5 mm.  The acquired projection (1024 x 1024) will be 
downsized to save space (to    512 x 512). 

These 0.5 mm slices can be exported as 0.5 mm, 2.0 mm, or 2.5 mm by selecting ‘export 
images’ option within the Elekta XVI software.   

 

Error message: an incorrect QC phantom is used or wrong positioning. 

This issue occurs due to the resolution of the image.  The images below illustrate the 
differences.  The image on the left is 512 x 512 and the image on the right it 1024 x 1024.  Notice 
the wavy lines in the center regions.  Those are not real. Instead, they are caused by the down 
sampling of the image. 

 

9.4 Radiation Light Field 

What is the difference between the light field and advanced light field tests? 

The difference between the light field and the advanced light field is the use of the center 
marker phantom.  This is a separate phantom that is set on top of the FC-2 phantom.  The 
added phantom has a center ball bearing that is positioned independently from the 4 ball 
bearings in the corners of the FC-2.  The ball bearings in the 4 corners are used by PIPSpro to 
determine where the light field is set up.  The center ball bearing is used to tell where the 
actual center marker of your light field is.  This allows us to determine the jaw positions. 
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9.5 Stereotactic 

How do I acquire the images for Stereotactic Module with a Varian? 

All images are acquired in the Varian AM Maintenance service mode.  Use the ‘high quality’ 
imaging mode, with the EPID at a distance of 150.  Acquire each image with 4 MU.  Place the 
image on the same computer as PIPSpro and load them into the software. 

Why do I get an “Unable to Analyze this Image” Message? 

The Stereotactic Module typically produces the best results with a 2cm X 2 cm MLC-defined 
field, backed by the Jaws to limit interleaf leakage, or a 2 cm SRS cone. 

If the MLCs are not backed by the Jaws, then Stereotactic may identify some ‘bleed thru’ inter-
leaf leakage pixels in the ‘green’ radiation field outline; this may then affect the reference mass 
center point of the Winston/Lutz Phantom calculation and misplaces the fiducial/cross-hair on 
the image slightly.   

 

 

9.6 Image-Based MLC QA 

Using a Scanner for Image-Based MLC QA - Epson 10000xl 

Use the following guidelines: 

Scan in professional mode. 

Use the photo mode under ‘exposure type’ 

Use 16 bit grayscale for the color depth and image type. 

Use 72 DPI for the resolution. 

Use the image adjustment settings to try to get the best contrast between the background 
and the strips. 

Save as a TIFF file. 

Can I use the graticule instead of the MLC QA phantom? 

Yes.  Be sure to check that the graticule is centered and the projection of the graticule is 
correct.  For all MLC’s except the BrainLab M3, when selecting points, select the BB on the 
central axis and then a BB 8 cm off the central axis.  For the BrainLab M3, select the center BB 
and a BB 3 cm off the central axis. 

Does it cause a problem if the collimator is at an angle when using  the MLC QA phantom? 

The collimator must be exactly at cardinal angles when acquiring MLC QA images.  PIPSpro 
uses the BB fiducials only to determine a scaling factor for magnification purposes. 

It is crucial to use a leveling instrument to ensure the collimator is rotated correctly. 
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10 WARRANTY STATEMENT- 4424-18 
Standard Imaging, Inc. sells this product under the warranty herein set forth. The warranty is 
extended only to the buyer purchasing the product directly from Standard Imaging, Inc. or as 
a new product from an authorized dealer or distributor of Standard Imaging, Inc. 

For a period provided in the table below from the date of original delivery to the purchaser or a 
distributor, this Standard Imaging, Inc. product, provided in the table, is warranted against 
functional defects in design, materials and workmanship, provided it is properly operated 
under conditions of normal use, and that repairs and replacements are made in accordance 
herewith.  The foregoing warranty shall not apply to normal wear and tear, or if the product 
has been altered, disassembled or repaired other than by Standard Imaging, Inc. or if the 
product has been subject to abuse, misuse, off-label use, negligence or accident. 

Product Warranty Period 

Standard Imaging Ionization Chambers 5 years 

Standard Imaging Detectors 1 year 

Standard Imaging Well Chambers 2 years 

Standard Imaging Electrometers 5 years 

Standard Imaging BeamChecker Products 2 years 

TomoScanner and TomoElectrometer 2 years 

Standard Imaging Software Products 1 year 

All Other Standard Imaging Products 1 year 

Standard Imaging Custom Products 1 year 

Standard Imaging Remanufactured Products 180 days 

Standard Imaging Custom Select Products 90 days 

Consumables 90 days 

Serviced Product 90 days (for service performed) 

Resale Products As defined by the Original Equipment Manufacturer 

ADCL Product Calibration 
(Standard Imaging uses the UW-ADCL for 
recalibrations required under warranty, unless 
otherwise requested) 

0 - 90 days = 100% of ADCL Calibration Costs 
91 - 182 days = 75% of ADCL Calibration Costs 
183 – 365 days = 50% of ADCL Calibration Costs 
366 – 639 days = 25% of ADCL Calibration Costs 
(days from date of shipment to customer) 

 

Standard Imaging’s sole and exclusive obligation and the purchaser’s sole and exclusive 
remedy under the above warranties are, at Standard Imaging’s option, limited to repairing, 
replacing free of charge or revising labeling and manual content on, a product: (1) which 
contains a defect covered by the above warranties; (2) which are reported to Standard 
Imaging, Inc. not later than seven (7) days after the expiration date of the warranty period in 
the table; (3) which are returned to Standard Imaging, Inc. promptly after discovery of the 
defect; and (4) which are found to be defective upon examination by Standard Imaging Inc.  
All transportation charges (including customs, tariffs, duties and brokerage fees) are the 
buyer’s responsibility. This warranty extends to every part of the product excluding 
consumables (fuses, batteries, or glass breakage) or material reactions. Standard Imaging, Inc. 
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shall not be otherwise liable for any damages, including but not limited to, incidental 
damages, consequential damages, or special damages. Repaired or replaced products are 
warranted for the balance of the original warranty period, or at least 90 days.  

This warranty is in lieu of all other warranties, express or implied, whether statutory or 
otherwise, including any implied warranty of fitness for a particular purpose. In no event shall 
Standard Imaging, Inc. be liable for any incidental or consequential damages resulting from 
the use, misuse or abuse of the product or caused by any defect, failure, malfunction or 
material reactions of the product, whether a claim of such damages is based upon the 
warranty, contract, negligence, or otherwise. 

This warranty represents the current standard warranty of Standard Imaging, Inc. Please refer 
to the labeling or instruction manual of your Standard Imaging, Inc. product or the Standard 
Imaging, Inc. web page for any warranty conditions unique to the product. 
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11 Serialization Information 
 

Standard Imaging products that are serialized contain coded logic in the serial number which 
indicates the product, day and year of manufacture, and a sequential unit number for 
identification: 

A YY DDD X 
A          Unique product ID                                                         
YY        Last two digits of the year                                            
              (e.g. 1999 = 99, 2000 = 00) 
DDD     Day of the year (1≤ DDD ≤ 365) 
X           Unique unit ID number (0 ≤ X ≤ 9) 
 

12 Customer Care Policy Statement 
Standard Imaging, at its discretion, may extend customer support only to the buyer 
purchasing the product directly from Standard Imaging, Inc. or as a new product from an 
authorized dealer or distributor of Standard Imaging, Inc.  This customer care statement is in 
lieu of all other customer support statements, express or implied, whether statutory or 
otherwise, including any implied statements of fitness for a particular purpose.  

Standard Imaging: 

• Technical support is preferentially biased to those customers with valid and applicable 
Standard Imaging Certificate of Maintenance agreements.  

• Technical support may range from providing detailed solutions to upgrade 
recommendations to the latest version of software for discontinued products.  

• Will, at a minimum, provide technical support during its normal hours of operation.  
• May, at its discretion, limit support of ancillary systems beyond its direct control, such 

as information technology systems, database management and 3rd party programs.  
• Will provide technical support for the product for a minimum of 7 years from the date 

of delivery or discontinuance.  
• Will not provide technical support for obsolete products, those products which are 7 

years past the date of discontinuance.  
• Will provide technical support for any and all involving issues with significant product 

risk, regardless of product age. 

This customer care statement represents the current standard customer care statement of 
Standard Imaging, Inc.  Please refer to the labeling or instruction manual of your Standard 
Imaging, Inc. product or the Standard Imaging, Inc. web page for any customer care 
statement conditions unique to the product.  Specifications subject to change without notice. 
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13 Customer Responsibility 
This product and its components will perform properly and reliably only when operated and 
maintained in accordance with the instructions contained in this manual and accompanying 
labels.  A defective device should not be used.  Parts which may be broken or missing or are 
clearly worn, distorted or contaminated should be replaced immediately with genuine 
replacement parts manufactured by or made available from Standard Imaging Inc.   

 CAUTION:  Federal law in the U.S.A. and Canadian law restrict the sale, distribution, or use of 
this product to, by, or on the order of a licensed medical practitioner.  The use of this product 
should be restricted to the supervision of a qualified medical physicist.   

 CAUTION:  As desired by IAEA, English is the default language for labeling and manuals. If 
translated versions are available, resolve any differences in favor of the English versions. 

 WARNING:  Measurement of high activity radioactive sources is potentially hazardous and 
should be performed by qualified personnel. 

 WARNING: Proper use of this device depends on careful reading of all instructions and 
labels. 

 WARNING: Where applicable, Standard Imaging products are designed to be used with the 
versions of common radiation delivery devices, treatment planning systems and other 
products or systems used in the delivery of ionizing radiation, available at the time the 
Standard Imaging product is released. Standard Imaging does not assume responsibility, 
liability and/or warrant against, problems with the use, reliability, safety or effectiveness that 
arise due to the evolution, updates or changes to these products or systems in the future. It is 
the responsibility of the customer or user to determine if the Standard Imaging product can 
be properly used with these products or systems. 

Should repair or replacement of this product become necessary after the warranty period, the 
customer should seek advice from Standard Imaging Inc. prior to such repair or replacement.  
If this product is in need of repair, it should not be used until all repairs have been made and 
the product is functioning properly and ready for use.  After repair, the product may need to 
be calibrated.  The owner of this product has sole responsibility for any malfunction resulting 
from abuse, improper use or maintenance, or repair by anyone other than Standard Imaging 
Inc. 

Standard Imaging will make numerous and reasonable attempts to contact a customer 
following completed manufacture or service of a product.  Should a customer product remain 
at Standard Imaging for more than 1 year following its completed manufacture or service, 
Standard Imaging reserves the right to resell, restock, donate, discard or destroy the product. 

If, in relation to the use of this product, a death or a serious deterioration of health has 
occurred, this should be reported to Standard Imaging, Inc. and the National Competent 
Authority of the country in which the incident occurred. When in doubt, please consult with 
an advisor or reach out to Standard Imaging, Inc. for further assistance. 
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The information in this manual is subject to change without notice.  Please see 
www.standardimaging.com for the latest information.  No part of this manual may be copied 
or reproduced in any form or by any means without prior written consent of Standard 
Imaging Inc.  

http://www.standardimaging.com/
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14 Service Policy 
If service, including recalibration, is required, please contact Standard Imaging’s Customer 
Service department by phone or email prior to shipping the product.  Standard Imaging’s 
Customer Service and Technical Service staff will attempt to address the product issue via 
phone or email.  If unable to address the issue, a return material authorization (RMA) number 
will be issued.  With the RMA number, the product can be returned to Standard Imaging.  It is 
the responsibility of the customer to properly package, insure and ship the product, with the 
RMA number clearly identified on the outside of the package.  The customer must 
immediately file a claim with their carrier for any shipping damage or lost shipments.  Return 
shipping and insurance is to be pre-paid or billed to the customer, and the customer may 
request a specific shipper.  Items found to be out of warranty are subject to a minimum 
service fee of 1 hour labor (excluding recalibrations) for diagnostic efforts and require a 
purchase order (PO) before service is performed.  With concurrence from customer, the 
product may be replaced if it is unserviceable or if the required service is cost prohibitive.  
Products incurring service charges may be held for payment.  Standard Imaging does not 
provide loaner products.  See the Standard Imaging Warranty and Customer Responsibility for 
additional information.  

 

15 Return Policy 
No merchandise will be accepted for credit without prior approval of return. Please contact 
Standard Imaging’s Customer Service Department to receive a return authorization number 
before returning any merchandise for exchange or credit. Products manufactured by 
Standard Imaging must be returned within thirty days of receipt of order in ‘like new’ 
condition. No credit will be given for products returned after thirty days from receipt of order. 
A minimum twenty percent restocking fee will be charged on all returned merchandise. All 
materials returned must be shipped pre-paid. Credit for returned goods will be issued to 
customer's account for use against future purchases of merchandise only. Special orders, 
custom products, re-sale (not manufactured by Standard Imaging) products, and ADCL 
calibrations will not be accepted for return credit or exchange. 

All products may not be registered, cleared, licensed or approved for sale in all countries or 
territories. Please contact Standard Imaging Customer Care for details. 
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16 Software License Agreement – 4575-04 
Contains licensed program materials of Standard Imaging, Inc. 

Copyright © Standard Imaging, Inc., Middleton, Wisconsin, USA 

This software is protected by U.S. and international copyright laws, international treaties, FDA 
and international regulations, and other intellectual property laws and treaties. This is a 
software license agreement to use the software product or products (the product) enclosed in 
this package and described in the applicable purchase order or other ordering document, 
unless otherwise specified in the product labeling. 

Standard Imaging (SI), Inc., a Wisconsin corporation hereby grants to the purchaser of the 
product (Licensee) the right to use the product, together with its documentation and other 
related materials, only in connection with the computers or computer network system located 
at the site of use (the site) previously designated as such by Licensee and only if in strict 
compliance with the terms and conditions set forth below.  Any purchase and installation or 
use of the product shall constitute acceptance of and agreement by Licensee to be bound by 
the terms and conditions hereof.  Licensee also agrees that the agreement terms and 
conditions will prevail in the event of any conflict between the agreement and applicable 
purchase order or other ordering documents. 

All rights not specifically granted to licensee under this software license agreement are 
reserved by SI.  The SI documented Warranty and Customer Responsibility statements shall be 
considered to be part of this agreement.  The term of this agreement and the licenses granted 
hereunder will continue in perpetuity, unless sooner terminated by SI. 

Licensee shall: 

a. Use the product only on the authorized number of computers, network systems or number 
of linear accelerators at the site of use as provided in the related product and/or sales 
documentation; 

b. Make backup copies of the product only for back-up, recovery and archival purposes; 

c. Authorize SI to use non-patient related data compiled, free of charge, from the Licensee’s 
use of the product for its own use, shared use with other medical device manufacturers for 
quality assurance purposes and/or the independent promotion of scientific knowledge, 
provided that SI does not identify the name of the Licensee to the general public; 

d. Authorize SI to communicate to the Licensee via email regarding the product. 
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Licensee may not and shall not: 

a. Make copies of the product, except as otherwise permitted herein; 

b. Rent, lease, sub-lease or otherwise permit any third party to use the product; 

c. Redistribute any portion of the product, its software programs, documentation, or other 
related materials; 

d. Other than as set forth in section 1.b. above, copy the product, any of its software programs, 
documentation or other related materials, without the express written  
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Authorized representative for the EU is Hoff & Lowendahl AB Högåsvägen 125, SE-741 41, 
Knivsta, Sweden (SRN: SE-AR-000001888). Contact information: info@lowendahl.eu. 
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